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Introduction

What Is MapLogic Layout Manager?

MapLogic Layout Manager is an extension to ArcGIS which provides all the tools necessary to
create and print multiple page layouts, map series and map books within ArcMap. ArcMap’s
cartographic tools were designed to create very sophisticated individual maps. MapLogic
Layout Manager was designed around the concept of multi-page maps. However, MapLogic
Layout Manager does much more than breaking up a map onto multiple pages. It handles all
the details necessary for creating a true multi-page document just like your standard word
processor will. Options like page numbering, indexing, two-sided printing, print previewing are
all automatically handled by MapLogic Layout Manager.

The MapLogic Layout Manager enhances ArcMap by providing tools which allow you to:

1. Create and store multiple page layouts in a single ArcMap document (Mxd)
2. Create map series in ArcMap
3. Create map books in ArcMap

As part of creating a map book, the MapLogic Layout Manager allows you to:

1. Create map series —a map that is broken into multiple pages based on different
map extents or different layer visibilities

2. Create locator maps — an overview map that highlights the location of the current
page in a series

3. Create key maps — an overview map that lists the page number where you can see
the detailed map of an area

4. Create indexes — a listing of features on the map and the page where are located
on

MapLogic Layout Manager User’'s Manual Page 1



MapLogic Layout Manager User Interface

Everything you need to get to in order to use the MapLogic Layout Manager extension is in one
of three locations:

The “Layouts” tab in the ArcGIS Table of Contents
The “MapLogic Layout Manager” toolbar
The properties of different layout elements and data frames
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The Layouts Tab

The Layouts tab is a new tab that is added to the ArcMap Table of Contents by the MapLogic
Layout Manager. If the Layouts tab is not visible after you install the extension, you can make it
visible by selecting Tools>Options... in ArcMap’s main menu. Go to the TOC tab, make sure
Layouts is checked and press the OK button.
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This tab is used to move around the different layouts contained in the Mxd. Double-clicking on
any layout will activate it (make it visible). You can only have one layout active at any time.

Click on any item listed in the Layouts tab using your right-mouse button, and you will see a
menu of options for the item. The above diagram shows all the different popup menus for the
different kinds of items contained in the tab.

Most of the work of managing layouts, map series and map books (adding/removing new books
and layouts, changing the order of sections, etc.) will be performed under the layouts tab.
Different commands on these menus are enabled and disabled in accordance with the
MapLogic Layout Manager license you have (Viewer, Basic, Advanced or Pro).

The MapLogic Layout Manager Toolbar

The MapLogic Layout Manager toolbar is a new toolbar that is added to ArcMap by the
extension. Within this toolbar you will find all of the tools needed to put together a map book. If
the toolbar is not visible after you install the extension go to View>Toolbars>MapLogic Layout
Manager on ArcMap’s Main Menu to display the toolbar.
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The above diagram shows the toolbar and all of its sub-menus. You will notice that the toolbar
layout is very similar to ArcMap’s Main Menu. This will enable you to quickly find the right
commands in the extension based on where you would expect to find similar commands in
ArcMap.

Different commands in the toolbar are enabled and disabled based on:

1. What kind of layout is currently active (page layout, map series layout or book
layout)

2. What kind of element is currently selected in the layout

3. What kind of MapLogic Layout Manager license you have (Viewer, Basic,
Advanced or Pro)

Element Properties

When you insert a new MapLogic Layout Manager element (for example a, Map Series Frame),
the element is added to the active page layout just as in ArcMap’s Insert Menu. To set the
properties of the element, select it, click the right mouse button and then select “Properties...”
on the popup menu. You can also double-click on the element.
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The above example displays the properties of a map series frame. You will notice that the
element will have all the normal properties you would expect for that type of element with an
added tab for properties specific to our extension. Modify the element properties just like you
would with any other element in ArcMap.
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Before You Get Started

It is very important that the user understand that a map book is a much more sophisticated and,
therefore, more complicated document when compared to a single page layout. If you are not
comfortable about how to use the extension, you will save a great deal of time by reviewing the
Getting Started With MapLogic Layout Manager document. We would also suggest reading the
next section which details the conceptual framework for setting up a map book.

You will also save time by planning the design of your map book before you start creating one.
Simple choices like the page size and margins you select for your map book will affect every
page of your map book. How you choose to break apart your map onto multiple sheets of your
map book will affect the scale and detail visible on each page.

So, even though you might want to create some quick map books just to figure out how
MapLogic Layout Manager works, when it comes to creating a final product a little planning
before hand can save you a lot of time.

Finally, as many of you have already figured out, GIS requires considerable computing power.
Every time you flip the page on a map book, MapLogic Layout Manager has to perform a
number of very intensive manipulations to render the page. Remember this when choosing the
computer you are going to use for your work.

How The MapLogic Layout Manager Changes The ArcMap Document

The extension adds a container to the ArcMap document (Mxd) where it holds layouts, map
series and map books. The contents of this container are displayed in a new tab called Layouts
in the ArcMap Table of Contents.

Can a user who does not have the MapLogic Layout Manager extension open an ArcMap
document that has been modified by the extension?

Yes. We have designed the extension so that it will allow the Mxd to be opened on other
copies of ArcMap whether the extension is present or not.

What will ArcGIS users who don’t have the MapLogic Layout Manager extension see
when they open an ArcMap document modified by the extension?

The user will see the layout that was active when the ArcMap document was last saved.
However, keep in mind that the MapLogic Layout Manager has a free “Viewer” license level,
which allows the user to move around the layouts and preview (but not print) map books.

Different Licenses For The MapLogic Layout Manager

The MapLogic Layout Manager has four different license levels: Viewer, Basic, Advanced and
Pro. Depending on the license level that you have purchased, you will have different tools and
capabilities available to you. The following table will give you a quick overview of what you can
do at each license level. Don't worry if you aren’t sure what some of the items listed in the table
mean, as we will provide plenty of explanation as we get further into the book.
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License Level: Viewer Basic Advanced Pro
zll\l/lexv(\j/)dmerent Layouts in ArcMap document Yes Yes Yes Yes
Preview map series and map books Yes Yes Yes Yes
Print single layouts Yes Yes Yes Yes
Print maps series and map books No Yes Yes Yes
Create/edit layouts and map series No Yes Yes Yes
Create/edit map books No No Yes Yes
Crgate location listings in map books (i.e., No No Yes Yes
Main street, Page 1)

Anchor elements to specific locations on the

; . . No No Yes Yes
Layout (including two-sided page setups)
Create multi-column location listings in map NoO No No Yes
books
Create multi-template sections in map books
(i.e., Page 9 in a map series uses a different No No No Yes

template from the rest)

Viewer License

The Viewer license is a free license which allows other users to explore the different layouts
you have placed in the ArcMap document. Users can activate the different page, series and

book layouts as well as preview the pages of a map book or map series.

The user can't create, modify, print or export map series or map book layouts with a Viewer

license.

Basic License

The Basic license gives the user the ability to create new page and map series layouts in
ArcMap. The user can also print map books created by other users using this license.

However, none of the map book creation or editing functionality is available to the user at this

license level.

Advanced License

The Advanced license enables most of the map book functionality for the extension. This
includes creating, editing and printing map books as well as indexing the feature locations in a

book.

Pro License

The Pro license is the highest license level of the MapLogic Layout Manager. At this level,
users have the ability to create multi-layout sections in the map book. This allows you to create
different page layouts for the odd and even pages in the map for two-sided printing.

The Pro license user can also create multi-column indexes. For example, if you would like to
create an index that show the location of roads in a map book as well as the location of each
address range in that road, a Pro license is required.

MapLogic Layout Manager User’'s Manual

Page 7




Basic Concepts

In this section, we attempt to familiarize the user with the conceptual framework of MapLogic
Layout Manager. Spending a few minutes to review this section will help you greatly in
understanding how MapLogic Layout Manager works. We assume that the user has a working
knowledge of ArcMap Views and Layouts.

Multiple Layouts Within The ArcMap Document

Table of Contents K|

El% FPage Layouts
- e[8) Page Layout 1
-3l Map Series Layouts
=- i@ Book Layouts
=&l Sample Map Book
-3 Front Cover
.. [ Cover Lapout
(= [ntroduction
E Intro Layaout
k.ey Map
@) Key Layout
= %] Map Pages
@ First Page Layout
E Map Senes Layout [Active
= % Index Of Roads
. First Page Layout
“oo @) Index Layout

|
o
dY

| 2]

ol
Displa_l,ll Source L apouts |

Before you installed the MapLogic Layout Manager, your ArcMap document was a single layout
document. In other words, you were always working on a single printed map called a page
layout. After installing the extension, your ArcMap document is a multi-layout document. You
are no longer limited to a single layout in your ArcMap document (Mxd).

Also, we have added two new types of layouts to the document; the map series layout and the
book layout. A map series layout is very similar to a regular layout except that it generates
multiple pages at print time.

A map book layout is basically a collection of page layouts and map series layouts that are
linked together in a single book. The key is that the items in a map book are linked. The
different parts of a book are aware of each other and update themselves when something
changes.

The Map Series Layout

As we mentioned earlier, a map series layout generates multiple pages at print time. A map
series knows how to move the visible area of the map from one area to the next or to turn
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different layers on and off for each page in the series.

The ability of a map series layout to update the visible area of the map is due to the fact that
one or more of the Data Frames (map windows) in the layout is a Map Series Frame or a
Thematic Series Frame. Map series frames and thematic series frames are new kinds of data
frames that you can add to your layout once you've installed the MapLogic Layout Manager.

The Map Series Frame Index Layer

The number and order of pages in a map series frame and the location of each page is based
on a layer in the map called an Index Layer. The Index Layer is a polygon (area) layer in your
map where each polygon represents a page in your map series.

Here are some characteristics about an Index Layer:

- It must be a polygon layer.

- The polygons don’t have to be rectangles. For example, you can use the boundary
of each state as the Index Layer for an atlas of the United States. However,
rectangular indexes often provide the best results.

- The polygons don't have to be the same size or the same shape.

- Not every polygon in the layer has to be a page in the map book.

- The layer need not be turned on; it just needs to be present in your map’s table of
contents.

The number of polygons in the Index Layer determines the number of pages in the series. If
the layer has a definition query (see ArcMap Help for more information), then only those
polygons that meet the conditions of the query are considered.

The MapLogic Layout Manager can use any polygon layer as an Index Layer.

The Map Book Layout

Just as a map series layout is an extension of a page layout, the map book layout is an
extension of map series layouts.

A Map Book Document Can Have Multiple Sections

The first difference you will notice between a map book layout and any other layout is that a
map book can have multiple sections. A section is a group of pages in the map book which
display similar content. For example, if you are creating a road map book you might have a
section containing the individual sheets of the map, while another section might contain an
index of road names and the pages they appear on.

The location of any section in the map book determines the order in which it is printed and the
page numbers that are assigned to it. MapLogic Layout Manager prints the map book from top
down, so the very first page of the top most section in the list is page 1. Right-clicking on the
name of a section in the map book provides the user with some tools to rearrange the sections
as needed.

A Section Can Have Single Or Multiple Pages

Depending on the content of a section, it can have one or more pages. You define the contents
of a section by creating one or more templates for that section and MapLogic Layout Manager
handles the rest of the pages. For example, if your road map is going to be broken up over 20
sheets, you will set up the first sheet (its scale, grid style, etc.) and MapLogic Layout Manager
will take care of the other 19 pages.
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A Section Can Have Multiple Layouts (Pro License Required)

One important tool available to Pro license users is the ability to have multiple layouts for a
section. For example, suppose you would like to have different layouts for the odd and even
pages on the map. You can achieve this by inserting a new layout into the section and then
setting the section properties to alternate back and forth between the two layouts.

New Elements You Can Add To Map Series And Book Layouts

|SERIES TEXT

{PAGE INDEX

[LocATOR

b ="
- ... FRAME
: LOCATOR FﬂE
k i
i LT Ly

Earlier we mentioned the map series frame, which is a new element you can add to a layout to
make it print over multiple pages. The MapLogic Layout Manager makes a number of new
elements available to you when creating map series and books.

The above sample shows just a few examples of the types of elements you can add to a layout.
Each element has its own purpose and properties. Each element knows how to update itself
based on its properties, which is what makes the extension so powerful.

A Map Series Frame Breaks A Map Onto Multiple Pages Based On Different Map Extents
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A map series frame is how you display areas of the map in a map series (similar to a data
frame). However, unlike a data frame, a map series frame knows how to break the map onto
multiple pages using the contents of a special polygon layer called the index layer. For
example if your index layer is breaking your map into 20 pages, the map series frame will make
the layout 20 pages long.

A Thematic Series Frame Creates Multiple Pages Based On Layer Visibility
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A thematic series frame is how you display different map themes (similar to a data frame).
However, unlike a data frame, a thematic series frame knows how to create multiple pages
using different layer themes that you setup for the map. For example, if you want to create a
land use and a zoning map, you create two themes one of which turns on all the layers

appropriate for a land use map, another which turns on all the layers appropriate for the zoning
map.

A Series Locator Frame Shows Which Page Is Currently Being Displayed

A series locator frame shows you which part of the overall map is being displayed on the
current page. For example, if you create a map book of U.S. States, you might want a small
map of the entire United States on each page highlighting the location of the state that is
currently being displayed. A series locator frame is designed for this purpose.
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A Series Key Frame Shows The Page Number Of The Pages In A Map Series Frame
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A Series Key Frame is used to create key maps. For example, you might want a map of the
entire United States at the beginning of your map book showing the page nhumber where each
state can be found. A Series Key Frame was designed for this purpose.

A Series Text Element Creates Text That Changes From Page To Page

Northeast Quadrant
Seminole County, Florida

A Series Text Element is used to create dynamic text on the pages of a map book. For
example, if each page of a map book is showing a unique Section, Township And Range, you
may want to create a text box that shows what the Section, Township And Range values are on
each page of the map book. If you have this information in your Index Layer, you can use the
Series Text Element to create a text box that dynamically lists this information from page to

page.

A Page Index Element Indexes The Contents Of The Current Map Page

MapLogic Layout Manager User’'s Manual Page 13



ndo aval Training Cente. 0 05 1 2 3
| r e e il
L L

! B  Continued On 133 c ' D
Populated Places
Aloma 2B Forest City. 1A Orienta Gardens 1A Weathersfield 1A
Altamonte Springs... 1A Gabriella 2C  Orlando 3A  Wekiwa Springs 1A
Azalea Park........... 3B Goldenrod.............. 2B Owviedo..............1D WhitesLanding...... 1C
Belle Isle 4A  lowa City. 1D Pine Castle 4A  Winter Park 2B -\ \
Bertha.................. 2C  Jamestown........... 2C  Riverside Acres........ 2A  Winter Springs......... 1B } é{
Casselberry. 1B Jones Landing 1D Sanlando Springs.... 1A (39 N
Clifton......c..............1C  Lake Charm........ 1D  Sky Lake............ 4A B 3
Conway......... ...3B  Lockwood...........3D Slavia........... 1C 3 1
Eatonville.............2A  Longdale............ 1B Taft........... 4A S
Edgewood 4A  Longwood 1B Truck Corner. 1D L
Fairview Shores 2A  Maitland 2A  Union Park 3B HF
Fairvilla 2A  Momingside Park.....4A  University Park 3D
FernPark............ 1B Neheb............1D Wagner...........1C

A Page Index Element is used to create indexes of features on the current map page. For
example, if you are creating a road map book, you may wish to have a listing of where each
road can be found on each page of the map book (for example, Main Street....B4). A Page
Index Element must always be on the same layout as the map.

A Series Index Element Indexes The Contents Of An Entire Section

A Series Index Element is used to create indexes of features on your map pages. For example,
if you are creating a road map book, you may wish to have a listing of where each road can be
found in the map book (for example, Main Street....Page 2 B-4). Depending on how many
listings there are, a Series Index Element can occupy one or more pages.
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Two-Sided Map Book Setup And Printing

Another basic difference between MapLogic Layout Manager and the rest of ArcMap is the
ability to setup and map book for printing on both sides of a page (Pro license required).
Obviously the number of printers that can print on both sides of a page are not many, and there
are probably no plotters that can print on both sides of your paper. MapLogic Layout Manager
can't actually send a command to a printer to print something on a page and then flip the page
over and print on the other side of the page. However, it does properly setup your map book so
that you could manually print to both sides of the paper or photocopy onto both sides of a page.
You do this by setting up two different layouts for a section and then telling the extension to
alternate between the two.

Where To Go From Here?

This section has provided you with a basic overview of the conceptual framework for the
MapLogic Layout Manager and some key capabilities and features as well as some important
information about using the software’s user interface. Hopefully, the user will have an overall
understanding of how things are organized in MapLogic Layout Manager and the basic
components of map series and books. In the following sections we will provide much more
detailed instructions on how to setup, customize and print page, series and book layouts.

Keep in mind that this is not a tutorial. If you would like step by step instructions on setting up
map series and books, please refer to the Getting Started With MapLogic Layout Manager
document.
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Working With Expressions

One of the key features of the MapLogic Layout Manager is that no text label in a map series or
map book is ever hardwired. Whether the label is a page number, a page title, a listing in a
series index, or any other text item in the map book, you determine the contents of that label by
composing an expression for it.

Why use an expression? Well this allows you to have total control over what the label says.
For example, by default the adjacent page label expression is “See Page
$SADIACENT_PAGE_NUMBER”. The actual label might look like “See Page 3”. Suppose
you prefer the label to say “Go To 3". All you would need to do is to change the expression to
say “Go To $$ADJACENT_PAGE_NUMBER”.

Although there is a default expression for every text label that the extension creates, you will
probably want to learn how to modify these labels to best meet your requirements.

All expressions are created using the MapLogic Expression Builder Dialog. Whenever you see

a label expression on any of our dialogs, you will see an Expression button next to it which
brings up the expression builder dialog.

The MapLogic Expression Builder Dialog
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i MapLogic Expression Builder 21 x]

— Reszerved Wordz: [page numbers, dates, etc. ]

| $3PAGE_NUMBER ~| add |

Fage number of current page

— Databaze Fields and Formats: [fields from the selected table]

|FID =l Add |

| s =l Add
Abg Absolute walue of a number. Example: -3.4bs =3

— Text Formatting T ags:

<FMT3</FNT> =] #dd |
Font Hame and Size. Example: <FMT name="tnal" size="18">My text< FNT >

— Expreszion:
Compose an expression by using reserved wordz, database fields, formatting statements and other text.

See Page $$A0JACENT_PAGE_MUMBER

Werify |

Cancel k.

The Expression dialog lets you build an expression from which a label is created. This dialog is
divided into four areas:

1. The reserved words

2. The database fields and field formatting statements
3. The text formatting tags

4. The expression

The label expression is a coded by combining reserved words, database fields, formatting
statements and other text into a statement which the tool can understand. Fortunately the
coding rules are very simple and the tool does most of the work for you.

Reserved Words

Anytime you see an item in an expression that starts with $$, you are looking at a reserved
word. A reserved word is a word that the extension understands and substitutes for an
appropriate value. For example, “See Page $$ADJACENT_PAGE_NUMBER” will be translated
into a label that might look like “See Page 3".

Depending on what item you are creating an expression for, different reserved words will be
presented to you to choose from. Select a reserved word from the list, and a short description
of the meaning of the word will appear below it.

The following is a list of available reserved words:
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General

$$BOOK_NAME — The name assigned to a map book

$$BOOK_PAGE_COUNT - The total number of pages in a map book

$$DATE — Today’s date formatted according to your computer’s default date format
$SDATE_LONG — Today's date formatted according to your computer’s long date format
$$DATE_MEDIUM - Today’s date formatted according to your computer's medium date format
$$DATE_SHORT — Today’s date formatted according to your computer’s short date format
$$SPAGE_NUMBER - Current page number

$$PROJECT_DRIVE — The drive letter where the MXD is located

$$PROJECT_NAME — The MXD file name

$$PROJECT_FULLNAME — The MXD file name and full path to where its located
$$PROJECT_PATH — The full path name to where the MXD is located

$SSECTION_NAME — The name assigned to the current section
$SSECTION_PAGE_COUNT - The total number of pages in the current section
$STEMPLATE_NAME - The name assigned to the current template layout
$STEMPLATE_PAGE_COUNT - The total number of pages in the current template layout
$STIME_LONG — Current time formatted according to your computer’s long time format
$$TIME_MEDIUM — Current time formatted according to your computer’s medium time format
$STIME_SHORT — Current time formatted according to your computer’s short time format

Indexing Location Of Features In Map Series

$$CENTERX — The X coordinate of the center point of the feature being indexed
$SCENTERY — The Y coordinate of the center point of the feature being indexed
$SFRAME_NAME - The name of the map series frame being indexed

Map Series Frames
$SADIJACENT_PAGE_NUMBER — The page number of the page adjacent to the current page
Page Index and Series Index

$$COLUMN — The frame’s grid column location of the feature being indexed
$$DOTS — Expand the text in a column to the column width using dots (i.e. Main St.......... Pg 3)
$SROW — The frame’s grid row location of the feature being indexed

Series Text

$$FIRST_3CHAR — First 3 characters of first listing on current page (must be linked to series
index)

$SFIRST_CHAR — First character of first listing on current page (must be linked to series index)
$SFIRST_LISTING —listing on current page (must be linked to series index)

$SFIRST_WORD - First word of first listing on current page (must be linked to series index)
$SLAST_3CHAR - First 3 characters of last listing on current page (must be linked to series
index)

$SLAST_CHAR — First character of last listing on current page (must be linked to series index)
$SLAST _LISTING - Last listing on current page (must be linked to series index)

$SLAST _WORD - First word of last listing on current page (must be linked to series index)

Thematic Series Frames
$$THEME_NAME — The name of the currently active theme

$SCUSTOM_TEXT _1 — Active theme’s custom text 1
$SCUSTOM_TEXT_2 — Active theme’s custom text 2
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$SCUSTOM_TEXT_3 — Active theme’s custom text 3
$$CUSTOM_TEXT_4 — Active theme’s custom text 4

If there are no reserved words available for an expression, the area is grayed out.

You can add a reserved word to your expression by selecting it and clicking the Add button.

Database Fields

The database fields area displays all the available database fields for the expression you are
building. It is the information from these fields that are extracted and placed in the text label.
Geometry (shape) and Blob fields cannot be used in a label expression.

Database field names are always enclosed in square brackets “[ ]". For example, a field called
"State_ Name" would be written as [State_Name].

You can add a field to the label expression by selecting it and clicking the Add button. If there
are no database fields available for an expression, the area is grayed out.

Formatting Statements

Formatting statements allow you to modify the information extracted from database fields. For
example, you might want to round a numeric value, or change text to upper case, or change the
way a date is displayed.

Select any formatting statement from the list and a short description will appear on the dialog
explaining what the statement does.

After you have selected a formatting statement, click Add to add the formatting to the
expression. The tool will make sure the information is added using the correct expression
coding syntax.

For example:  [Population1990].Round(0)

A formatting statement that is mismatched with the field type is ignored. For example, if you
attempt to change the number of decimals on a text field, it will be ignored.

Formatting statements are added after the field with only a "." between the two (for example,
[State_Name].UCase).

You can apply multiple formatting statements to a field by adding them one after the other.
Formatting statements will be applied to the value of the field starting from the left and moving
to the right. For example, [State_Name].UCase.LCase will result in a lower case label because
the LCase statement was the last formatting statement.

Some examples of formatting statements are:

Using the layer: US States

Using the legend label text definition: [State_ Name].UCase

Would result in the following label in your legend for the state of Florida: FLORIDA
Using the layer: US States

Using the legend label text definition: [State_ Name].Replace("A","IAN").UCase
Would result in the following label in your legend for the state of Florida: FLORIDIAN

The following is a list of all available formatting statements:
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Abs - Absolute value of a number. For example: -3.Abs =3

FormatCurrency - Number formatted to system currency. For example: 100.FormatCurrency =
$100.00

Format(Instructions) - The Format function converts a value to a text string and gives you
control over the string's appearance. For example, you can specify the number of decimal
places for a numeric value, leading or trailing zeros, currency formats, and portions of the date.
Format is a very powerful statement and can do many different things.

The instructions for the Format statement can be one of many named formats or a user defined
instruction.

Named Formats:

General Number - Shows numbers as entered.

Currency - Shows negative numbers inside parentheses.

Fixed - Shows at least one digit.

Standard - Uses a thousands separator.

Percent - Multiplies the value by 100 with a percent sign at the end.

Scientific - Uses standard scientific notation.

General Date - Shows date and time if expression contains both. If expression is only a
date or a time, the missing information is not displayed.

Long Date - Uses the Long Date format specified in the Regional Settings dialog box of
the Microsoft Windows Control Panel.

Medium Date - Uses the dd-mmm-yy format (for example, 03-Apr-93)

Short Date - Uses the Short Date format specified in the Regional Settings dialog box
of the Windows Control Panel.

Long Time - Shows the hour, minute, second, and "AM" or "PM" using the h:mm:ss
format.

Medium Time - Shows the hour, minute, and "AM" or "PM" using the "hh:mm AM/PM"
format.

Short Time - Shows the hour and minute using the hh:mm format.

Yes/No - Any nonzero numeric value (usually - 1) is Yes. Zero is No.

True/False - Any nonzero numeric value (usually - 1) is True. Zero is False.

On/Off - Any nonzero numeric value (usually - 1) is On. Zero is Off.

Beyond the named formats, you can also create custom formats using syntax that the Format
statement understands. The following examples of user defined formats assume that the
country in the Windows Control Panel is set to "English (United States)."

Format("00000.00") will result in a number like 08315.40

Format("### . ##") will result in a number like 8315.4

Format("##,##0.00") will result in a number like 8,315.40

Format("$##0.00") will result in a number like $315.40

Format("0.00%") will result in a number like 700.00%

Format("m/d/yy") will result in a date like 1/27/93

Format("dddd, mmmm dd, yyyy") will result in a date like Wednesday, January 27, 1993

The Format statement is based on the Visual Basic Format function and can do many things.
For more information on how Format works, visit the Microsoft website for this function at:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/vblr7/html/vafctformat.asp

FormatNumber(0) - Sets number of decimal places for a numeric value. For example:

MapLogic Layout Manager User’'s Manual Page 20



2.53.FormatNumber(4) = 2.5300

LCase - Sets all characters in a string to lower case. For example: "Hello World".LCase =
"hello world"

Left(0) - Returns left x number of characters in a string. For example: "Hello World".Left(2) =
"He"

LTrim - Removes spaces to left of string. For example: " Hello World".LTrim = "Hello World"

Mid(0,0) - Returns the middle x number of characters at position y. For example: "Hello
World".Mid(7,3) = "Wor"

Replace(Search,Replace) — Search and replace text in a string. For example: "Hello
World".Replace(o,xx) = "Hellxx Wxxrld"

Right(0) - Returns the right x number of characters. For example: "Hello World".Right(2) = "Id"
Round(0) - Rounds a number to decimal x places. For example: 2.67.Round(0) = 3

RTrim - Removes spaces to right of a string. For example: "Hello World  ".RTrim = "Hello
World"

Spaces(0) - Inserts spaces between characters of a string. For example: "GIS".Spaces(3) = "G
| s"

Trim - Removes spaces from both sides of a string. For example: " Hello World ~ ".Trim =
"Hello World"

UCase - Sets all characters in a string to upper case. For example: "Hello World".UCase =
"HELLO WORLD"

Text Formatting Tags

Text formatting tags are HTML-like tags supported by ArcGIS for modifying text styles of
portions of your labels. These change the text font, whether its bold or italics, the character
spacing and so on. Select any formatting tag from the list and a short description will appear on
the dialog explaining what the statement does. For more information on text formatting tags,
refer to your ArcMap documentation. After you have selected a formatting statement, click Add
to add the formatting to the expression.

The Label Expression

The expression text box is where the code for the label expression is composed. Although you
can select items from the available lists and click the Add buttons to create the expression, you
can also type the expression directly in this text box. An expression is composed by combining
database fields, formatting statements and other text. Any text entered in the text box that the
tool can't interpret as a database field or formatting statement is treated as plain text.

For example: Population: [Population1990].Round(0)
Will result in a symbol label that will look something like: Population 874923

Verifying That An Expression Is Correct

Once you have created an expression, you can test whether it is using the correct syntax by
clicking on the Verify button. The Expression Builder dialog will examine the expression and
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prompt you with a response. If the expression contains a syntax error, you will be prompted
with the nature of the error. For example,

Invalid Expression! x|

Q Missing close bracket™]") on field name.

If the expression is valid, detailed information about how the tool is interpreting your expression
is presented. For example,

Yalid Expression x|

Labeling Instruckions:
PUT TEXT:"See Page "
AMD RESERVECMWORD: ADJACENT_PAGE_MUMEBER.

Saving The Expression

Once you have created the expression you like, click the OK button to save it.
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Quickly Generating A Map Series Or Map Book

Generating a map book or map series using MapLogic Layout Manager is a multi-step process
with numerous options and settings at each step. However, MapLogic Layout Manager also
includes a wizard which can create a map series or book with only a few quick selections. The
wizard automates the entire process using the most commonly selected options and settings.

The Book Wizard

The Book Wizard will create a map series or book using the most commonly used options. In
order to create the map series or book you will need to have an index layer loaded into the
active map. This is the polygon layer in which each polygon represents the boundary of a page
in the series.

Keep in mind that there are many more options available in MapLogic Layout Manager for
every step of the book creation process. The Book Wizard also includes information on how to
access the options available on each step of the process.

You can open the Book Wizard by selecting Tools > Book Wizard... from the MapLogic Layout
Manager toolbar.

MapLogic Layout Manager

E} arid Wizard..,
Indexing Wizard. ..
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Book Wizard

Introduction | Book Content || Map Series | Overview Map || Index Database | Index Layout | Surmmary

Welcome to the Maplogic Book “Wizard. This wizard will help you set up a map seres or map boaok,
uzing MaplLogic Layout Manager.

Thiz wizard iz designed to combine a number of different steps needed to create a map book.  All of these steps can be
done individually through the Layouts Tab in Arckap'’s table of contents and the Maplogic Lavout Manager toolbar.

B efore getting started you will need to make sure pou have anindex layer [or grid layer] loaded in the map.

The index layer iz a palygon laver in which sach palygan represents the boundary of a page in the map serez. The anly
requirement for thiz layer is that it be palygons. The palygons do not have ta be uniform in size, or even conbiguous.
Townzhip boundaries, county boundaries, and forest stand boundanies are all examples of acceptable gnd layers. The
key iz to understand that each palygon in thiz lager will become a page in the map series.

T =

]

T T
=N
il

IF pou don't have an index laver, Maplogic Layout Manager can create one for you. Just open the Gnd ‘wizard fram
the main toolbar:

[ Cancel ] [ < Back H Mest » ] [ Create Map Book ]

The Book Wizard dialog is designed to make the process of creating a map book or map series
quick and easy by including extensive help and visuals.
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Book Wizard |'_| |'E| E|
Introduction | Book Content | Map Series | Overview Map | Index D atabase | Indes Layout | Summary

The Book Wizard can help create a Map Seniez or a Map Book. Pleaze zelect what pou would like to create:

() Map Series  [available with all license levels)

A Map Senes iz a map that iz split acrozs mulkiple sheets.

Map Series Name: | ky b ap Series |

{*) Map Book [requires Advanced or Pro license]

& Map Book iz a collection of ane ar more Map Seres and Pp—
ather maps and tables. & Map Book will most aften have an :
overview map, and an index [a table lizting map featurez and
the page each feature can be found on).  Thiz wizard can

create a map book with a map zeries, an overview map and an U
index. Y'ou can always add mare cantent to your Map Boak - =
after the wizard completes creating the book. E -

Map Book Name: |ty b ap Boaok

Select zections you would like to be included in the Map Book:

Overview Map

Name: | Owerview Map |

Map Series [required)

Name: | Map Pages |

Feature Index

Hame: |Street Index |

[ Cancel ] [ ¢ Back ” Mt > ] [ Create Map Book ]

The first option is to choose whether you are creating a map series or a map book. As can be
seen, a map book is a map series that also includes an overview map and an index of features
(for example a street index). While the map series is available at all license levels, you need an
Advanced or Pro license to generate a map book.
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Book Wizard

Introduction | Book Content | Map Series | Overview Map | Index D atabase | Index Lapout || Summary

The Book ‘wizard will uze the curment map az a template for creating the Map Senes. The curent
map zhould be zet up az pou would want a page in the zeries to look like. Once the Map Seres haz
been created, you will be able to adjust the lapout of the map. However, all the pages will be
zharning the same template, so changing one page will affect all pages.

The Map Series iz contralled by a polygon laver called the index layer. Each palygon in the index
layer will become a page in the Map Seriez. Pleaze select the index laper:

index Layer: |ETT I -

The pages in the zeries are zorted according to the values in a field in the layer's table. Pleasze zelect the field to sort
ull

Sort Field: |Name v|

The Boak wWizard will create the Map Senes using the above infarmation.  However, there are many more ophions

available to chooze from when zetting up senes. After the Map Senesz haz been created, you can access theze oplions
from the Data Frame Properties Dialog.

Data FFrame Properties E"Zl

Genesal | Dvatz Frame [ Coordingle Syztem | Ileminalion | Giridz | Wzp Cache |

\'!'/ P.-:I'd DaLa..-.

;;" Full Extent Ennolalion Grovps | Estent Rectangies | Frame | Size and Posiion  Map Seres
JLj [® Foous pata Frame [EIMap Series Propesties (ssme pioperlies overide Dats Frame piopeibies]
= =

e Senes ]Mia:enl Page Listngs ] Optians ] Cusgtom Code|

The lecalion of each pags in the seiies is deteimined by a pobigon [area] laper in lhe
Data Frame called the Index Laper'. Each polygon n this layer iepiezents a page in
the setiss

Index layer: -

I ak | Cancel | eply |

[ Cancel ] ’ ¢ Back H Mext = ] [ Create Map Book ]

The index layer is necessary to create a map series or book. The polygons in the index layer

will become pages in the series. The sort field determines the order by which the pages are
added to the series.
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Book Wizard

Introduction | Book Content | Map Series | Owverview Map | Index Database | Index Lapout || Summary

The Overview [or Key) map iz a map showing the entire extent of the Index Laver along with e *
labelz showing the page number of each polpgon in thiz layer. ETRAOALS o

Book Title: |M_|r| bap Baok |

Generally, the overview map does not display all of the layers that can be seen on the map pages
because the map would be too busy at this scale. Select which layers will be visible on the
OVErVIEW Map:

Map Layers: |[] Grids A —
Strestidap Marth America 3

|:| Mational Capitalz (50 to S0mil)
|:| Mational Capitalz (60 to 30mil) il

The Book wizard will create an overview map uzing the above information.  Howewver, there are more options available
faor thiz map. After the map has been created, you can acceszs theze options from the Data Frame Properties Dialog:

Data Frame Properties E|E|

Genzral ] Dala Frame | Ewrdnaleﬁ].'ﬂem] Turrinatices ] Giids | iap Cache |
Annotalion Groups l Exlent Rectangles | Frame | Seand Posbion  Sedies Kep

Srate OF Flarids @

1153038 diag

e

@ Eul Extent &S eries Key Propeitics
Forus Daka Frame Key l Fey Labels ] Options ]

A Sesies Kew Map iz a map of the enlire extent of a map senes with labels showing
the page |ocation of each arsa. & Senies Fey must be inked to a Map Seies

Digtrigube L4 Frame i ordsf Lo properhs Lshel The mep.
Ratate ar Flip |2 S ection:
i3y Properties... |HBF' Pages ﬂ

ok | caneel | e |

[ Cancel ] ’ ¢ Back H Mext = ] [ Create Map Book ]

If you are creating a map book, the software can automatically generate an overview map for
the book.
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Book Wizard

Introduction | Book Content | Map Series | Overview Map | Index Database | Index Layout | Summary

Indexing iz the process of creating a table of features and where they are located in the map pages.
Indexing iz performed by comparing map features against the page boundaries and then estracting
information about the feature and the page it iz located on.

Abe Springs... 5 Argyle. ... 18
Achan......... 1% Anel........ 1T
Acline ... 14 Aripska.. 19
Select layer and figld to index:
Layer to Index: | Detailed Strests v|[=] Field: namE v|

The index iz stared in a database which iz then uzed to generate the index pages. ze the folder icon to zelect the
destination file to store index.

Database file: |C:'\T emplndaxD atabase. dbf |

Indexing can be a time conguming procezs. You have the option of creating a smaller zample index for testing.
|:| Create a Sample Database

The Book wWizard will create the index database uzing the above information. Howewver, there are many maore options
available when generating an index. To generate an index with more options select the Indesing ‘Wizard from the main
toolbar;

MaplLogic Layout Manager

m Book Wizard. .
ﬁ} arid \Wizard. ..
Indexing ‘W

[ Cancel ] ’ < Back ” Meut = ] [ Create Map Book ]

If you are generating a map book, the software can also index a layer and add a table to the
end of the book listing the location of features in the book. A street index is the most commonly
generated index. In order to create an index, you will need to select a layer to index and the
field from that layer to include in the index.

As part of the indexing process, the software needs to store its results in a database which will
later be used to generate the table. Use the folder tool to select a destination for the index
database.
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Book Wizard

Introduction | Book Content | Map Series | Overview Map || Index Databaze | Index Layout | Summary

Once the index databaze hasz been created, the Book Wizard will lapout the index on one ar more
pages in the Map Book. Select your preferred index style:
{E} Boxed
Alaga 9 Boulogne il
Alford 18 Bounds Crossing 17
Allentowm 13 Boykin 3
) Dotted
Alaga 9 Bullhead Bluff........ _—4
Alford : 1% Bt Fort e Fa
At own 13 Byrneille. ... 2

The Book “Wizard will create the index uzing the above information. Howewer, there are many more optiohs available
for the index layout.  After the indes haz been created, you can access these options from the Senes Index Properties
Dialog:

Series Index 1 Properties

L= tres | Frsme | Size and Posilion  Sedies Index |
3 zoom ‘\whole Page

@ Znoem to Selected Elements (Eiseries Jnde_u_Fmpelliﬁ:_
X o o Indes Source | Index Layout’| DisplapSort Crder | Options |
3 Tl
B The index is organized a5 a series of cohumnz contaning dilfesent infomation [the listing text.
- Copy Chr+C the page number, ete.]. You can modfy the content of each calumn by changing the
G- ¥ Delete Dielate
Column Properties:
Rotate or Flp » Cokimn Test | Font| Background | Sizs/Marging | Cokann Broak | Tille |

[y Froporties...

[ Cancel ] [ < Back ” Mext » ] [ Create Map Book ]

The wizard offers two options for the layout of the index. Keep in mind that, as with all other
steps in the process, there are many more options available beyond the choices presented by
the Book Wizard.
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Book Wizand
Intraduction | Book Content | Map Series | Overview Map | Index Database | Index Layout | Summary

Ready to Create Map Book

Details:

Output Tepe: Map Book

Map Book Mame: ky Map Boolk
Map Cantent: Overview Map, Map Senes, Feature [ndex

Owerview Map:
tap Title: My Map Book

Map Senes:
tap Series Indew Layer: Grids
Map Series Sort Field: Mame

Sernies Index:
Laver to Index: Detailed Strestz
Index Field: HAME
Index Databaze File: C:ATemptIndasD atabaze. dbf
Index T able Style: Boxed

ALL REQUIREMENTS MET. CLICK 'CREATE MAFP BOOK' TO BEGIM

Pause Drawing [This option speeds up execution by pausing map refresh until process is complete)

Once you have selected all the necessary options on the book wizard, click the Create Map
Book button to generate the map series or book. The summery window will update you as
each step in the process is completed.
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Creating Map Series Index Layers

The ability of MapLogic Layout Manager to create a map series is based on the Index Layer.
As we mentioned earlier, the Index Layer is a polygon layer that contains all the information
needed to break the map apart into multiple pages. Essentially, polygons within your Index
Layer represent pages on your map book.

The MapLogic Layout Manager can use any polygon layer as an Index Layer. The extension
provides you with a wizard that creates grid and linear index layers for you. If the tools provided
by the extension don’'t meet your requirements, you can always create your own Index Layer
using the layer creation and editing tools provided by ArcMap.

The Grid Wizard

The Grid Wizard provides tools which allow you use a humber of different methods to generate
a grid layer. Grids can cover an area, follow a line, follow the extent of map features or even

entered manually. Additionally, the resulting grids can be edited, moved, merged or split. You
can preview your results on the map before committing the grids to a shapefile or feature class.

ol Jl( __
a2

1|21 s

L C2iHC3HHCaH—
\ il | vz
2

=

Grid an Area Follow a Line Map Feature Extents

You can create a grid index layer by selecting Tools > Grid Wizard... from the MapLogic
Layout Manager toolbar.

MaplLogic Layout Manager

Layout  Edit = Yiew ~ Insert ™ Tools * Help =

il Book Wizard. ..

Grid Wizard. .,

The process of creating an Index Layer using the Grid Wizard is to use one or more of the grid
tools available on the wizard to populate the Grid List. The grid list is essentially a list of
rectangles. For each rectangle there is a set size and position and, optionally, a name, scale
and rotation.
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Grid Wizard

Welcome to the Maplogic Grd “wizard. This tool will create a polygon shapefile or feature clazs which can be

uzed ag a map senes index layer. 77 7
1. Use Grid Tools to populate Grid List BE / T //
2. Click Create Grid ,r‘ \ g
B2 | 4 4
NG N
= i
Grid List [1 of 100 grids selected] - Use and tools to add to list
Name Origini | Origin'' | ‘Width ~Height = Scale | Rotation E]
A 81,5735 | 28,6821 |0.0369 0.0291 |0 1] E] Grid an Area...
AD2 | -B1.B36E 286821 |0.0369 0.0291 |0 1] E] Follow a Line...
AD3 | -B1.4997 286821 |0.0369 0.0291 |0 1] E] Layer to Grid...
ADd | -B1.4623 286821 |0.0369 0.0291 |0 1] - -
Single Grd...
A05 | 814253 | 286821 0029 [0 |0

» AR
AQ7
ANg
A0
Al10
BO1
BOZ
BO3
BO4
BOS
BOE
BO7
BOS

-31.3521
-H1.3152
31,2783
312414
-81.5735
-81.5366
-81.4337
-01.4628
-81.4253
-31.383

-31.3521
-H1.3152

28,6821
28,6821
28,6821
28,6821
28.653
28.653
28.653
28.653
28.653
28.653
28.653
28.653

0.0363

00364
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363
0.0363

0.0251
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231
0.0231

oo o o o |lo o oo o oo

oo o o o |lo o oo o oo

Mote: Order of the gridz in the list iz the order of the pages in the map senes.

Edit...
Spli...

Mowve...
Delete. ..

Presiew

w0
o
]
o
T
o
I
=]
=
&2,

All Rows:
Delete All

Presieww all

[ ] Auta-dinimize

[ Create Grid ” Cancel

Grid An Area

The most common type of grid used in a map series is to take a large area and split it into
uniform smaller pieces.
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The Grid an Area tool can be used to easily generate this type of grid. In order to create the

grid the software needs to know:
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The extent of the grid

The size of each grid cell

The order of the grid cells

Rules for limiting grid placement (optional)
Rules for naming grid cells (optional)

aogrLONE

To begin the process of creating an area grid click the Grid an Area button. The tool will
appear at the bottom of the wizard.

Grid Extent

Introduction | Grid Extent | Grid Size | Grid Order | Grid Limits | Grid Mames

The Gnd estent determines the area for the gnd. mE— = ,.’. f
Currert Extent 2 Lo
-1 2042 WITETR =xe R
50wl ] 8
287112 MR
"]

Lower Left

= -81.5733 +I
Y — -

254200

| <Back || Mest> | | AddToGrdList | | Cancel |

The grid extent is the limit of the area for which you want to create a grid index layer for. You
can type in the coordinate limits of the extent, click on the Full Extent button to select the area
covered by all layers in the map, click on the Current Extent button to select the area of the
map that is currently visible or use the rectangle tool to draw the extent on the map.

By default the current visible extent of the active map is selected for the grid extent.

Grid Size
Introduction || Grid Extent | Grid Size | Grid Order || Grid Limits || Grid M ames
The grd size determines the dimensions of each grid cell. 17
- o
(%) Automatic - size grid cells automatically a2 f i I
Fawrs ; 10| Colamns ; 10 . ,J
S
Page Units [FOR PROJECTED COORDIMATE SYSTEMS ONLY) 5 ﬁ.li ?I}'_ 8
B ! | o
Whictth Height : [Inches) ' \
Y [ SIS EAY T N
At g Scale of 1 A .
) Map Units - size grid cells using map distances o e
Width : 00369 Height : 00291 {Decimal [ Auto-Minimize
degrees)
| <Back || Mewt> | | AddToGridList | | Cancel |

Once you have determined the area you are going to make a grid for, you need to tell the

wizard what the size of each grid cell should be. You can set the cell size automatically or in
page units or map units.
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To set the size automatically, you set how many rows and columns the area is to be divided
into.

To set the cell size in page units, you must tell the wizard at what scale you will be printing the
map series and how big you want each cell to be on the printed page. This is the preferred
method of creating a grid since you generally want to print a map series at a particular scale.
The default values for the cell width and height is the current size of the frame on the layout.
This option is only available with projected coordinate systems.

To set the cell size in map units, you must tell the wizard how big an area you want each grid
cell to cover on the map.

By default the area is split into a 10 by 10 grid.

Grid Order

Intraduction || Grid Extent || Grid Size | Gnd Order | Grid Limits | Grid Mames

The grid order determines the order by which the cellz are added to the Grid List. T
= Ilf
11 2 St 4
Upper Left to Lower Right W ; o f>::
E ¥ by . - .
(%) Move acrossfirst andthen up or down T e 2 &
{:} Mowve up or down first and then across R SN 421
B ¥
Pl o
e ]

| <Back || Mest> | | Add ToGridList | | Cancel |

The grid order is the order in which the grid cells will be added to the grid list. When creating a
map series there is usually a preferred order in which the pages will flow in the series.

By default the order are the pages are from the upper left corner of the map to the lower right
corner.

Grid Limits

Introduction || Grid Extent | Grid Size | Grid Order | Gnd Limitz | Grid Names

The Grd limit removes cells where there i no underlving data for the selected lavers. 7

[] only place grid if it overlaps data from: {1 2 i _,3: x
[[] Mational Capitals (50 ta 30mil) -~ e ot }

[] Mational Capitals (30 to 1 5mil) 5 x:ﬁ__ t{7¢ ] &
|:| Mational Capitalz (15 1o 10mil) ,.....} r,' e

|:| State - Province Capitals (6010 30mil) ok i x
|:| State - Province Capitals (3010 15mil) % r ']'-
s A R

| <Back || Mest> | | Add ToGridList | | Cancel |
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By default a rectangular grid will be created covering the entire extent entered. If you want to
create grid cells only where there is data from one or more layers in your map, check Only
place grid if it overlaps data from. You must then select the layers which you want the
wizard to check while creating the grid cells.

The wizard will check each grid cell against the layers you have selected. If there is data from
one of the selected layers that overlaps the grid cell, then the grid is added to the list.

Grid Names

Introduction || Grid Extent || Grid Size | Grid Order | Grid Limits | Grid Names

The ard name iz a label azsigned to each and cell Z
Add page names to the grid ’ . "a
Haming Style oz | Start names as if first grid is: I —f
(%) Row - Column Row: 1 Column: |1 ‘l .. .
() Column - Row Row-Column Seperator: C?H [ | ||
Row Names  (5) ajpha (4,8,C, .0 (O Mumeric (0,1,2, .. e -

Column Names () alpha (4, B, C, .0 (&) Mumeric (0,1, 2, ..

Mewt> [ Add ToGrd List | [ Cancel |

You can optionally assign a name to each page in the grid cell based on the row and column
location of the cell in the index grid. These names can be displayed on the map in place of
page numbers.

You can set whether or not the software should name grids as if the first grid is assumed to be
row 1 and column 1. This is useful if there are already grids in the grid list and you are
appending to the existing list. For example, if there are already 4 rows of grids and you are
adding a 5" row, you can make sure that the grids are named properly by setting the starting
row number to 5.

Once you have selected all the options, press the Add To Grid List button to generate the
grids.

Follow A Line

Another common way of creating grids is to follow a linear feature on a map. This is useful for
creating a map series that follows a road alignment, river, etc.

In order to create the grid the software needs to know:
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The grid path

The size of each grid cell

Rules for grid placement

Rules for naming grid cells (optional)

PoNPE

To begin the process of creating an area grid click the Follow a Line button. The tool will
appear at the bottom of the wizard.

Grid Path

Introduction | Grid Path | Gnd Size | Gnd Placement | Gnd Mames

Gnd paths can either be drawn on the screen or imported from layers or graphics.

Path Points Draw onmap |Add a3 newy line b |

from zelected graphc

from layer: | V| ' \‘ i
Selected fest i "I-rum-' A
|:| elected features Jf-*"'Ti—[ et

Sort By: | 3z | :
[] Auto-Minimize

Options: [ Merge [ Reverse Lines

| <Back || Mext> | | AddToGrdList | | Cancel |

The grid path consists of one or more lines along which the software will place grid cells. The
path can be drawn on the map, imported from an existing graphic line on the map or imported
from a linear feature layer.

If the lines are being imported from a layer, you have the option of importing all line features or
just the selected features. The direction of the line features is important as the software will
begin at the starting node of the line and move to the ending node.

Grid Size

|ntroduction | Grid F'ath| Grid Size | Gnid Placement | Grid Mames
The and zize determines the dmensions of each and cell 7
Page Units [FOR PROJECTED COORDIMATE SYSTEMS OMLY) //

&t & Scale of 1 :I:I I a1 P LY e

(%) Map Units - sjzc and cellz uzing map distances

Wickth - 00363  Height : 0.0291 (Decimal

degrees)

-

[] Auto-Minimize

| <Back || Mest> | [ AddToGridList | | Cancel |

Once you have determined the path to make a grid for, you need to tell the wizard what the size
of each grid cell should be. You can set the cell in page units or map units.
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To set the cell size in page units, you must tell the wizard at what scale you will be printing the
map series and how big you want each cell to be on the printed page. This is the preferred
method of creating a grid since you generally want to print a map series at a particular scale.
The default values for the cell width and height is the current size of the frame on the layout.
This option is only available with projected coordinate systems.

To set the cell size in map units, you must tell the wizard how big an area you want each grid
cell to cover on the map.

Grid Placement

Introduction || Grid Path | Grid Size | Grid Placement | Grid Mames

The gnd path can ether be drawn on the screen ar imported from a laver.

Rotate grids to follow path
Thiz option generates pages more efficiently and trnes to center path on page

'@' Place starting point at center of first page
{:} Place starting point at edge of first page
Offzet from Edge : 0| (Decimal degrees)

| <Back || Mest> | | AddToGrdList | | Cancel |

Grids that follow linear features can either maintain a horizontal orientation or rotate in line with
the direction of the path they are following. Rotating grids try to keep the linear feature
centered on the page.

Another placement option relates to the position of the starting grid. The first grid can either be
centered on the starting point of the linear feature or placed so the line starts at the edge of the
page. If you choose the start at edge option, you can set an offset so there is a small gap
between the edge of the page and the line.

Grid Names

Intraduction || Grid Path | Grid Size | Grid Placement | Grid Mames

The gnd name iz a label aszigned to each arid cell

Add page namesto the grid
Path Names () ajpha (8, B, C, .0 (O Numeric (0,1, 2, .)
G} Atomatic (imported from linear festure)

Page Names (7) alpha (2, B, C, .0 () Mumeric (0,1, 2, ..

Start names as if first grid is: Path: [q Page: |1
Path-Page Seperator:

Mest> [ Add To Grid List | [ Cancel |

You can optionally assign a name to each page in the grid cell based on the path and page
number of the grid. These names can be displayed on the map in place of page numbers.
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As was mentioned earlier, the tool can generate grids that follow more than one linear feature.
Each of these lines is called a path and each grid that is placed along the line is called a page.
The tool can name pages based on their path number and page number.

You can set whether or not the software should name grids as if the first grid is assumed to be
path 1 and page 1. This is useful if there are already grids in the grid list and you are
appending to the existing list. For example, if there are already 4 paths of grids and you are
adding a 5 path, you can make sure that the grids are named properly by setting the starting
path number to 5.

Once you have selected all the options, press the Add To Grid List button to generate the
grids.

Layer To Grid

Another common way of creating grids is to match the extents of features in a layer. For
example, if you want to create a map series of school locations, or hazardous wastes sites, etc.

To begin the process of creating an area grid click the Layer to Grid button. The tool will
appear at the bottom of the wizard.

Creates qrds bazed on the estent of features in a paint, line or polygon layer. 7
ot _ M
Layer: v Jli
DSeleded features only ‘l:L D y A |:|
Sort By: - e JEUL M S
[ muttiple features have the same sort } T D! D‘ ]
value, merge them into one grid i .f-f" i
Expand Extent By: 0| [Decimal dearees]
For point layers this number must be greater than zero

| #dd To Grid List | | Cancel |

The process of creating grids based on a layer is very simple. Just select the layer you wish to
use and the field to sort the grids on.

Optionally, you can choose to merge features that have the same sort value and also expand
the grid so that there is a buffer around each feature.

If you are using a point layer to generate a grid from, you need to make sure you have set the
expansion value to a number larger than zero.
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Once you have selected all the options, press the Add To Grid List button to generate the
grids.

Single Grid
If none of the automated methods for generating grids is appropriate for what you are trying to
do, you can always generate the grids manually.

To begin the process of creating an area grid click the Single Grid button. The tool will appear
at the bottom of the wizard.

b anually addz a grid to the Grid List, 7
Origin (Lower Left Corner) and Size f -\

K ol Wicth: 0 \'\.._l f

A 0| Height: Xl f
o --é-—-\'rr-_;#iﬁl’-!.'-}
Optional kems \“Y'* o
Maime; Seale: 0| Rotation: v T /I
S )
Add new gridto: | ager Current Grid W [[] Auto-Minimize

|:| Keep tool open after adding new grid

| Add To Grid List | | Cancel |

Creating a new grid is very simple. You can either type in the size and position of the grid or
use the rectangle tool to draw the grid on the map.

Optionally, you can define a name, scale and rotation for the grid. The rotation value does not
actually rotate the grid. This value can be used in the map series properties to rotate the entire
map on the page represented by the grid.

If you plan to add more than one grid, check the Keep tool open after adding new grid option.
This will leave the tool open after grid has been added so you can create additional grid cells.

Once you have selected all the options, press the Add To Grid List button to generate the
grids.

Editing Grids
Once you have populated the grid list you have the option of editing, splitting, merging or
moving grid cells using the tools on the wizard

Edit Grid
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The edit tool allows you to change all of the parameters of an existing grid cell.

Edit zelected grid zettings. ”
Origin (Lower Left Corner) and Size

Optional kems
Mame: Scale:ljl Rntatinn:ljl

[[] Auto-Minimize

[ |dpdate Grid List ] [ Cancel ]

To edit a single grid, select the grid on the grid list and press the Edit button.
Split Grid

The split tool allows you to split a grid cell into smaller grids. This is useful when an area of the
map has too much detail and would be better served by multiple pages.

S plit | Grid Marmes
Splitz zelected grid into emaller grids. /

. . . 1
souins Rows:| 3| cownne: 3| [ /]

Grid urder:| pper Left to Lower Right i |

@' Move across first and then up or down

{} Mowve up or down first and then across

ol Z

\\‘_ ; Y EAF il
\

1

TN

™ e

a ,..‘- = .-"f
Add new grids to: | Atfter Current Grid w /‘f i3
Remowe original grid from Grid List D Minimize Wizard

¢Back | MNest> | | AddTo GridList | | Carcel |

Because the split tool is generating new grid cells, you have options available to determine the
order of the new cells as well as the naming style for the new cells.

Merge Grids

The merge tool is the reverse of the split tool it allows you to merge multiple cells into one. This
is useful when an area of the map is sparse and would be better served by a single page.
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Combines the selected grids inta one larger grid. 7
: )
Merged Grid HName : | 206_A07 \ LAY
Add merged gridto: | s g current Grid v 5 I
E ¥
= 5 = .
Remove merged grids from Grid List g - ::;}— e
1
MOTE: Merge does not maintain the individual geometies of menged ) T |
gridz. & new rectangle iz created that matches the extent of the R o el
merged grids.
[[] Auto-Minimize

[ |pdate Grid List ] [ Cancel ]

The merge tool does not maintain the geometry of the individual grids it is replacing. Rather a
new rectangle is created that matches the extent of the replaced grids.

Move Grids

The move grids tool allows you to shift the position of one or more grid cells.

baoves the selected grids a user-specified distance. 7
S P
Off=zet Distance :,.* 3
Horizortal () A
" ’ = )
Yertical (Y7 |:| i) %
U = 1..;.{._-',-1. -
\.\_y,. .|__
.
) i Ty
ey
[[] Auto-Minimize

[ |pdate Grid List ] [ Cancel ]

You can either enter the horizontal and vertical offsets for the selected grids or use the line tool
to draw the direction and distance of the move.

Generating The Index Layer
Once you have populated the grid list with the grid cells, click the Create Grids button to

generate a shapefile of feature class from the grid list.
If you are not ready to create the final grid and would like to work on the grid list at a later time,

you can use the save = and load = buttons to save the grid list to an external file which can
be loaded later.

Creating Grid Index Layer Tool (Outdated)

This tool is no longer recommended as it has been replaced with the more advanced
Grid Wizard. A grid index layer is a grid of rectangles covering an area.
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You can create a grid index layer by selecting Tools >Outdated Tools >Create Grid Index
Layer... from the MapLogic Layout Manager toolbar.

This will display the Grid Index Wizard dialog. In this dialog, you need to set the properties of
the index grid. In order to accomplish this you must:

1.

2.
3.
4

Set the extent the area to create a grid for and any sub-areas you want excluded
from the grid creation process

Set the size and order of the each cell in the grid

Assign a page name to each grid cell (optional)

Set the destination of where the grid will be stored

The Grid Index Wizard dialog is divided into four tabs corresponding to the different parameters
we described above.

Setting The Grid Extent
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ﬁ}lﬁrid Index Wizard

A Gnd Index Layer iz used to create a map zenes that covers an
area such az a city or county,

Grid Extent | Page Size and Order I Fage Namesl Dutput I
Set the extent af the arid.

Starting Coordinate [Lowerleft]:

: | 2,474, 746,45 Current Estent

T 1.723.712.66 Full Extert |

Ending Coordinate [UpperRight]:

A 2,399,848 57
T 1.435,359.55

[+ Don't create empty gnds.

A anid iz congidered empty unless it containg features
from &t least one of the following zelected layers:

[[] Capital Cities

[] uzabln

[] Rivers

[ Interstate Hw
[]5tate Bnd

[T Lakes

|Inited States

[ Heighbouring Countries

X

Cancel < Back P et > izt

The grid extent is the limit of the area for which you want to create a grid index layer for. You
can type in the coordinate limits of the extent or click on the Current Extent button to select the
area of the map that is currently visible or click on the Full Extent button to select the area

covered by all layers in the map.

By default a rectangular grid will be created covering the entire extent entered. If you want to
create grid cells only where there is data from one or more layers in your map, check Don’t
create empty grids. You must then select the layers which you want the wizard to check while

creating the grid cells

Setting The Grid Page Size And Order
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HpGrid Index Wizard x|

& Gnd Index Laver iz used to create a map senes that covers an
area such as a city or county,

Grid Extent  Page Size and Order | Fage Namesl Dutput I

—Page Size
The size of each rectangle be can either in map units or
page unitz. |f pou select page unitz, you must alzo zelect a
zrale for each rectangle.

= Page Units (Inches)
width | 5.32648691740924
Height: |  £.05475024343634
Scale: 1: |  20563350.724591

f* Map Units  (Meters)

"fidth | 200000
Height : | 200000
—Page Order
IJpper Left ko Lower Right j

{* Move accross first and then up or down

{~ Move up or down firzt and then accross

Canicel < Back M et = Eimizt

Now that you have determined the area you are going to make a grid for, you need to tell the
wizard what the size of each grid cell should be and the order in which the grid cells will appear
in the map series. You can set the cell size in page units or map units.

To set the cell size in page units, you must tell the wizard at what scale you will be printing the
map series and how big you want each cell to be on the printed page. This is the preferred
method of creating a grid since you generally want to print a map series at a particular scale.
The default values for the cell width and height is the current size of the frame on the layout.

To set the cell size in map units, you must tell the wizard how big an area you want each grid
cell to cover on the map.

The wizard will add page numbers to the grid cell in the index layer based on the order which
you select in the Page Order area of the dialog.
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Setting The Page Names

ﬁ}lﬁrid Index Wizard x|

& Gnd Index Layer iz uzed to create a map zenes that covers an
area such az a city or county,

Thiz taol can generate page names for each rectangle in the
grid bazed on itz row and column pozition.

[+ Add page names to the grnd

— Maming Options
Haming Style

¢ Row - Column E

£~ Calurmn - Row

[T Separate row and column with an underzscore

Row Mames

o Alphald, B, C. .1 € Mumencz (0,1, 2,...]

Column Names

 Alpha s, B, C. .1 & Mumencz (0,1, 2,...]

Cancel < Back i Eef Finizh

You can optionally assign a name to each page in the grid cell based on the row and column
location of the cell in the index grid. These names can be displayed on the map in place of

page numbers. As you can see, you have a number of naming styles to choose from.

Don't confuse this grid with the grid that you might want to put around each page of your map

series. That grid is set as a property of the data frame.
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Setting The Output Destination

B}Iﬁrid Index Wizard x|

A Gnd Index Laver iz uzed to create a map zenes that covers an
area such az a city or counky,

[Grid Extent I Page Size and Order I Page Mames  Output |

Thiz taol will create rectanagles that will cover a zelected area.
Thesze rectangles can be added to an existing laver ar a new
layer,

{+ Create a new Layer:

[T emphUS Grid.shp ﬂ

|F encountenng eror using folder toaol, Click Here

= Use an existing Layer:

|<Nn:|t Setr j

[T | Clear layer [Select this optian to delete all existing features)

Output Fields:

Page Mumnber: IF"g_NumI:-er j
FPage Scale: IF"g_Su:aIe j
Fage Mame; IPg_Name j

[T | Start page numbers after bighest existing number

Carnicel ¢ Back = Eimizh

The wizard saves the resulting grid in a new shape file or it can append or overwrite an existing
polygon layer in your map.

If you are using an existing layer, you must tell the wizard which fields it will use to store the
page number, page scale and page name. If you are creating a new shape file, the wizard will
automatically create the fields to store this information in.

When saving into an existing layer, there are two options available to you.

Clear layer — this option clears any existing features from the layer before adding the new grid.
Start page numbers after highest existing number — If you are appending to existing
polygons, you can tell the wizard to start the page numbers after the highest page number that
already exists. For example, if there are already eight polygons in your index layer, the first
new polygon will be numbered as page 9.

Once you have set all your parameters, click the Finish button to create the index layer grid.

Creating Linear Index Layer Tool (Outdated)

This tool is no longer recommended as it has been replaced with the more advanced
Grid Wizard. A linear index layer is a series of rectangles following the path of a linear feature.
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To create a linear index layer you must first select a linear feature to create an index for and
then select Tools >Outdated Tools > Create Linear Index Layer... from the MapLogic Layout
Manager toolbar.

The feature you select must be a continuous line with no breaks in it.

This will display the Grid Index Wizard dialog. In this dialog you need to set the properties of
the index grid. In order to accomplish this you must:

1. Set the direction of the linear
2. Set the size and order of the each cell in our grid
3. Set the destination of where the grid will be stored

The Grid Index Wizard dialog is divided into four tabs corresponding to the different parameters
we described above.
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Setting The Direction Of The Linear Index

¥ Untitled.mnd - ArcMap - ArcYiew =10 x|

J File Edit Yiew Insert Selection Tools Window Help

—
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EII@ FPage Lavouts
i -l Page Lapout1
=

@ Map Senes Layouts
-3 Page Layout 1 [Activi

EI Book, Lavouts =
Em Atlas of US Highways DT T
=81 Duevienita x|
i b [d Page Layout 1

=5 State Maps & Linear Index Laver is used to create a map senes that follows the
B Page Layout1 path of a linear feature such az a road or a river.

#- 81 Highway Index

Flovs Direction | Page Size I Output I

It pou look on the map pow will see that labels have been added to
the linear feature that was selected indicating the direction the
zenies will move along the feature. IF you would like to reverse this
direction, check the following option;

[~ Reverze direction
1] |

Displa_l,ll Source La_.,.gutsl ﬁ o eiI

J oo = & ] Ol7| AJ"| 2 |t

< Back MHest > Firiizh

If your ArcMap session is in “Data View”, labels will be added to the map showing the current

direction of the linear index. You can reverse the direction of this index by selecting the
Reverse direction checkbox.

MapLogic Layout Manager User’'s Manual Page 48




Setting The Grid Page Size And Order

YzLinear Index Wizard x|

& Linear Index Layer iz uzed to create a map zenes that follows the
path af a linear feature such az a road or a river.

Flow Direction  Page Size | Output I

The zize of each rectangle be can either in map unitz or page unitz. |f
you gelect page units, pou muzt alzo select a scale for each rectangle.

Width: | 9 32645691 740924
Height: | £ (5475024343634
Scale: 1: | 782739.363121305

= Map Unitz  (Meters)

afidth : I 0
Height : I 0
Cancel < Back Mext » Firizh

Now that you have determined the direction of the linear index, you need to tell the wizard what
the size of each cell should be. You can set the cell size in page units or map units.

To set the cell size in page units, you must tell the wizard at what scale you will be printing the
map series and how big you want each cell to be on the printed page. This is the preferred
method of creating a linear index, since you generally want to print a map series at a particular
scale. The default values for the cell width and height is the current size of the frame on the
layout.

To set the cell size in map units, you must tell the wizard how big an area you want each cell to
cover on the map.
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Setting The Output Destination

%rlinear Index Wizard x|

& Linear Index Layer iz uzed to create a map zenes that follows the
path of a linear feature zuch az a road or a river.

Flaw Direu:tiu:unl Page Size  Output |

Thiz ool will create rectangles that are placed in ine with the zelected
linear feature. These rectangles can be added o an existing layer or
a new layer.

{+ Create a new Layer:

IE:'\.T emp*Linear ndex. shp ﬂ

It encountering emor uging folder tool, Click Here
"~ Usze an existing Layer:

|<NDtSet> j

[T Clear laven [Select this option to delete all existing features]

Output Fields:

Fage Mumber: IF'g_NumI:uer j
Page Angle: IF'g_.-'l'-.ngIe j
Fage Scale: IF'g_Su:aIe j

[ | Start page numbers after ighest existing number

Cancel | ¢ Back | = | Finizh

The wizard saves the resulting index in a new shape file, or it can append or overwrite an
existing polygon layer in your map.

If you are using an existing layer, you must tell the wizard which fields it will use to store the
page number, page angle and page scale. If you are creating a new shape file, the wizard will
automatically create the fields to store this information in.

When saving into an existing layer, there are two options available to you:

Clear layer — this option clears any existing features from the layer before adding the new
polygons.

Start page numbers after highest existing number — If you are appending to existing
polygons, you can tell the wizard to start the page numbers after the highest page number that
already exists. For example, if there are already eight polygons in your index layer, the first
new polygon will be numbered as page 9.

Once you have set all your parameters, click the Finish button to create linear index.
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Managing Page, Map Series And Book Layouts

As was mentioned previously, the MapLogic Layout Manager allows you to store multiple page,
map series and book layouts within the ArcMap document. You manage the collection of
layouts in the document through the Layouts tab.

Table of Contents |

E[@ Page Lapouts
i [d] Page Layout 1
-3l Map Series Lapouts
=- Ty Book Layouts
=Ll Sample Map Baook
-3 Front Cover
@ Cover Lapout
(= [ntroduction
@) Intro Lapout
Key Map
@) Kep Lapout
kMap Pages
E First Page Lapout
E Map Series Layout [Active
- & Index Of Roads
First Page Layout
Index Layout

i
3

i
3

| 2]

1]
Displa_l,ll Source  Layouts |

The Layouts tab is a new tab that is added to the ArcMap Table of Contents by the MapLogic
Layout Manager. If the Layouts tab is not visible after you install the extension, you can make it
visible by selecting Tools > Options... in ArcMap’s main menu. Go to the TOC tab, make sure
Layouts is checked and press the OK button.

You create, copy/paste, edit, delete, rename and rearrange page layouts, maps series layouts
and book layouts through the Layouts tab.

Displaying Popup Menus In The Table Of Contents Layout Tab

Right-clicking on any item in the layouts tab will present you with popup a menu which allows
you to manage that item. For a full listing of all the different popup menus, please refer to the
section titled MapLogic Layout Manager User Interface.
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Show Lavout Manager Toolbar,.,

0]
| |
Displa_l,ll Source  |apouts | 3 |E|

Creating A New Layout

To create a new page layout right-click your mouse on where it says “Page Layouts” and select
“New Page Layout” from the menu that pops up.

Show Layouk Manager Toaolbar, ..

| =]

Displa_l,ll Source  Lapouts | 3 |E|

You can similarly create new maps series, map books, book sections and section templates.

Copying An Existing Layout

If you want to make a copy of an existing layout and modify it, you can Copy/Paste an existing
layout. To do this, right-click on the layout you want to copy and select “Copy” from the popup
menu. Then right-click again and select “Paste” from the popup menu.
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Displa_l,ll Source | aypouts |

EI% Page Layouts

E ...... Eap Sel| Activate
g
Book Lz Rename...

Crder »

Faste
Remove...

Moving Back And Forth Between Layouts

In order to see the contents of any layout in the ArcMap document you need to activate that
layout. In order to activate a layout, all you need to do is double-click on its name in the list or
right click on its name and select “Activate” from the pop-up menu. This will move the layout
that is currently being displayed to the background and print the new layout to the foreground of

your ArcMap session. The active layout is always displayed in bold letters in the table of
contents along with the word “(Active)” next to its name.

! x|

EI% FPage Layoutz

5
Book Lapouts Rename. ..

----- [# Page Layout 1 [Active]
)

tap Senes Laye M|

Crder k

Copey
FPaste

Remave...

Displayl Source | apouts |

Renaming Layouts
To rename a page, map series or book layout, right-click on a layout and select “Rename...".

Removing (Deleting) Layouts
If you would like to remove a layout from your ArcMap document, right-click on the layout you

would like to delete and select “Remove...” from the popup menu.

You should know that you can’t “undelete” a deleted layout. The extension will give you a
warning before deleting a layout.
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Rearranging Layouts

You can always rearrange the positions of a layout in the list of page layouts by right-clicking on
the name of the layout and then going to the “Order” menu.

=
El% FPage Layouts
. -[@ Page Layout 1 [Active]
(8
[ i.[@ p; ectivate
E Map©  Rename...
: Order Up
CESY To Top
stz To Bokkarn

Displa_l,ll SouUce  [apouts | 3 |E|

Rearranging is particularly important when dealing with sections in a map book as the order of
the sections is the order in which they are printed.

Managing Page and Map Series Layout Properties

The properties of a page or map series layout, including its paper size, the location of different
elements on the page, and the properties of those elements are all modified just as you have
done in the past in ArcMap.

Managing Map Book Properties

A map book is a collection of sections. You add and remove contents from a map book by
adding and removing sections. You do this just as you would with layouts by right-clicking on
the name of the book or section in the Layout tab.

MapLogic Layout Manager User’'s Manual Page 54



% Untitled.mxd - ArcMap - Arc¥iew -0l x|

J File Edit Wiew Insert Selection Tools Window Help
|IDSE& F B@% v« | d[zms o4& aa
J @ @ @J| @ EH m BIEEE 'I ||£||E| J Layout ™ Edt = ‘iew ™ Insert * Too

x|
Page Layouts
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EIEE Map Series Layouts
- - Ia Page Layout 1 [Active)
=-J] Book Laouts
=4 New Sectio
L8] Sec
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Rename...
Order r
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A map book does not have any properties other than the sections it contains.

Each section in a map book can have one or more templates (A Pro license is required to add
multiple templates to a section). A template is a layout which determines the contents of a
section. The reason for having multiple templates in a section is so that you can create
different layouts for different pages in the section.

For example, if you are printing a two-sided map book, you may wish to switch the binding
margin for odd and even pages. Or you may wish to move the page number so that it is always
on the outside edge of the page.

Another example would be a situation where one area of the map is so different from the rest
that you would like to create a different layout for it.

Managing Section Properties

To manage the properties of a section right-click on the section name and select Properties...
from the popup menu.
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Page Numbering

There are two general types of properties that you can manage for the section. The first is the
page numbering for a section.
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Section Propetties - State Maps ed |

MasterTemplateI Alternate Templates Fage Numberingfl

The page numbering for each page in a map book 1z automatically calculated
baszed on the number of pagesz in each zection and the aorder in which each
zection appears in the map book. “Y'ou can overide automatic page numbering
and start a zection at a particular page number.

{* Continue from previous section.

i~ Start at: I 1

Cancel ]

As you can see in the dialog, the normal behavior of a section is for its page numbering to
continue from the previous section in the book. The MapLogic Layout Manager automatically
keeps track of how many pages exist in each section of the book and numbers the pages
accordingly.

You can, however, override the default page number and set the starting page number of a
section to a particular value. To do this, click the Start at: option and then enter a new page
number.

This is useful if you have pages in your map book which you do not want counted. For
example, the map book might have a cover page layout which wouldn’t normally be counted.

Master And Alternate Templates

If you have a Pro license, a section can have more than one template layout. When there is
more than one template in a section, one of them must be selected as the master template.
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Section Properties - State Maps 7] ]

tdazter Template | Alternate Templates I Page Numberingl

The Maszter Template iz the primary kemplate for a section. Al ather terplates ik
the zection modify the master template by adding or substituting pagesz in the
mazter template [zee the Alternate Templates tab).

Select Master Template:

Page Layaout 1

Layo
Template 1
Template 2

Cancel )%

The master template is the primary template for the section. All other templates modify the
master template by adding or substituting pages in the master template.

MapLogic Layout Manager User’'s Manual Page 58



Section Properties - State Maps ed A

Master Template  Alkernate Templates | Page Numberingl

Alternate templates modify the master template either by adding pages to or
gubsztituting pages in the master template.

Alternate Templates:

Template 2

f+ Thiz template adds pages to the master template.
i~ This template substitutes pages in the master template.

tdd Options | Substitute Dptions

f+ Substitute even other page in master termplate,

For example. 12 page master and 12 page alternate = 12 Total
Fage 1: master, Page 2 alternate, Page 3: master... etc.

" Subshitute pages starting at the fallowing page: 1

Cancel 0k,

As you can see in the above dialog, you can select how each alternate template in the section
modifies the master template.

For example, suppose you want to create a two-sided map book where the template for the odd
and even pages are different. Let's say you want to move the page number so that it's always
on the outside edge of the page.

First you would create a template layout for the section. Then copy/paste that layout so you
have a duplicate of it. Modify the duplicate template so that the page number is in the
appropriate position.

Finally, display the properties of the section and set the second template as an alternate
template. Select This template substitutes pages in the master template and Substitute
every other page in master template. The extension will now alternate back and forth
between the two templates when displaying and printing the contents of the sections.

If you have only one template in a section the Master Template and Alternate Templates tabs
will be grayed out.

Modifying the contents of templates within a section is the same as modifying any other layout
in the ArcMap document.
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Where To Go From Here?

In this chapter you have learned the basics of managing (creating, deleting, copy/pasting,
renaming) page, map series and book layouts in the ArcMap document. However, the
MapLogic Layout Manager adds a number of new graphic elements that you can add to your
layout. These graphic elements are what make creating map series and books possible.

In the next chapters we will discuss the details of each of these new graphic elements.
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The Map Series Frame

What Is A Map Series Frame?

A Map Series Frame is how you display areas of the map in a map series (similar to a data
frame). However, unlike a data frame, a map series frame knows how to break the map onto
multiple pages using the contents of a special polygon layer called the Index Layer. For
example, if your Index Layer is breaking your map into 20 pages, the map series frame will
make the layout 20 pages long.

Adding A Map Series Frame To A Layout

To add a new Map Series Frame to a layout select Insert > Map Series Frame from the
MapLogic Layout Manager toolbar. You can only add map series frames to active map series
and book layouts. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to add a map series frame to a layout,
otherwise the tool is grayed out.
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Converting An Existing Data Frame To A Map Series Frame

You can also convert an existing data frame to a map series frame by selecting the data frame
and then selecting Edit > Convert Data Frame To Map Series Frame... from the MapLogic
Layout Manager Toolbar.

MapLogic Layout Manager k|
—— Llayout ™ |Edit ™ View ™ Insert ™ Tools ™ Help
1‘_ ﬂ Convert Data Frame To Map Series Frame
f[i] Convert Data Frame To Thematic Series Frame

; f[f] Convert Data Frame To Series Locator Frame
1_‘ ﬁ Convert Data Frame Tio senes key Erame

Convert Text Element Tio Series Text

Remowve senies Properties From Data Frame
Remove Thematic Series Properties From Data Frame
Hemowve Locstor Properties From Data Frame

Remowve Key Map Properties From Data Frame

Remove Page Index Properties From Element

Remove Series Index Properties From Element

:

Add Anchar Properties to Element

Remove Anchor Properties From Element

i
¥
o
o
|
% Remove Series Text Froperties From Text Element
I
i
b
i/
e

Secton Propertes. ..

g
S0 =] Bz u A B~ L 2~ | pbisher ~

You can only convert a data frame to a map series when the active layout is a map series or
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book layout. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to convert a data frame to a map series
frame, otherwise the tool is grayed out.

Modifying The Properties Of A Map Series Frame

To modify the properties of a map series frame, select the frame then right-click your mouse
and select Properties...

% Untitled - ArcMap - Arc¥iew -0l x|
J File Edit Miew Insert Selection Tools Window Help
| DEE& + BB X |- ~ | $|fmmmms |4 &8 Qa
J @ E @1| B [ B m EIEEZ 'I ||£||‘§| J Layout = Edit = Yiew ™ Insert ™ Too
:E] | I 1 I 1 I 1 I |4| 1 1 1 |8| 1 1 | ;I
m Page Layouts .
. -[# Page Layout 1 ] —=
EE@ b ap Senes Layouts 1 '||' I = !I
- [3 Page Layout 1 [Active) ] i 0 Add Data...
: Book Layouts g % cut Chrl
7 L Copy Chrl+iC
El by Delete Delete
4 ﬂ Conyert Tio Graphics
1 | | If Group e
i - Conemini IE: Unigraup
— — Graphic Operations » ;I
DISI:I|E|_|,|| Source  Layouts | 2 El o iI o , LI
= Crder
Jgrawing" k{:}||:|jﬁj£|l-&-fia| l|é
Mudge 3
Display the properties for the selected element I_ -542470.71 1241 | 1 S
Align 3
Diskribuke 3
Rotate or Flip 3
Properties. ..

Once the properties dialog for the frame is displayed, click on the Map Series tab to adjust the
map series properties.

There are three sub-tabs on the map series tab: series, adjacent page listings and options.

Modifying The Series Properties Of A Map Series Frame

The Series tab displays all the settings which determine how the contents of the map will
change as you move from page to page in a map series.
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General I Diata Frame I Coondinate System I llumination I Grids l Map Cache |
Annotation Groups I Extent Rectangles I Frame I Size and Position Map Series

:E] Map Seniez Properties [zome properties override Data Frame properties. |

Series | &djacent Page Listings I Options I Custom Eu:u:lel

The lozation of each page in the zenes i determined by a polygon [area) layer in the
[ata Frame called the 'Index Layer'. Each polygon in thiz layer represents a page in
the series.

Index layer:

To zort the pages, select a zort field and order.
[+ Sort the series uzing this feld: IF'g_Name
[T Reverze Order

— Page Scale and Reference Scale Settings
i+ Automatic [Best fit] Overlap: |2n Percent

L

L

" Fixed Scale 1: |10000

{~ Scale each page using thiz field: IF'g_Su:aIe

Lef Lo

[~ Set reference scale using feld: |<Nn:|ne>

Each page can be rotated differently uzing an angle =et in a rotation figld.

L

[~ Rotate each page uzing thiz field: |<N|:|ne>

The reference anid (&1, 42, B1. Etc.] around each page can be set uzing a field.

[~ Set reference gnd using thiz field: |<N|:|ne>

Kl

Fage namesz are uged for export file names and listing pages in Table of Contents.

Kl

[T Mame each page using this field: IF'g_Name

ok | Canesl | mppy |

The Index Layer

The Index Layer is a polygon layer in your map that determines the boundaries of each page in
the map series. Essentially, each polygon in the layer represents a page in the map series.
The extension examines the map and presents you with all the valid polygon layers for you to
choose from.
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The number of polygons in the index layer determines the number of pages in the series. If the
layer has a definition query (see ArcMap Help for more information), then only those polygons
that meet the conditions of the query are considered.

The Series Sort Order

Once you have selected the Index Layer, you have the option of sorting the pages in the layer
based on the value in one of the fields in the layer’s table. To do this check Sort the series
using this field: and then select the appropriate field name from the list.

If you created your Index Layer using one of the extension’s tools, there will be a field named
Pg_Number in your table which contains the page order you specified when the layer was
created.

The Reverse Order option reverses the sort order.

If no sorting option is selected, the order of the page in the series is the order of the features in
the layer’s table.

The Page Extent/Scale

You can set the extent of each page in the map series in one of three ways.

Automatic — This method zooms the boundaries of the map for each page so that the polygon
representing that page “best fits” the frame. If you select this option, you can also set an
amount of overlap between the pages.

Fixed Scale — This method sets the scale of the map to a fixed value for all pages in the map
series. Each page will be centered on the polygon representing that page. If the polygons in
the index layer are of different sizes, the series will ignore the size difference.

Scale Each Page Using Field — This method reads the scale for each page from a numeric field
in the index layer’s table. This is useful if you have specific scales that you want each page of
the map series to be set to.

If you created your index layer using one of the extension’s tools, there will be a field named
Pg_Scale in your table which contains the scale specified when the layer was created.

The Reference Scale

If you would like each page in the map series to have a particular reference scale, you can do
so by selecting a reference scale field. The values from this field in your Index Layer’s table will
be used to update the reference scale of the map as you move from page to page.

The Page Rotation

If you would like the pages in your map series to have different angles, you can select a
numeric field from which the page rotation will be read.

If you created a linear index layer using the extension, there will be a field named Pg_Angle in
your table which contains the rotation of each page in your linear index.

The Page Reference Grid

If you would like the reference grid (A1, A2, B1, B2, etc) around the map to change from page
to page in a map series, you can create a field that contains the name of the reference grid for
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each page in the series.

As the map series moves from page to page the name of the reference grid is read from the
selected field and the appropriate grid is turned on.

The Page Name

You have the option of assigning a page name to each page in the map series by selecting a
page name field. The page name does not appear anywhere on the layout itself, rather it is
used to display the names of pages in ArcMap’s table of contents as well as on the print and
export dialogs. This gives you additional options when selecting pages for display, print or
export.

Modifying The Adjacent Page Listing Properties Of A Map Series Frame

The Adjacent Page Listings tab displays all the settings which determine the properties of the
labels that appear on the edge of the map directing the user to the page where the map is
continued on.
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General I Data Frame I Coordinate System I [lumination I (Grids l Map Cache |
Annotation Groups I Extent Fectangles I Frame I Size and Postion ~ Map Series

:E] Map Seriez Properties [zome properties override Data Frame properties. ]

Seriez  Adjacent Page Listings I Dptions I Cusztorn E-:u:lel

An adjacent page lizting iz a label that appearz on the edge of the map that lists the
neighboring page(s).
[+ Label map with neighboring pages

Label Expression: (434D JACENT _PAGE_NUMBER E=pression... |
Label Symbol: Sprbal |
[+ Uniform

i Top }'\
= Battom v

= Left
= Fight

Label Placement: [v Top [+ Bottom [« Left [+ Right
Label Dffset: |0.12 o1z o1z o1z

Label Rotation: [5 ill [o ill [a0 ill [270 ﬁ
[~ Automatic [pointing in the direction of adjacent page]

Harmally, only ohe page iz listed as adjacent on each side of the map.

[ List all adjacent pages
[+ Rotate comner labels [label must be in exact cormer of frame)

QK I Cancel Apphy

If you would like these labels to appear around your map check the Label map with
neighboring pages option.

The Label Expression

The label expression determines the text for the label. You can modify the expression by
clicking the Expression... button. For more information about expression syntax please refer
to the Working With Expressions section of this manual.

The Label Symbol

To modify the label symbol click on the Symbol... button. The ArcMap Symbol Selector dialog
will be displayed to allow you to select a font symbol.

You have the option of selecting a uniform symbol for all four sides of the map or selecting a
different symbol for each side. Using different symbols for each side of the map allows you to
create marker backgrounds to the labels such as arrows.
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The Label Offset

The label offset determines how far the label is placed from the edge of the map. The value of
this offset is in layout units (inches or centimeters).

The Label Rotation

The label rotation determines the angle of the labels around the map.

If the rotation is set to automatic, the extension will draw a line between the center of the
current page and the center of the neighboring page and then align the label with this line.
Otherwise, the angles are set according to the numbers that appear in the Top, Bottom, Left
and Right input boxes.

The Label Placement (Top, Bottom, Left And Right) Option

The label placement options determine the side of the map on which labels are placed.

If you don’t want adjacent page labels to appear on one side of the map (for example, the
binding side of the paper), you can turn placement off using the Top, Bottom, Left and Right
checkboxes.

The List All Adjacent Pages Option

The default behavior of the adjacent labels is that one label will be added to each side of the
map (top, bottom, left and right). If there is more than one neighboring page on one side of the
map, the extension will find the page that is best aligned with the middle of that side.

If you check the list all adjacent pages option, all adjacent labels will be displayed around the
map. The extension draws a line between the center of the current page and the center of the
neighboring page to determine the location of the label.

The Rotate Corner Labels Option

If you choose to display all the adjacent page labels, you can choose to rotate the corner labels
so they appear at a 45 degree angle.

This option will only work if the labels are at the exact corner of the frame. In order to insure
this, your index layer polygons must have the same aspect ratio as the data frame and must be
aligned corner-to-corner with each other.

Modifying The Options Of A Map Series Frame
The Options tab displays some options relating to map series frames.
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General I Data Frame I Coordinate System I [lumination I (Grids l Map Cache |
Annotation Groups I Extent Fectangles I Frame I Size and Postion ~ Map Series

:E] Map Seriez Properties [zome properties override Data Frame properties. ]

SEriesl Adjacent Page Listings  Options | Custam E-:u:lel

By default the map ig dravn all the way o the edge of the Data Frame. v'ou may
chonze to clip all data beyond the boundaries of the index polygon, or mask these
areaz uzing a symbol. 1F you select both options, clip takes precedence.

[ Clip data to the outline of the index polygon

[v Mask areas outside of index polygon
* Add mask as layer - Laver mazks may not mazk annotation labels
= Add mask as graphic - Graphic masks can not be moved in TOC

Mazk Spmbol: Symbal...

Transparency: |5|:| 5

[ Invert Mask -Mazk inside polygon
[T Expand clip/mask boundary by ||:| map units.

Digoontinued options - Listed for compatability with older versions

Set default page to: |2

Start series on page: |-| of the template.

QK I Cancel Apphy

Clip Data To The Outline Of The Index Polygon

By default, when the map zooms to a page in the series, any overlapping areas around the
index polygon are displayed on the map. However, there are situations where you may wish
not to show the overlapping areas. For example, if you are doing a map book of US states, you
may wish to clip the displayed map to the boundary of each state. By checking this option, the
pages of the map series will be clipped to the boundary of each page’s index polygon.

Once you have modified all of the map series properties, click the OK or Apply button to save
your changes.

Mask Areas Outside Of The Index Polygon

This option is similar to the clip option except that areas outside of the index polygon are
masked using a symbol rather than clipped.
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Mask Symbol

You can choose any fill symbol as a mask. To modify the mask symbol click on the Symbol...
button. The ArcMap Symbol Selector dialog will be displayed to allow you to select a mask
symbol.

Mask Transparency

If you choose to create a Mask Layer you can also set the transparency for the mask layer.
This allows you to “fade” areas outside of the current page.

Mask Layer Vs. Mask Graphic

If you choose to mask areas outside of the index polygon, you have the option of placing the
mask as a layer or a graphic. If you choose layer masking, a layer is added to the ArcMap table
of contents. This allows you to modify the position of the mask layer and, therefore, modify
which layers are masked. However, a mask layer may not mask annotation labels.

Invert Mask

In some cases you may want to mask areas inside the index polygon rather than outside of the
index polygon. The Invert Mask Option allows you to mask areas inside the index polygon.

Expand Clip/Mask Boundary

This option allows you to expand the edge of the mask beyond the edge of the index polygon.
There are some cases where the boundary of the index polygon might be along a feature which
you don’t want to be hidden by the mask.

For example, if the edge of the index polygon follows a street center line, you may not want half
of the street itself to get masked. By expanding the mask boundary, you can control how far
away from the edge of the polygon the masking occurs.

The Default Page

The default page is the page that is normally displayed when you aren'’t previewing all the
pages in a map series. Normally, the first page in a maps series is the default page. However,
there are some situations where the first page may not be very representative of what the
series is going to look like. For example, it might be in an outlying area with very few features
on the map. In such a situation, you may wish to want a different page to be displayed when
you are editing your layout.

This option is now primarily accessed through the Layout Tab in ArcMap’s table of contents. It
exists on the dialog for compatibility with older versions of the extension.

The Series Starting Page

This option allows you to offset the page on which the map series is displayed on the layout.
For example, you may have two map series frames in your layout and you want one of them to
start after the first one finishes. By setting a starting page other than 1, the map series will be
hidden from the layout until that the series reaches the starting page.

This option is seldom used. It exists on the dialog for compatibility with older versions of the
extension.
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Modifying The Custom Code Of A Map Series Frame

If there are certain tasks that you would like performed on the pages of a map series that
MapLogic Layout Manager does not do, you can create your own Visual Basic code and run it

in between the pages of a map series. The Custom Code tab is where your custom code is
linked to the Map Series Frame.

The macro that is to run before or after the page is refreshed must follow a specific syntax.
More information about this syntax is provided at the end of this section.

General I Data Frame I Coordinate System I llumination I (Grids l Map Cache |
Annotation Groups I Bxdent Rectangles I Frame I Size and Position Map Series

:E] Map Serniez Properties [zome properties override Data Frame properties. ]
Seriesl Adjacent Page Listings I Option:  Custom Code |

E ach page in the map series can be customized wzing YBA macro either before or
after the page iz drawn. See help file far macro requirements.

—BEFORE [runs macro before activating the nest page in zeries]

[~ Bun macro before drawing page

Document Hame: |

[Froject, Mormal or TemplateFroject]
Module Hame: |

Macro Mame: |

—AFTER [runz macro after activating the next page in senies]

[T Bun macro after drawing page

Document Hame: |

[Project, Mormal ar TemplateProject]
Module Hame: |

Macro Mame: |

Sample Macro | - Createz a properly formatted zample macro

] I Cancel Apphy

You can run your custom code before or after a page in a map series is drawn. In order for

MapLogic Layout Manager to find your custom script, you must tell it what document, module
and macro it is contained in.

Run Macro Before Drawing Page

This checkbox activates the macro selected to run before the page is refreshed.
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Run Macro After Drawing Page
This checkbox activates the macro selected to run after the page is refreshed.

Document Name

Document name can have one of three values Project, Normal or TemplateProject. This refers
to the location of the document in which the macro is stored. If you are storing the macro in the
current MXD then type Project for the document name. If the macro is stored in Normal.mxt
then type Normal for the document name. If the macro is stored in a template other than
Normal being referenced by the MXD, then type TemplateProject for the document.

Module Name

The module name refers to the module within the document where the macro is stored. See
ArcMap’s Visual Basic editor for more information about modules.

Macro Name

Once the document and module name have been entered, the final step is to enter the name of
the macro that will run between the pages of the map series.

Sample Macro

The Sample Macro button will create a sample macro that you can use to get started in
customizing the map series. This is useful because your macro must be declared with a very
specific syntax.

Public Sub MapSeriesSample (pMap As IMap, pIndexLayer As IFeaturelayer,
pFeature As IFeature, lPageNumber As Long)

'The above 4 arguements are required for any macro you are
running from the map series frame.

'These arguements allow you to get information about the map
series page that is currently active.

'pMap: The MapSeriesFrame map

'pIndexLayer: The MapSeriesFrame index layer

'pFeature: The polygon feature in the index layer for the
current page in series

'1PageNumber: The current page number in the series

MsgBox "Map Name: " & pMap.Name & vbNewLine _
& "Index Layer Name: " & pIndexLayer.Name & vbNewLine _
& "Current Page OID: " & pFeature.OID & vbNewLine _
& "Current Page Number: " & lPageNumber
End Sub

As you can see in the above sample macro, any custom macro that is defined to run in between
the pages of a map series must have four arguments. MapLogic Layout Manager will pass
important information to your macro through these four arguments. These include the map (as
an IMap object, index layer (as an IFeatureLayer object), polygon feature (as an IFeature
object) and page number (as a Long number) of the page that is about to be refreshed.
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The Thematic Series Frame

What Is A Thematic Series Frame?

Land Cover Classification Map Zoning Map

i ¥ U T

A Thematic Series Frame is how you display themes of the map in a map series (similar to a
data frame). However, unlike a data frame, a thematic series frame knows how to generate
multiple pages using different layer settings. For example, a thematic series frame might
generate a land use and a zoning map from the same layout by changing layer visibility on
selected layers.

In order to create a thematic series, one or more Themes are created. Each theme controls:

1. The visibility settings of all layers in the map (i.e. whether a layer is turned on or off)

2. The order of the layers in the map

3. The map extent (optional)

4. Custom text. Custom text can be used to change text elements on the layout. For example,
map titles.

Adding A Thematic Series Frame To A Layout

To add a new Thematic Series Frame to a layout select Insert > Thematic Series Frame from
the MapLogic Layout Manager toolbar. You can only add thematic series frames to active map
series and book layouts. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to add a thematic series frame to a layout,
otherwise the tool is grayed out.
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MaplLogic Layout Manager |

Layout * Edit * View ¥ |Imsert ¥ Tools * Help -

EE] Map Series Frame

@ Thematic Series Frame

Series Locator Frame
Ef] Series Key Frame
E&] Series Text
il Page Index
L]
3

Series Index

Page Layout

Series Layout

Map Books 2

Converting An Existing Data Frame To A Thematic Series Frame

You can also convert an existing data frame to a thematic series frame by selecting the data
frame and then selecting Edit > Convert Data Frame To Thematic Series Frame... from the
MapLogic Layout Manager Toolbar.

MapLogic Layout Manager |
Layout * |Edit = View ¥ Insert * Tools * Help -
o f[‘i] Convert Data Frame To Map Series Frame
@ Convert Data Frame To Thematic Series Frame
ﬁnﬁ] Convert Data Frame To Series Locator Frame
% Convert Data Frame To Series Key Frame
ﬁ Caonvert Text Element Tio Series Text

Remove Series Properties From Data Frame

Remove Themzatic Series Froperties From Data Frame
Remove Locator Properties Erom Dats Erame
Remowve Key Map Properties From Data Frame
Remove Series Text Froperties From Text Element
Remove Page Index Properties From Element

Remove Series Index Properties From Element

Add Anchor Properties to Element

Remove Anchor Properties From Element

0§ | & Go | R & X R W

oection Propertes. ..

You can only convert a data frame to a thematic series when the active layout is a map series
or book layout. If the active layout is a page layout, the tool is grayed out.
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You must have a Basic, Advanced or Pro license to convert a data frame to a thematic series
frame, otherwise the tool is grayed out.

Modifying The Properties Of A Thematic Series Frame

To modify the properties of a thematic series frame, select the frame then right-click your
mouse and select Properties...

% Untitled - ArcMap - Arc¥iew -0 x|

J File Edit Wiew Insert Selection Tools ‘Window Help
JDE—”E%H% By @B X | o | & [oswie o] o2 |@|§9J@@
J @ @l@| @ @ Ej m BIEEZ 'I ||§T|i| J Layoutk * Edit * Wiew * Inserk ™  Too

: E] | I 1 I 1 I 1 I |4 I 1 I 1 I 1 I |8 I 1 I 1 I | ;|
E@ Page Layouts .
 i.[@ Page Layout 1 ] e - - ==
El EE b ap Senes Layouts 1 . = — ! == !I
[ Page Layout 1 [Active) ] . <X Add Data. ..
----- r- Book Layouts - 2 oo Chrls
7 & % _ 4Tt B Copy Chrl+iC

Delete Delete

EraUp

EW
ﬂ Camyert Tio Graphics
I
I

_- - Cantemini
— — Graphic Operations »
DISI:I|E|_|,|| Source  Layouts | 3 E| o iI

Ungroup

B
L

— Crder »

Jgrawing" kf:}||:|jﬁj£|l-ﬁ-fia| l|é
Mudge 3

Display the properties For the selecked element I_ -547470,71 1241 | 3 L
Align 3
Distribute 3
Fuokate ar Flip 3

Properties...

Once the properties dialog for the frame is displayed, click on the Themes tab to adjust the
thematic series properties.

Adding, Removing, Rearranging And Activating Themes

A thematic series is created by generating one or more themes that control the layer settings for
a given map.
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General I Data Frame I Coordinate System I llumination I Grids I Map Cache |
Annotation Groups I Bxdent Rectangles I Frame I Size and Position Themes

A theme records a map's laver settings and map extent.

Zoning Activate Theme
Land Cower Claszification
Aerial Photography

MHew Theme...

Copy Theme

FRemove Theme

Properties. ..

1
!

The Active theme iz in bold letters

oK Cancel Apply

The Theme List

Each time a new theme is created it is added to the list of available themes.

The order of themes in this list is the order in which they will be displayed in the Layouts tab in
ArcMap’s table of contents. You can rearrange the order of themes in the list by highlighting a
theme and using the up and down arrows on the dialog to rearrange its position.

There is a check box in front of each theme in the list. This check box controls whether the
theme is to be considered or ignored in the thematic series. An unchecked theme is essentially
dormant and will be excluded from the pages of a thematic series.

Activating A Theme

The theme that is currently being displayed is called the Active Theme and is highlighted in bold
letters in the theme list.

You can activate a theme be selecting it in the theme list and clicking the Activate Theme
button.
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Once you hit OK or Apply on the data frame properties dialog, the map will switch to the
activated theme.

Creating A New Theme

If you would like to add a new theme to the list of available themes, click the New Theme
button. This will bring up the Theme Properties dialog which will allow you to modify the setting
for the new theme.

Copying An Existing Theme

If you would like to make a copy of an existing theme, select the theme in the theme list and
click the Copy Theme button. This will create a copy of the theme and add it to the theme list.
You will then be able to edit the properties of this theme to change its settings.

Removing A Theme

If you would like to remove a theme, select the theme in the theme list and click the Remove
Theme button. This will remove the selected theme from the list of themes. Note that the
changes are not permanent until you hit OK or Apply on the data frame properties dialog.

Editing The Properties Of A Theme

The properties of a theme can be modified by activating the Theme Properties dialog. To
display the properties of a theme, select the theme in the theme list and click the Properties
button.

The Theme Name

Each theme is assigned a default name when it is created. You can modify the name of a
theme by changing the Theme Name displayed in the theme properties dialog.

The theme name will be displayed in the Layouts tab in ArcMap’s table of contents. The theme
name can also be used when creating export file names.

It is a good idea to give each theme a meaningful name rather than the default name that the
software assigns it.
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Modifying The Layer Visibility Properties Of A Theme

isi. Theme Properties x|

Theme Mame: IZDﬂiﬂg

Layer Yizsibility I Layer I:Iru:lerl tap Extent I Cuiztam Te:-:tl Options I

Select which layers are turned on ar off far thiz theme:

SEMSTR
Zoning
[ Land Caver Classification

B ey Welsy Al On | Al 0f |

<Bach Mext > | 0K

The layer visibility properties of a theme control which layers will be turned on and which layers
will be turned off for a given theme.

You modify the visibility of a given layer by checking or un-checking the layer in the list.
Current Layer Visibility

The current layer visibility button will read the current layer settings for the map and assign
these settings to the layers in the list.

All On/All Off

These buttons will turn all layers on and off.

Modifying The Layer Order Properties Of A Theme
The layer order properties of a theme controls the arrangement of layers in the map.

MapLogic Layout Manager User’'s Manual Page 78



. Theme Properties x|
Theme Mame: IZ-:uning

Layer Yizibility  Layer Onder | tap E=tent I Custom Te:-:tl Options I

[T Sort Layers

Select the laver order for thiz theme [layers in groupz can't be reardered):

Zu:uning S

Land Cowver Clazsification J.

Current Laper Order |
Cancel | < Back Meut > k.

Turning on Layer Sorting
The Sort Layers checkbox activates the option to sort layers.
Rearranging The Layer Order

To rearrange the order of layers in the map select a layer and use the up and down arrow
buttons to move its position in the list of layers.

IMPORTANT: You can not change the order of layers within group layers.
Current Layer Order

The current layer button rearranges the layers according to how they currently appear in the
map.

Modifying Map Extent Of A Theme

The map extent properties of a theme control the visible extent of the theme. The map extent
of the map can be controlled in one of 4 ways.
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. Theme Properties x|

Theme Hame: |Zu:uning|

Layer Visil:uilit_l,ll Layer Order M ap Extent | Custam Te:-:tl Dptions I

Select map extent for this theme:

{+ Do not adjust map extent

" Set map extent manually:

Lower Left; Upper Right:

A R8s 192.21 # | 572,232.80 EurrentE:-:tentl
T 155513319 1 | 157347427  Full Extent |

= Set extent from bookmark:

|<N|:|ne> j

If the Data Frame alzo hiaz map series properties, the extent iz 2et by the map
IENEE.

Cancel < Back Mext » k.

Do Not Adjust Map Extent

This option leaves the map extent unchanged. When the theme is activated the map extent will
remain the same as it was before the activation.

Set Map Extent Manually
This option allows you to manually define the map extent. The Current Extent and Full Extent
buttons allow you to read the lower left and upper right values of the extent from the current

map.

When the theme is activated, the software will read the lower left and upper right coordinates
entered here and zooms to the resulting extent.

Please note that if the coordinates entered does not match the aspect ratio of the map frame,
the map will be “best fit” given the extent values.

Set Extent From Bookmark
If you have set up bookmarks for your map, you can use these bookmarks to control the extent

of the map when the theme is activated. You will be presented with a list of available book
marks to choose from.
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Set Extent From Map Series Properties

If the thematic series frame is also a map series frame, the extent settings of the map series
overrides the extent settings of the thematic series.

For example, if the map series properties are dividing the map into 20 pages, and the thematic
series properties contain 2 themes, the result will be a 40 page series. In other words the
software will generate each theme over the twenty map extents.

Modifying Custom Text Of A Theme

Each theme can have up to four custom text settings. You can use these custom text settings
in conjunction with Series Text elements to generate dynamic text on the layout. More
information about series text elements can be found later in this document.

. Theme Properties x|

Theme Hame: |2|:uning

| Options I
Custarn bext can be uzed with Series Text elements ta create dunamic text labels.

Custom Text 1:

H O

Custom Text 2:

H O

Custom Text 3:

H O

Custom Text 4:

1l

K

Cancel < Back M et > | ]

You can use the custom text settings to change map titles, notes or any other text on the layout.
This allows a theme to control more than just the layers. It can change the entire look of the
map layout.

Modifying The Options A Theme

After a theme has been created, there may be new layers that are added to the map. Since the
theme was created before these layers were added, the theme settings do not include
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instructions as to what to do with these layers. The options tab allows you to instruct the
software to turn new layers on, off, or just ignore them.

. Theme Properties X|
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The Series Locator Frame

What Is A Series Locator Frame?

A Series Locator Frame shows you which part of the overall map is being displayed on the
current page. For example, if you create a map book of U.S. States, you might want a small
map of the entire United States on each page highlighting the location of the state that is
currently being displayed. A series locator frame is designed for this purpose.

Adding A Series Locator Frame To A Layout

To add a new series locator frame to a layout, select Insert > Series Locator Frame from the
MapLogic Layout Manager toolbar. You can only add series locator frames to active map
series and book layouts. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to add a series locator frame to a layout,
otherwise the tool is grayed out.

MapLogic Layout Manager |

Layout = Edit = View |Insert * Tools * Help =

[E] Map Seties Frame

@ Series Key Frame
EE] Seties Texkt
mﬁj Seties Index

a Page Layout

a] Series Layaout
Map Books 3

Converting An Existing Data Frame To A Series Locator Frame
You can also convert an existing data frame to a series locator frame by selecting the data
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frame and then selecting Edit > Convert Data Frame To Series Locator Frame... from the
MapLogic Layout Manager toolbar.

a . e A
MaplLogic Layout Manager =]
Layouk = |Edt = View ™ Insett * Tools  Help =

f[i] Conwett Data Frame To Map Series Frame

Convert Daka Frame To Series Locakor Frame

Canvert Data Frame To Series Keyw Franme

Conyert Texk Element To Series Texk

Remove Series Properties From Data Frame

Remove Locatar Properties Erom Data Frame

Remove ey Map Properties Fram Lata Frame
Remoyve Series Texk Properties From Text Element

Remove Series Index Properties Fram Element

iy | R R R R R

sechion Froperties, .,

x OOl Al = F Sifo <l s 7 u

3

You can only convert a data frame to a series locator frame when the active layout is a map
series or book layout. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to convert a data frame to a series locator
frame, otherwise the tool is grayed out.

Modifying The Properties Of A Series Locator Frame

To modify the properties of a series locator frame, select the frame then right-click your mouse
and select Properties...
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% Untitled - ArcMap - Arc¥iew o ]

J File Edit Wiew Insert Selection Tools ‘Window Help
JDE”E%H% By @ X | o o | |[1:20597.77% ﬂ|'~\£|i§j|'*?J@@
J @ @l@| @ @ Ej m BIEEZ 'I ||§T|i| J Layoutk * Edit * Wiew * Inserk ™  Too

E] | I 1 I 1 I 1 |4 I 1 1 1 |8 I 1 1 | ;|
m Page Layouts .
. -[# Page Layout 1 2
. BN
EIE@ bap Series Layouts T T
- [si Page Layout 1 [Active] ] i 0 Add Data...
¥ Book Layouts g ¥ cut Chel
. SOy Copy Chrl+C
El o s by Delete Delete
4 ﬂ Conyert Tio Graphics
1 _ If Group b
_ Cantemin IE: ul'lgrl:ﬂ.lp
— — Graphic Operations » ;I
DISI:I|E|_|,|| Source  Layouts | 2 E| o ﬂ ﬂ
— Qrder »
Jgrawing" k"f:}||:|jﬁj!z|l-‘f‘-"a| l|é
Mudge 3
Display the properties For the selecked element I_ -547470,71 1241 . R 3 L
Distribute 3
Rotate or Flip 3
Propetties. ..

Once the properties dialog for the frame is displayed, click on the Series Locator tab to adjust
the map series properties.

There are three sub-tabs on the series locator tab: locator, current page symbol and options.

Modifying The Locator Properties Of A Series Locator Frame

The Locator tab displays all the settings which determine how the contents of the map will
change as you move from page to page in a map series.
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Data Frame Properties ﬂﬂ

General I Data Frame I Coordinate Syztem I [ lurnination I Gnids I Labels |
Annotation Groups I Eutent Rectangles I Frame I Size and Position  Series Locator

M Senes Locator Properties [zome properties overide D ata Frame properties. ]

Locator | Current Page S_l,lml:u:ull Elptiu:unsl

& Senes Locator Map iz a zmall map placed on the page which shows the location of
the current page in the senesz with rezpect to all the other pages in the zenes. In
order for the locator map to update itzelf az the series moves from page to page., it
muzt be tied to a bMap Seriez Frame.

Map Sernies Frame: |Morth Amernica j

Generally a locatar map'sd
you can 22t the map exten
page in the zenes.

[~ Always center the map on the current page in the series

If the map series changes rotation from page to page. the locataor frame can be set o
fallow the zame ratation.

[~ Rotate the locator map along with the map zeries frame

QK. I Cancel Apply

The Map Series Frame

The basic step in setting the properties of a locator map is telling it what map series frame it
relates to. By linking the locator map to the map series frame, it will know how to update itself
as the map series moves from page to page.

The extension examines the layout and displays a list of map series frame for you to choose
from.

Always Center Locator Map
This option pans the locator map as you move from page to page so that the current page is

always in the center of the map. This is useful if the extent of the locator map is not zoomed
out far enough to show all the pages in a series.
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Rotate Locator Map Along With Map Series

If you have setup your map series so the rotation of the map changes as you move from page
to page, selecting this option will make the locator map to copy that rotation.

This is a good way to orient the user as to what is the direction of the page in a map series.

Modifying The Current Page Symbol Properties Of A Series Locator

Frame

The Current Page Symbol tab displays the settings which determine how the current page will
be highlighted as you move from page to page in a series.

Data Frame Properties

(" Senes Locator Properties [zome properties ovemnde Data

Locator |_Curent Fage Symbol I Optians |

Frame properties. ]

Y'ou can chooze the sumbol that will be uzed to highlight the curent page on the

loz:ator map.
[+ Highlight the current page on the map

" Add highlight az layer - Layer may not mazk annotation labels

f+ Add highlight az graphic - Graphic can not be moved in TOC

Highhght Spmbol:

Symbal...

2%

General I Data Frame I Coordinate System I [Nlumination I (Grids | Map Cache |

Annatation Groups I Extert Rectangles I Frame I Size and Position ~ Series Locator

Transparency: |5|:| %

If you would like evemything but the current page boundary to be

highlighted check the [nvert highlighted area option.
[~ Invert highlighted area

oK

Cancel

Apply

Highlight The Current Page

This option tells the extension that it should highlight the current page in a map series. This is
the normal behavior of a locator map. If you don't select this option, the map will pan over to
the center of the current page, but nothing will be highlighted.
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Current Page Symbol

The symbol property is the fill color and pattern you would like the current page of a map series
to be highlighted with. The default symbol is your ArcMap selection symbol. Click the
Symbol... button to change the current page symbol.

Highlight Layer Vs. Highlight Graphic

You have the option of placing the highlight as a layer or a graphic. If you choose to highlight
using a layer, a layer is added to the ArcMap table of contents. This allows you to modify the
position of the highlight layer and, therefore, modify which layers are covered by it. However, a
highlight layer may not cover annotation labels.

Highlight Transparency

If you choose to create a Highlight Layer you can also set the transparency for the highlight
layer. This allows you to “fade” the highlighted area.

Invert Highlighted Area

This option allows you to invert the area that is highlight for visual effect. So instead of:

You will get:

LA TR e

Modifying The Options Of A Series Locator Frame
There is only one option on a Series Locator Frame.
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Data Frame Properties ilil

General I Data Frame I Coordinate System I [ lurmnination I Grids | Labels |
Annatation Groups I Estent Rectangles I Frame I Size and Position ~ Series Locator

" Series Locator Properties [szome properties overnide D ata Frame properties. ]

Sometimes a map series frame doesn't appear on every page in the zeries. The
lazator map can be zet ta follow itz parent frame's wvigibility.

[+ If map zeriez frame izn't visible, hide the locator frame as well

Locator I Current Page Symbol

] Caricel Apply

If Map Series Frame Isn’t Visible, Hide Locator Frame As Well

Depending on how you have setup your map series frame, there are certain situations where
the map series is not visible on the page. By selecting this option, the locator map will follow its
parent map series visibility.

Once you are finished modifying the series locator frame’s properties, click OK or Apply to save
your settings.
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The Series Key Frame

What Is A Series Key Frame?
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A Series Key Frame is used to create key maps. A key map is an overall map of the area in the
map book showing what page the details for each area of the map can be found. For example,
you might want a map of the entire United States at the beginning of your map book showing
the page number where each state can be found. A series key frame was designed for this
purpose.

Adding A Series Key Frame To A Layout

To add a new series key frame to a layout select Insert > Series Key Frame from the
MapLogic Layout Manager toolbar. You can only add series key frames to active book layouts.
If the active layout is a page layout or map series layout, the tool is grayed out.

You must have an Advanced or Pro license to add a series key frame to a layout, otherwise the
tool is grayed out.
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MaplLogic Layout Manager |
Layout * Edit = View |Insert * Tools * Help «

[E] Map Series Frame

[18] Thematic Series Frame
[E] Series Locator Frame
Ef] Series Key Frame

Efi] Series Text

i Page Index

|I|E'_'| Series Index

& Page Layout

& Series Layout
Map Books 2

Converting An Existing Data Frame To A Series Key Frame

You can also convert an existing data frame to a series key frame by selecting the data frame
and then selecting Edit > Convert Data Frame To Series Key Frame... from the MapLogic
Layout Manager toolbar.

MaplLogic Layout Manager ]
—— Llayout ™ |Edit ™ View ™ Insert ™ Tools ¥ Help =
1‘_ f[i] Convert Data Frame To Map Series Frame
}n[i] Convert Data Frame To Thematic Series Frame

Remove Thematic Series Properties From Data Frame
REemove Locator Properties Erom Dats Frame
Remowve Key Map Properties Erom Data Erame

Remove Series Text Froperties From Text Element

Remove Series Index Properties From Element

Add Anchor Properties to Element

Remowve Anchor Properties From Element

G
i
|
i
E Remove Faoe Index Properties From Element
i
&
i
g

Sechon Propertes. ..

I
St <] Bz u|A~v &~ B o~ | pubisher v

You can only convert a data frame to a series key frame when the active layout is a book
layout. If the active layout is a page layout or map series layout, the tool is grayed out.
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You must have an Advanced or Pro license to convert a data frame to a series key frame,
otherwise the tool is grayed out.

Modifying The Properties Of A Series Key Frame

To modify the properties of a series key frame, select the frame then right-click your mouse and
select Properties...

% Untitled - ArcMap - Arc¥iew -0 x|

J File Edit Wiew Insert Selection Tools ‘Window Help

| DEE& ¢ 2@ X |0 | $|fasmm |4 &8 | Qa

J @ El@| @ @ E] m BIEEK vI ||§T|i| J Layouk * Edit = Yiew ™ Insert ™  Too

E] | I 1 I 1 I 1 I |4 I 1 1 1 |8 I 1 1 | ﬂ
m Page Layouts .
- e[@ Page Layout 1 = e = 7 =
E‘EE Map Seres Layouts T i = '||' — !I
~ -[& Page Layout 1 [Active) ] =3 Yoromd B Add Data
Book Layauts - g Ut (o
. ! e Copry Chrl+C
T . P XK Delete Delete
4 hﬁ. ﬂ Comyert Tio Graphics
. | If Group 7

- IEH Canemin IE: Unigraup
— — Graphic Operations »
DISI:I|E|_|,|| Source  Layouts | 3 E| o iI

B
L

e Qrder »

Jgrawing" kf:}||:|jﬁj£|l-ﬁ-fia| l|é
Mudge »

Display the properties For the selecked element I_ -547470,71 1241 | 3 L
Align 3
Distribute 3
Rokate ar Flip 3

Properties. ..

Once the properties dialog for the frame is displayed, click on the Series Key tab to adjust the
map series properties.

There are three sub-tabs on the series locator tab: locator, key labels and options.

Modifying The Key Properties Of A Series Key Frame

The Key tab displays all the settings which determine where the key map will get the
information of the map series it relates to.
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Data Frame Properties ilil

General I [ ata Frame I Coordinate System I [rninatior
[rids I Labelz I Annatation Groups | Extent Rectangles
Frame I Size and Position Seres ey | Feature Link

Eeries K.eyp Properties
K.ey | K.en Labels I Optione I

& Seriez Key Map iz a map of the entire extent of a map zenes with labelz showing
the page location of each area. & Series Key must be linked to a Map Senes
Frame in order to properly label the map.

Section:

I State Maps j
Template:

IF'age Layout 1 j

Map Seriez Frame:

] I Canicel Apply

In order for a key map to display the location of each page in a map series, it must be linked to
the map series that it will get the information from. A key map usually appears at the beginning
or end of a map book, detailing where the user can find the detailed map for an area. Itis
usually placed in the layout of a section other than the map series itself.

Therefore, to link the key map to its parent map series, you must select the section, template
and map series frame.

Modifying The Key Labels Properties Of A Series Key Frame

The Key Labels tab displays all the settings which determine the properties of the labels that
appear on the map directing the user to the appropriate page in the map book containing the
detailed map for a page.
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Data Frame Properties ilil

General I [ ata Frame I Coordinate System I lurmiriation

[Erids I Labelz I Annatation Groups | Estent Rectangles

Frarme: I Size and Position Seres Key | Feature Link
Series Key Properties

I Options I

The labelz on a key map are generated uzing an exprezsion which defines the label
test and a font zymbaol.

Label Expression: |<FNT Expression...
size="B">[STATE_MAME]</FNT>
$3PAGE_MNUMBER

Symbol Preview: Spmbal...
Arial 14
Alignment: |- j
Angle: |0
] Cancel | Apply |

The Label Expression

The label expression determines the text for the label. You can modify the expression by
clicking the Expression... button. For more information about expression syntax, please refer
to the Working With Expressions section of this manual.

The Label Symbol

To modify the label symbol click on the Symbol... button. The ArcMap Symbol Selector dialog
will be displayed to allow you to select a font symbol.

The Label Alignment
If your label has more than one line, you may want to set the alignment of the lines in the label.
The Label Angle

You may also set an angle for the labels, if you want them to have a rotation other than
horizontal.
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Modifying The Options Of A Series Key Frame
There is only one option on a Series Key Frame.

Data Frame Properties ﬂil

General I Data Frame I Coordinate Syztem I Ilurnination I
Gridz I Labelz I Annotation Groups | Estent Rectangles I
Frame I Size and Position Series Key | Feature Link

Series Key Properties

Autorefrezhing the F.ey i ap forces the key labels to be recreated each time the
frame iz drawn [far printing or previewing). Thiz option removes all existing labelz
and replaces them with new one's. [F pou would like ta move the labels on the map
after they have been created, uncheck Auto Refresh. However, keep in mind that
whenewver you come back to this dialog and change the key properties, the labelz
will be recreated when you Click OF. or Apply.

[+ Auto-Refresh Key Map

k. Cancel Apply

By default, the series key frame refreshes all the labels on the map every time the map is
previewed or printed. This insures that the page numbers in the key map are accurate as you
modify the contents of the map book.

If you do not like the default placement of the labels on the map, you may want to manually
move the location of the labels. By turning Auto-Refresh off, you insure that the extension will
not override your label placement.

However, keep in mind that whenever you go back to the properties dialog of the key frame and
change the key map’s properties, the labels will be recreated when you hit Apply or OK.

Once you are finished modifying the series key frame’s properties, click OK or Apply to save
your settings.
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The Series Text Element

What Is A Series Text Element?

Northeast Quadrant
Seminole County, Florida

A Series Text Element is used to create dynamic text on the pages of a map book. For
example, if each page of a map book is showing a unique Section, Township and Range, you
may want to create a text box that shows what the Section, Township and Range values are on
each page of the map book. If you have this information in your index layer, you can use the
Series Text Element to create a text box that dynamically lists this information from page to

page.

Adding A Series Text Element To A Layout

To add a new series text element to a layout select Insert > Series Text from the MapLogic
Layout Manager toolbar. You can only add series text elements to active map series and book
layouts. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to add a series text element to a layout,
otherwise the tool is grayed out.

MapLogic Layout Manager k|
Layout * Edit  View * |[Insert ™ Tools  Help «

E]E] Map Series Frame

E]E] Thematic Series Frame
EE] Series Locator Frame
[;f] Series Key Frame

] Page Index
quEfI Series Index

a Page Layout

& Series Layout
Map Books 2

Converting An Existing Text Label To A Series Text Element

You can also convert an existing text label to a series text by selecting the text element and
then selecting Edit > Convert Text Element To Series Text... from the MapLogic Layout
Manager toolbar.
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MaplLogic Layout Manager |

Layout * |Edit * View ¥ Insert ¥ Tools ¥ Help «

:

CaonvertData Frame To Map Series Frame
Convert Data Frame To Thematic Series Frame
Caonvert Data Frame To Series Locator Frame

ConvertData Frame Mo senes key Erame

Convert Text Element Tao Series Text

Remowve Series Properties From Data Frame

Remove Themzatic Series Properties From Data Frame
Remove Locator Properties Erom Datas Frame
Remowve Key Map Propertes From Data Frame
Remove Series Text Froperties From Text Element
Remove Page Index Properties From Element

Remove Series Index Properties From Element

Add Anchor Properties to Element

Remove Anchor Properties From Element

| & G| R = X IR R RS RS S S

oecton Propertes. ..

You can only convert a text element to series text when the active layout is a map series or
book layout. If the active layout is a page layout, the tool is grayed out.

You must have a Basic, Advanced or Pro license to convert a text element to a series text
element, otherwise the tool is grayed out.

Modifying The Properties Of A Series Text Element

To modify the properties of a series text, select the text element then right-click your mouse and
select Properties...
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Once the properties dialog for the element is displayed, click on the Series Text tab to adjust

the series text properties.
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Modifying The Series Text Properties Of A Series Text Element

2] x|
Teat I Size and Postion Seres Tead |

@ Sernies Text Properties [zome properties overnide Text Element properties.]

& Series Text Element iz a text label placed on the page which updates itzelf bazed
ah the current page in the series. The text to changes as the zenies maoves from
page ko page. Depending on what object the source of the senes text iz, different
expreszionz can be defined for it.

Label Source:
{* Get text from the book or series lapout [page number, etc. ]
= Get text from a Map Series Frame:

|<N|:|ne> j

" Get text from a Thematic Index Frame:

|<N|:|ne> j

" Get text from a Seres Index Frame:=

|<N|:|ne> j

* Thiz option iz for map books which requires an &dvanced or Pro license.

Sometimes a zeriez element [Map Series Frame, etc.] doesn't appear on eveny page
it the zeriez. The series text can be set ta fallaw ite parent frame's wizibility.

[+ If parent senes frame izn't vizible. hide the zeries text az well

Label Expression:

The test in the label iz determined by an expression that extracts information
frorn itz sounce.

$FPAGE_MUMBER ;I Expreszion... |

[~ Wrap text if longer than I 0 characters

QK I Cancel Smply

In order for the Series Text Element to update itself as the map series moves from page to
page, it needs to know what the source of the label as well as the expression for the label.

The Label Source

A series text element can retrieve information from three different sources: the series layout, the
map series frame, and the series index frame. The current page number is a good example of
information you would get from the layout.

The Series Layout — The series layout can provide information like the page number, the name
of the layout, section or map book, and the total number of pages in the map series and so on.
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The Map Series Frame — The map series frame can provide all the information in the Index
Layer’s table for the current page of a map series. For example, if you have a map series of US
States, you can retrieve the name of each state from the Index Layer’s table.

The Thematic Series Frame — The thematic series frame can provide the theme name as well
as any of the four custom text objects that can be defined for each theme.

The Series Index Frame — A series index frame lists the location of features in a map book (i.e.
Main Street, Page 9). The series index frame can provide information about the first and last
listing of the index that is being displayed on the current page. Much like a phone book, you
may want to have a label on the page which shows what listings can be found on the current
page (i.e. “Main Street to University Avenue”).

The Label Expression

The label expression determines the text for the label. You can modify the expression by
clicking the Expression... button. For more information about expression syntax please refer
to the Working With Expressions section of this manual.

The Hide Label Option

Depending on how you have setup your map series frame, there are certain situations where
the map series is not visible on the page. By selecting this option, the series text will follow its

parent map series visibility.

Once you are finished modifying the series locator frame’s properties, click OK or Apply to save
your settings.
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The Page Index Element

What Is A Page Index Element

ALFIHEDR.....coee. RAIMNTREE CT............. 2B
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A Page Index Element is used to create indexes of features on your map. An index is an
alphabetical listing of feature in a map and where they can be found. For example, if you are
creating a road map book, you may wish to have a listing of where each road can be found in
the map (Main Street.... B-4).

A page index is always created in conjunction with a data frame on the layout.

IMPORTANT: By default you must allow enough space for the index to list all the features that
appear on the page otherwise some features will be dropped from the index. There is an option
in the page index properties which allows the page index frame to expand until all the features
have been listed.

Indexes are created based on the labels of features on the map or the features themselves.
However, consideration needs to be made as to what is being indexed. Sometimes the user
will not be able to find a feature on the map unless there is a label associated with it. For
example, if Main Street is within the grid cell B-2 of a map, the user may not be able to figure
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out which road on the map in that area is Main Street unless there is a label for it. On the other
hand, the location of a fire station may not require a label since there is an appropriate symbol
on the map which shows the user where the fire station is located, and the likelihood of two fire
stations existing close to each other is slim.

Adding A Page Index Element To A Layout

To add a new page index element to a layout select Insert > Page Index from the MapLogic
Layout Manager toolbar. You can add page index elements to active page, map series, or book
layouts.

You must have an Advanced or Pro license to add a page index element to a layout, otherwise
the tool is grayed out.

MapLogic Layout Manager =]
Layout * Edit * View ™ |Insert * Tools ™ Help «

[E] Map Series Frame

[E] Thematic Series Frame
[E] Series Locator Frame
@ Series key Frame

E&] Series Text

ﬂ Page Index

lﬁj Series Index

a Page Layout

a| Series Layout
Map Books 2

Modifying The Properties Of A Page Index Element

To modify the properties of a Page Index Element, select the index element then right-click your
mouse and select Properties...
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Once the properties dialog for the element is displayed, click on the Page Index tab to adjust
the properties.

The properties are divided into four sections: the index source, the index layout, the display and

sort order and options. There are quite a number of properties for a page index. Fortunately,
most of the properties are assigned default values.

Modifying The Index Source Properties Of A Series Index Element

MapLogic Layout Manager User’'s Manual Page 103



Page Index 1 Properties 7| x|

Frame I Size and Position  Page Index |

il Page Index Properties
Index Source | Index La_I,IDutI Display/Sart I:Irl:lerl Dptions I

& Page [ndex liztz the lozation of items curently vizible on the map [for example, Main
Street.. .B-3). The index draws on infarmation from attributes of a Feature Layer in the map
of from annotation labelz. The contents of each column in the index are determined uzing
an expreszion for that column.

Select Map:
INew Data Frame j

{+ Create listingz from geographic features in layer:

I shreets j

Lizting text will come from the layer's table uzing an expreszion [zee Lizting Text tab).

i~ Create listingz from CAD/CoveragefGeoD atabase annotation Layer:

|<N|:|ne> j

Lizting text will be the annaotation label test.

{~ Create listingz from annotation group [labels stored in MXD]:

|<N|:|ne> j

Lizting text will be the annaotation label test.
MOTE: Labelz that ArcGIS generates on the fy for a layer can not be indexed.

Y'ou may zelect to index only those features that are entirely within the vizible extent of the
map or to include features that are partially vizible as well.

Index Features That:

MOTE: Index polygon optionz anly apply if selected data frame iz a map senes frame.

k. I Cancel Apply

To set the source of an index you must select the map to be indexed, the type of features that
will be indexed, the layer that will be indexed and how to choose the features to be indexed.

The Map

The map is the frame which will be indexed. The dialog will present you with a list of available
maps in the layout to choose from.

The Type Of Features To Be Indexed

You can index features in a map layer or annotation labels on the map. If the location map
features are going to be indexed, you will need to provide information on where in the feature’s
table the listing information will be extracted from.

If you are indexing annotation, the listing text will be the annotation text.

Labels that ArcMap generates “on-the-fly” can not be indexed as their positions are not static.
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The Layer To Be Indexed

For each of the different types of items to be indexed the dialog shows a list of available layers.
The page index properties are not complete unless a layer is selected.

Selecting Features

The final option on the Index Source tab is the method by which features are selected. You
have the option of selecting all the features that intersect the map or only those that are
completely within the map.

If the map is a map series, you also have the option of limiting the selection to the polygon for
the current page.
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Modifying The Index Layout Properties Of A Page Index Element

Page Index 1 Properties |

Frame I Size and Position  Page Index I

i Page Index Properties
. | Display/S art I:Iru:lerl I:Ipticunsl

The index iz organized as a series of columns containing different information [the lizting test,
the gnd location, etc.]. Youw can modify the content of each column by changing the
expreszzion defining the column az well zize, symbol, and other azpectz of each column. Pro
wzerz can also add new columns to the layout.

Click on a column to modify its properties:

Add®..

Grid

Remove®. ..

* Pro license required to add additional columns to indes.

Column Properties:
Colurnn Texst | Fu:untl Background | SizedMargins I Colurnn Break I Title I

Compozse column fext uging expression;

[MNAKE] [TYPE] E xprezsian... |

k. I Cancel Apply

The index is displayed as a series of columns containing the listings and their corresponding
locations. For each column, you can define the column width, the font, the background color

and many other parameters.

If you have a Pro license, you can add additional columns to the index. For example, one
column might be the street name, another column the address range, and so on.

The Column Text
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Calurnr TEHtI F-:untl Background | SizedMarging | Column Breakl Titlel

Compoze column text uzing expressian;

[WAME] [TYPE$$DOTS Exprezzion... |

The text for a column is determined by an expression. You can modify the expression by
clicking the Expression... button. For more information about expression syntax please refer
to the Working With Expressions section of this manual.

The Column Font

B ackground I Size/Marginz I Colurnn Break I Title I

Column font: Syrmbal... |

Helwetica &

Alignment: || ;4 j
Apply Symbol To All Columnz

For each column in the listing you can select a different font and alignment. The “Apply Symbol
To All Columns” button allows you update all columns in the index with the currently selected

font.

The Column Background

| {| Size/Marging | Calumn Ereakl Titlel

Cilurnn Te:-:tl Font gu]]

[+ Color column background
[+ Use alternating background symbols

Background: Alternate Background:

Symbal... | Symbal.... |

Apply Settingz To All Columns |

In this area you can set the background color for each column in the page index. Note that you
can choose to alternate the color as you go from each listing to the next. This can make the
listing a little easier to read. The “Apply Settings To All Columns” button allows you update all
columns in the index with the current background settings.
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The Size and Margins

Coalurmi Te:-:tl Fn:nntl Background Sizex'MarginsE Caluran Breakl TitIeI

..................................

Column Width: |1 7

M argins:

Top: ||1 03
Battarm: ||:|_ 03
Left: ||:|. 05
Right: IIZI. 05 &pply Marging To All Colurmns

You can set the width of each column and the margins around each listing in the column. The
height of the column is determined by the size of the listing. If the listing is too long to fit on a
single line, the text is broken down onto multiple lines. The “Apply Margins To All Columns”
button allows you update all columns in the index with the current margins. Note that the
column width is not affected by this button.

Column Breaks

[v¥ Break column liztings when First letter changes.

Spacing: ||:|_-|

[+ Place new letter heading after break

Symbaol... |

Helvetica 9.7¢

You can add a break in the listings each time the first letter in the listings change. Thus, the
listings are broken down into groups of A’s and B’s and so on. You can set the break spacing
and whether there will be a label for each break.

Column Titles

Calurnn Te:-:tl F-:untl Background | SizetMarging | Column Break  Title |

[v Display Title: |Street

Font: B ackground:

Symbaol... |

Align: |reppe j Apply Syrmbals To &l Colurnns |
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You can set a title for each column in a listing including its font and background symbol. The
“Apply Symbols To All Columns” button allows you update all column titles in the index with the
currently selected symbols.

Modifying The Display And Sort Order Properties Of A Page Index
Element

Page Index 1 Properties 7] x|

brea I Framel Size and Position  Page Index |

[l Page Index Properties

Index S-:uur-:el Index Layout | Displap/Sart Order I Optiars I

The arder in which the columng appear in the index iz determined by the arder in which the

columns appear below.
Up |

Grid Dok

ToTop

To Bottom I

To rearange the ligt select an item and use the buttons ko the right.
{* Columnz added from left to night

" Columnz added from right to left [Arabic and Hebrew fonts)

Liztings zan be zorted alphabetically over multiple colurmns. The sart order iz determined
by the arder in which the columns appear below [The top most ikem in the st being the
primary zort column, the nest item the zecondary sort colurmn, ete.]. 1f vou do naot want a
column to be considered while sorting, uncheck it |f you do not choose to zort the index
alltagether, listings will be added ik the arder that they appear in the listing databaze file.

[+ Sort Index

Up |

(anid Do
ToTop

To Bottom I

{* Ascending

" Dezcending

()% Cancel Apply

The Column Display Order

The column display order is the order in which the different elements in the listing are placed in
the page index. Normally the name of the feature is displayed first followed by its location.

However, you can modify this order by selecting a column and clicking on the up and down
buttons.
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Left To Right Or Right To Left Column Layout

In languages where text is written from right to left (Arabic and Hebrew) tables often follow a
right to left layout as well. This option allows for change the direction in which columns are
added to the index.

The Column Sort Order

You can select to sort the listings by selecting the Sort Index option. Additionally, you can
choose which items you want sorted, and the order in which they are sorted. The sort order is
determined by the order that the column names appear in the list (the top most item in the list is
the primary sort column, the next item is the secondary sort column, and so on.). You can
rearrange the columns by selecting them and clicking the up and down buttons.

Modifying The Options Of A Page Index Element

Page Index 1 Properties ed

Area I Framel Size and Position  Page Index |

il Page Index Properties

Faor annotation, line and polvgon features listings will be created for the entire extent the
feature. “'ou may limit the indexing of a line ar palygon feature ta a zingle paint itz
centriod].

[T Only index the center point of annotation, line and polygon Features

If a lizting appears on multiple arids [for example, Main Street 82, Main Steet B3), the
liztings can be combined [ie. Main Street A2 B3] ANDAOR the text [ather than grid
lozations] can be driopped from subzequent liztings.

[ Combine multiple listings of the same Feature

{* Separate each listed item by a new line

{~ Separate listed items using: I

[~ If there are more than two listings, only show First and last listing

[” Drop text from subsequent rows when listings are the same

If the page index frame iz wide enough, the defined column layout will be repeated az
rany imes az pozsible.

[v Bepeat column layout az many times az frame width will allow

Column Spacing: ||:|_1 [~ Allow frame to expand as needed

[f pou have added a break to one of the columns in the indes, thiz option will add a
break, befare the firzt ligting if the lizting iz not a number.

[~ Add a starting break when first listing is not numeric

Y'ou have the option wrapping indes liztings around other graphic elements on the lapaut,

[~ wWrap page index around other layout graphics
[This option iz ignored for Arabic and Hebrew right-to-left test)

k. Cancel Apply
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Only Index The Center Point Of Line And Polygon Features

This option limits the indexing of a line or polygon feature to a single point (its center).
Otherwise, listings will be created for the entire area the feature covers. For example, a major
road that crosses many grid cells in a map will have multiple locations listed. If this option is
selected, the road will be listed once.

Combine Multiple Listings Of The Same Feature
This option combines listings so the same listing isn’t repeated over and over. For example, if
Main street appears on grid A2, A3 and B3 of the map, you generally would not want three

separate listings for main street:

Main Street A2
Main Street A3

Main Street B3

You can combine the listings so they appear as a single listing:

Main Street

A2,A3,B3

If you do choose to combine listings, you have the option of selecting what character separates

the listings.

If There Are More Than Two Listings, Just Show The First And Last Listing

This option allows you to drop all the locations for a feature other than the first and last one.
This helps reduce the number of locations listed for long linear features. In the above example

the listing would look like:

Main Street

A2-B3

Drop Text From Subsequent Rows When Listings Are The Same

This option allows you to drop repeating text from columns to give it a more professional look.
This option does not combine the listings as the above option. It is particularly useful when you
have a multi-column listing. For example:

CITY STREET Grid
Gainesville Main St Al,B4
Gainesville University Ave B2
Gainesville Willow Rd C5
Springfield Lincoln Ave F2
Springfield Main St G9,F10
Will become:
CITY STREET Grid
Gainesville Main St Al,B4
University Ave B2
Willow Rd C5
Springfield Lincoln Ave F2
Main St G9,F10

MapLogic Layout Manager User’'s Manual

Page 111



Add A Starting Break When First Listing On First Page Is Not Numeric

This option allows you to place a column break before the very first listing if the listing does not
start with a number. For example:

STREET GRID
Allen Ave 3A
Arbor St 2B

B

Boardwalk Ave 2A

Will become:

STREET GRID
A

Allen Ave 3A
Arbor St 2B

B

Boardwalk Ave 2A

Repeat Column Layout As Many Times As The Frame Will Allow

This option will repeat the column layout as many times as will fit into the size of the page index
element.

You can also set the spacing between the column groups.
Allow Frame To Expand As Needed

Normally the page index will stop listing items when the table fills in the boundary of the page
index frame. Any remaining features that have not been listed are dropped from the index.

This option allows the software to keep adding columns beyond the edge of the frame until all
the indexed features are listed. The index always expands in the left or right direction. Keep in
mind that, as the frame expands it may interfere with other elements of the layout or move
beyond the boundary of the printed page

Wrap Page Index Around Other Layout Graphics

This option will allow the page index columns to warp around any other elements that have
been placed over the boundaries of the index.
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Once you are finished modifying the series locator frame’s properties, click OK or Apply to save
your settings.

IMPORTANT: You must allow enough space for the page index to list all the features that
appear on the page otherwise some features will be dropped from the index. The “Allow frame
to expand as needed” option allows you to override this behavior.
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The Series Index Element

What Is A Series Index Element

Road Name Page Road Name Page
ACE COLBWAN LN 1,3-C | |FRAMNCES AHM CT 8,30
AEGEAN & 4,1-B | |FRANKLIN RD 11,2-A
ALLEH & 2.1-B 1. A
ALLEM 8T 118 | [

1,2-B
ALTERTETEaAT 75| [SEORGEMARTIN RO Z.1-B
1,1-C | |GLEM & 16, 1-B
ANGELINA WBI CT 5, 3-B | |GRANT 5T #1,1-0
GREC 1AM Wiy 24 1-A
B GROVENDOD LK 1,2-C
BECK CT z,1-D
BECK 5T #z.1-0| (H
BERG OF 7.3C | |HACKAIORE RO 1,2-0
BIGLER LH 12,2-B | |HARPER W&LLEY RO 3,20

A Series Index Element is used to create indexes of features on your map pages. An index is
an alphabetical listing of feature in a map book and where they can be found. For example, if
you are creating a road map book, you may wish to have a listing of where each road can be
found in the map book (Main Street....Page 2 B-4). Depending on how many listings there are,
a series index element can occupy one or more pages.

Indexes are created based on the labels of features on the map or the features themselves.
However, consideration needs to be made as to what is being indexed. Sometimes the user
will not be able to find a feature on the map unless there is a label associated with it. For
example, if Main Street is within the grid cell B-2 on Page 3 of a map book, the user may not be
able to figure out which road on the map in that area is Main Street unless there is a label for it.
On the other hand, the location of a fire station may not require a label since there is an
appropriate symbol on the map which shows the user where the fire station is located, and the
likelihood of two fire stations existing close to each other is slim.

Creating a series index is a two step process. First you need to create a database of features
and the pages they appear on. This is called a Location Listing Database or an Index
Database. The second step is to take that database and put its contents in a layout for printing.

The reason the two steps of creating a series index are separated has to do with time. It takes
a significant amount of time for the MapLogic Layout Manager to find the location of each
feature in a series. The extension must create each page of the series and then examine the
features that appear on the page. For a very large map series, you may be looking at a
process that takes hours. If the location listing database was going to be created “on-the-fly”
each time it was accessed, the software would be too slow for any practical use.

However, this means that any changes made to the map series will require re-indexing of the
map series. For example, if you change the scale of the map series frame, or add new features
to the map, or change the size of the map series frame, etc. you will be required to re-index the
map series. Since indexing can take a long time, much time can be save by making sure all the
changes to the map series have been completed before creating indexes.
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MapLogic Layout Manager provides two tools for creating location listing databases; a standard
tool which can create an index database from a single layer in a single map and a more
advanced tool for Pro users which can index across multiple layers and multiple maps.

For more information about creating index databases please refer to the Creating Index
Databases section of this manual.

Adding A Series Index Element To A Layout

To add a new series index element to a layout select Insert > Series Index from the MapLogic
Layout Manager toolbar. You can only add series index elements to active book layouts. If the
active layout is a page or map series layout, the tool is grayed out.

You must have an Advanced or Pro license to add a series index element to a layout, otherwise
the tool is grayed out.

MaplLogic Layout Manager |
Layout = Edit = View ™ |Insert * Tools ¥ Help -«

[E] Map Series Frame
[18] Thematic Series Frame
[E] Series Locator Frame
Eﬁ] Series Key Frame

EE] Series Text

il Page Index

quE'_'l Series Index

a Page Layout

& Series Layout
Map Books 2

Modifying The Properties Of A Series Index Element

To modify the properties of a Series Index Element, select the index element then right-click
your mouse and select Properties...
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Once the properties dialog for the element is displayed, click on the Series Index tab to adjust

the properties.

The properties are divided into four sections: the index source, the index layout, the display and
sort order and options. There are quite a number of properties for a series index. Fortunately,

most of the properties are assigned default values.

Modifying The Index Source Properties Of A Series Index Element
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Seties Index 1 Properties 27| x|

Frame I Size and Position  Sefies Ihdex |

ﬁﬁeries Index Properties
Index Source I Index Laycuutl Displap/Sart I:Irl:lerl Dptions I

A Series [ndex liztz the location of iters it a map zenes [for example, Main Street.. Page
4 B-3]. The index draws on information from a listing database created uzing the ''Create
Location Lizting D atabase' tool.

Lizting Database:

IE:'&M apLogichk arketing'MapLogic Layout ManagertSample Map Book\wWinterPa ﬂ

[MPORTAMNT: The lizting databaze iz a snapshot of feature locations at the time the
database waz created. Any changes that are made to the map book, GIS datazetz
ar lapers that effect the number and location of features will require the recreation of
the databazel

The listing database can be linked to a Map Senes Frame in the map book. | the
databasze iz inked to a Map Senes Frame, page numberzs will be comected to reflect the
lozation of the map genies in the map book. Faor example, if M ain Street iz on page 1 of a
map =enes but the map senes actually beging on page 5 of the map book, Main Street will
be lizted az being on page 5. Linking alzo allows for more optionz when defining listing
tewt. IMPORTAMT: Page numbers can only be corrected if the Seres Index comes after
the Map Seriez in the map bookk.

[MPORTAMT: If pou created an &z 12" lizting databaze, do nat link, it o the Map Seres.
[+ Link databaze to Map Series Frame:

Section:

IMap Fages j
Template:

IMap Senes Layout j
Map Senez Frame:

INEW Data Frame j

k. I Cancel | Apply |

To set the source of an index you must set the location listing database which it must read and,
optionally, the map series frame it belongs to.

The Listing Database

The listing (or index) database is the name of the file that was created by the Location Listing
Database Wizard or the Multi-Layout/Multi-Layer Indexing Wizard.

Refer to the Creating Index Databases section of this manual for more information on creating
the database.

Link Database To Map Series Frame

Although linking the database to the map series isn’t required, by linking the two, the extension
will correct the page numbers to reflect the position of the map series in the map book.
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For example, suppose Main Street is located on the first page in a map series. In the location
listing database Main Street will be listed as being on Page 1. However, suppose that the map
series doesn't start on the first page of the map book. Suppose you have a key map on page
one of a map book, so the map series actually begins on Page 2 of the book. By linking the
index to the map series, the extension will realize this and correct the listing so that Main Street
is listed as being on Page 2 of the book.

To link the Series Index to the Map Series Frame, check the Link Database to Map Series
Frame option and then select the appropriate, Section, Template and Map Series Frame from
the drop down lists.

IMPORTANT: If you created an “As Is” Location Listing Database, do not link it to the map
series frame. The page numbers in an “As Is” database have already been corrected and a
second attempt to change the page numbers can created errors.
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Modifying The Index Layout Properties Of A Series Index Element

Series Index 1 Properties ed

Frame: I Size and Position  Sefies Index |
lﬁﬁeries Index Properties

Index Source  Index Layout | Dizplay/S art EIru:IerI Optioks I

The index iz organized az a zenes of columnz containing different infarmation [the lizting test,
the page number, etc.]. 'ou can madify the content of each column by chanaing the
expression defining the column as well size, symbol, and other aspects of each column. Pro
uzerz can also add new columns to the layout.

Click on a column to modify its properties:

Listin Add..

Remove®...

* Pro licenze required to add addiional columng to index.

Column Properties:
Column Text | Fn:nntl Background | Sizedargins I Calurnt Break: I Title I
{~ Get text from Listing Databaze file

{* Get text from Map Seres Frame's Index Layer Table
[To use thiz option link Index Databaze to a bMap Senez Frame]

Compose column text using expression;

$3PAGE_MUMBER E xprezszion... |

k. I Cancel Apply

The index is displayed as a series of columns containing the listings and their corresponding
page numbers. For each column, you can define the column width, the font, the background
color and many other parameters.

When you selected the location listing database in the previous tab, the extension examined the
file and populated this area with default values for the different columns that are normally
displayed (a listing and a page location).

If you have a Pro license, you can add additional columns to the index. For example, one
column might be the street name, another the address range, and so on.

There are many properties that you can set for each column in the series index. This can
become a little confusing, so let’s take another look at the sample index presented at the
beginning of this chapter.
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Road Name Page Road Name Page

ACE COLBMAN LN 1,3-C | |FRAMCES ANM CT 8,30
AEGEAN 4,1-B | [FRANKLIN RD 11, 2-A
ALLEN A 2,1-B A
ALLEN 5T Hg G
ATTERAT B 15| |BEORGEMARTIN RO 2,1-B
1.1-C | | GLEN A 16, 1-B
ANGELINA VBN CT 5,2-B | |GRANT 5T 21,1-0
GRECLAN WY 4, 1A
B GROVEWOOD LN 1,2-C
BECK CT 7.1-D
BECK 5T z1-.0/ |H
BERG OR 7.3C | |HACKAMORERD 1,2-0
BIGLER LN 12.3-B | |HARPER WALLEY RD 3,20

Note some of the characteristics of the index, the column fonts, the background colors, the
column titles, the column widths, the breaks that appear in the index as the first letter of the
listings change. These are all properties that you set in the Index Layout tab.

The Column Text

Colurnn Text | Fu:untl Background | Size/Marging I Colurnt Break. I Title: I

f+ Get text from Listing Databaze file

" Get text from Map Series Frame's Index Layer Table
[To use thiz option link Index D'atabase to a Map Sernes Frame]

Compoze column text uging expression;

[Lizting] E wpression... |

You have the option of creating a text that is extracted from the location listing database or,
optionally the map series frames index layer table (if you have linked the index to the map
series frame). For example, instead of the page number where a feature is located, you could
use the name of the page in the map series.

The text for a column is determined by an expression. You can modify the expression by
clicking the Expression... button. For more information about expression syntax please refer
to the Working With Expressions section of this manual.
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The Column Font

B ackaground I Size/Marginz I Colurnn Break I Title I

Column font: Sumbal... |

Helwstica &

Alignment: || -; j

Apply Syrmbal Ta All Calumne

For each column in the listing you can select a different font and alignment. The “Apply Symbol
To All Columns” button allows you update all columns in the index with the currently selected

font.

The Column Background

[v Color column background
[+ Usze alternating background symbols

B ackground: Alternate Background:

Syrbal... | Symbal.... |

Apply Settingz To All Columnz |

In this area you can set the background color for each column in the series index. Note that
you can choose to alternate the color as you go from each listing to the next. This can make
the listing a little easier to read. The “Apply Settings To All Columns” button allows you update
all columns in the index with the current background settings.

The Size and Margins

Column Width: |-| 7

M argins:

Top: [0z
Bottom: ||:|_ 03
Left: ||:|_ 05
Right: IU. 05 &pply Marging To Al Columns
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You can set the width of each column and the margins around each listing in the column. The
height of the column is determined by the size of the listing. If the listing is too long to fit on a
single line, the text is broken down onto multiple lines. The “Apply Margins To All Columns”
button allows you update all columns in the index with the current margins. Note that the
column width is not affected by this option.

Column Breaks

[+ Break column liztings when First letter changes.

Spacing: ||:|_1

[+ Place new letter heading after break

Symbaol... |

Helvetica 9.7¢

You can add a break in the listings each time the first letter in the listings change. Thus, the
listings are broken down into groups of A’s and B’s and so on. You can set the break spacing
and whether there will be a label for each break.

Column Titles

Calumn Te:-:tl F-:untl Background | Sizedtdarging | Column Break  Title |

v Display Title: |Street

Font: B ackground:

Symbal... |

Align: et j Apply Syrmbals To Al Colurnns |

You can set a title for each column in a listing including its font and background symbol. The
“Apply Symbols To All Columns” button allows you update all columns in the index with the
currently selected title symbols.
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Modifying The Display And Sort Order Properties Of A Series Index
Element

Series Index 1 Properties d
Bres I Framel Size and Position  Senes Index |

lﬁﬁeries Index Properties

[rides S-:uuru:el Index Layout | Display/Sart Order | Dptions I

The arder in which the columns appear in the index iz determined by the order in which the

colurmng appear belaw,
Up |

Lizting Dhown
Fage —_—
Girid ToTop

To Bottam I

To rearange the list zelect an item and uze the buttonz to the right.
{* Columns added From left to right
{” Columns added from right to left [4rabic and Hebrew fonts]

Liztings can be sorted alphabetically over multiple columnz. The zort order = determined
by the arder in which the columns appear below [The top maozt ikem in the lizt being the
primary zort columr, the nest item the secondarny sort column, etc.]. If you do not want a
colunin to be conziderad while zorting, uncheck. it [F you da not choose ta zart the indes
alltogether, listingz will be added in the arder that they appear in the lizting databasze file.

[+ Sort Index

Up |

Do

ToTop

To Bottam I

{* Aszcending

{~ Descending

2k, Cancel Spply

The Column Display Order

The column display order is the order in which the different elements in the listing are placed in
the series index. Normally the name of the feature is displayed first followed by the page it is
located on. However, you can modify this order by selecting a column and clicking on the up
and down buttons.

Left To Right Or Right To Left Column Layout
In languages where text is written from right to left (Arabic and Hebrew) tables often follow a

right to left layout as well. This option allows for change the direction in which columns are
added to the index.
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The Column Sort Order

The listings in the location listing database are not sorted. You can select to sort the listings by
selecting the Sort Index option. Additionally, you can choose which items you want sorted, and
the order in which they are sorted. The sort order is determined by the order that the column
names appear in the list (the top most item in the list is the primary sort column, the next item is
the secondary sort column, and so on.). You can rearrange the columns by selecting them and
clicking the up and down buttons.

Modifying The Options Of A Series Index Element

Series Index 1 Properties 7] x|

Frame I Size and Position  Senes Index |

l@ Senes Index Properties
Index Su:uuru:el Index La_l,u:uutl Display/Sort Order  Ophions |

If a listing appears on multiple pages [for example, kain Street Page 6, Main Street Page

). the liztingz can be combined [i.e. Main Street Page B8] AMDAOR the text [other than
page numbers and grid locationz] can be dropped from zubzequent listingz.

[ Combine multiple listings of the same Feature

{~ Separate each listed page by a new line
{* Separate listed pages using: IJ

[v If there are more than two listings, only show First and last listing

[~ Drop text from subsequent rows when listings are the same

[f the zenies index frame iz wide enough, the defined calumn layout will be repeated as
mary times az poszible,

¥ Repeat column layout as many times as frame width will allow

Column 5pacing: Il]_2

[f you have added a break ta one of the columnz in the indes, this option will add a
break before the first listing if the lizting iz not a number.

[~ Add a starting break when First listing on first page iz not numeric

The default page is the page that iz normally displaved when vou aren't previewing the
index pages.

Set default page to: |-|

[f wou would like to see a zample page of the index before creating the entire indes
[wihich can take a long time to generate], select the Sample Page option.

[¥ Generate a zample index page only

k. I Cancel Apply

Combine Multiple Listings Of The Same Feature

This option combines listings so the same listing isn’t repeated over and over. For example, if
Main street appears on Page 2, 3 and 4 of the map series, you generally would not want three
separate listings for main street:
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Main Street 2
Main Street 3
Main Street 4
You can combine the listings so they appear as a single listing:
Main Street 2,34
If There Are More Than Two Listings, Just Show The First And Last Listing
This option allows you to drop all the locations for a feature other than the first and last one.
This helps reduce the number of locations listed for long linear features. In the above example
the listing would look like:
Main Street 2-4
Drop Text From Subsequent Rows When Listings Are The Same
This option allows you to drop repeating text from columns to give it a more professional look.

This option does not combine the listings as the above option. It is particularly useful when you
have a multi-column listing. For example:

CITY STREET PAGE
Gainesville Main St 14
Gainesville University Ave 2
Gainesville Willow Rd 5
Springfield Lincoln Ave 12
Springfield Main St 9,10
Will become:
CITY STREET PAGE
Gainesville Main St 14
University Ave 2
Willow Rd 5
Springfield Lincoln Ave 12
Main St 9,10

Repeat Column Layout As Many Times As The Frame Will Allow

This option will repeat the column layout as many times as will fit into the size of the series
index element. For example, in the sample series index that was shown at the beginning of this
chapter, the columns were repeated twice.

You can also set the spacing between the column groups.

Add A Starting Break When First Listing On First Page Is Not Numeric

This option allows you to place a column break before the very first listing if the listing does not
start with a number. For example:

STREET PAGE
Allen Ave 3
Arbor St 2

B
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Boardwalk Ave 2

Will become:
STREET PAGE
A
Allen Ave 3
Arbor St 2
B
Boardwalk Ave 2

Default Page

Normally, the first page of the series index is displayed when you are not previewing or printing
the index. However, if you prefer another page to be displayed by default, you can change the
default page of the listing.

Generate A Sample Index Page Only
Depending on the size of the index, the process of laying out the pages of an index can take a
long time. By selecting the sample page option, only one page of the index is created. This

allows you to examine your layout, fonts, colors, etc. before creating the full index.

Once you are finished modifying the series locator frame’s properties, click OK or Apply to save
your settings.
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Creating Index Databases

What Is An Index

Road Name Page Road Name Page
ACE COLBWAN LN 1,3-C | |FRAMNCES AHM CT 8,30
AEGEAN & 4,1-B | |FRANKLIN RD 11,2-A
ALLEH & 2.1-B 1. A
ALLEM 8T 118 | [

1,2-B
ALTERTETEaAT 75| [SEORGEMARTIN RO Z.1-B
1,1-C | |GLEM & 16, 1-B
ANGELINA WBI CT 5, 3-B | |GRANT 5T #1,1-0
GREC 1AM Wiy 24 1-A
B GROVENDOD LK 1,2-C
BECK CT z,1-D
BECK 5T #z.1-0| (H
BERG OF 7.3C | |HACKAIORE RO 1,2-0
BIGLER LH 12,2-B | |HARPER W&LLEY RO 3,20

An index is an alphabetical listing of feature in a map book and where they can be found. For
example, if you are creating a road map book, you may wish to have a listing of where each
road can be found in the map book (Main Street....Page 2 B-4).

Indexes are created based on the labels of features on the map or the features themselves.
However, consideration needs to be made as to what is being indexed. Sometimes the user
will not be able to find a feature on the map unless there is a label associated with it. For
example, if Main Street is within the grid cell B-2 on Page 3 of a map book, the user may not be
able to figure out which road on the map in that area is Main Street unless there is a label for it.
On the other hand, the location of a fire station may not require a label since there is an
appropriate symbol on the map which shows the user where the fire station is located, and the
likelihood of two fire stations existing close to each other is slim.

Creating a series index is a two step process. First you need to create a database of features
and the pages they appear on. This is called a Location Listing Database or an Index
Database. The second step is to take that database and put its contents in a layout for printing.
The process of placing the index on paper is handled through the Series Index Element. For,
more information about this element please refer to The Series Index Element section of this
manual.

MapLogic Layout Manager provides two tools for creating location listing databases; the
Indexing Wizard which can index across multiple layers and multiple maps (Advanced and Pro
users only) and an older tool which can create an index database from a single layer in a single
map (Advanced and Pro users).

The Indexing Wizard

To create an index database using the Indexing Wizard, select Tools > Indexing Wizard...
from the MapLogic Layout Manager toolbar.

You must have an Advanced or Pro license to use this tool.
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MaplLogic Layout Manager

Layout = Edit = Yiew = Insert ™ Tools * Help =

kil Book Wizard...
e Grid wizard. .
E Indesing Wizard. ..

This will bring up the Indexing Wizard dialog. This wizard has a number of advantages over the
older Location Listing Database Wizard discussed later in this section including the ability to
index across multiple layouts and layers. Additionally, the settings of this wizard can be saved
and restored so you don’t have to reenter all the settings each time the wizard is used.

In this dialog you are going to setup the process for creating the database which includes:

Selecting the layouts and maps to index

Selecting the layers to index

Selecting the indexing boundaries

Defining the output columns for the index
. Selecting the index sorting properties
Selecting the index output file

RBHoooNO

= O
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Indexing Maps

i, [ndexing Wizard

[Mtroduction

Within pour Archdap document there may be one or more maps frames [data frames). The wizard needs to
know which of theze maps to index. By default only the active map iz selected.

[f the Active Lavout iz part of a map book., vou have the option of adding mapsz that are located in other

gections in pour map book in the index. The wizard will zearch acrozs all zelected sections in creating the
indes.

The Active bMap will determine the rules of indexing. For example, if you select to index the 'Streets" layer
fram the Active Map, all ather mapz and lapouts that are included in the indexing must have a "Streetz’ laper.
[f the map does not have the required layer, it will be skipped.

Select one or more maps to index:

=il

(8

o

[ Marth &merica

ci

MNorth America

o

i

Optionz
[v Only index map when it iz on the page

[f you are using anchors to move maps on and off the layout depending on the page, this option
ifizures that the map iz only indered when it iz on the lavout and nat when it iz aff ta the side.

Click Mext to continue

| Lu:uau:l...| Cancel < Back | Mext » |

One of the key advantages of using this wizard is that indexing is not limited to just one map. If

there are multiple maps on the layout or multiple layouts in a map book, this wizard can create
an index based on all of these maps and layouts.

If the active layout is part of a map book when starting this wizard, you will be able to select
maps located in any section of the map book. If the active layout is a page layout or a map
series layout, you will be able to select maps on just the active layout.
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The active map also determines some of the indexing rules. For example, the choice of
indexing layers is based on the layers in the active map. So if you select to index the “Streets”
layer in the active map, the wizard is going to look for a “Streets” layer in any of the other maps
you have selected to index.

Only Index Map When It Is On The Page

One of the features of MapLogic Layout Manager is that you can use anchor settings to move
maps on and off the printed page as needed.

An example of this would be a detail map that is to be displayed on only one page in a map
series. Selecting this option insures that this detail map is only indexed when it is moved onto
the printed page and is ignored when it is off to the side.
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Indexing Layers

. Indexing Wizard g]
Introduction l Map[z] Lavers) l Indexing Boundaries l Cutput Eu:ulumns] Sort Order ] Cutput l

YWithin the selected map(z) there are one or more layers of data, The wizard needs to know which of these
data layers should be indexed.

T he first layer that iz zelected will determine the ez for indexing. Faor example, if you plan on extracting
information from a field called "'Street_Mame" all the other zelected layers must alzo have a field with the
zame name. |f a layer does not have the required figld, it will be zkipped.

Select the layer lwpe ta index:

* Create index from geographic features layers
Test will come from the layer's table uzing an expreszion,

(" Create index from CAD/Coverage/GeoD atabase annotation Layers
T ext will be the annatation label text.

Select one or more layers index:

[ Us& Boundary
[ Capital Cities

[ Lakes:

[ State Boundaries

[ States

D Meighbanng Countries

If more than one layer iz selected, information can only be extracted from figlds that have the zame name and
are aof the zame tppe.

Optiohs

[ Only index layers that are visible [checked]

[ Only index features that are cumrently selected

[ Only index the center point of annotation, line and polygon features

Thiz option limits the indexing of an annotation, line or polygon feature to a single point itz centrind).
Othenwize, liztings will be created for all the pages the entire extent of that feature covers.

Chick Mext to continue

| Ln:nau:l...| Cancel < Back | M et > |

Another key advantage of using this wizard is that indexing is not limited to a single layer. If

there are multiple layers in the map, this wizard can create an index based on more than one
layer.

The first layer that is selected determines what information is going to be available for extraction
from each of the indexing layers. For example, if the layer contains a field named
“Street_Name” which you want included in the index, the wizard will look for a “Street_Name”
field in all of the layers that have been selected for indexing.

MapLogic Layout Manager User’'s Manual Page 131



Only Index Layers That Are Visible (Checked)

This option insures that a layer is only indexed when it is visible. For example, the same layer
may appear in multiple maps that are being indexed but the layer has been turned on in only
some of the maps. This option insures that the indexing occurs only when the layer has been
switched on.

Only Index Layers Features That Are Currently Selected

This option limits the indexing to those features in a layer that are selected, rather than all of the
features in a layer.

Only Index Layers The Center Point Of Annotation, Line And Polygon Features

This option limits the indexing of an annotation, line or polygon feature to a single point (its
center). Otherwise, listings will be created for all the pages the feature covers. For example, a
major road that crosses many pages in a map series will have a listing for every page it appears
on. If this option is selected, the road will be listed once.
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Indexing Boundaries

i Indexing Wizard @

Intraduction l M ap(z] l Lapers]  Indexing Boundaries l Output I::::Iumnsl Sort Order l Dutput l

To index a feature in a laver, it muzt be compared againzt a boundany to determine if it iz inzide or outzide the
boundary. & boundary can be the visible extent of the map, a polygon ik anather laver ar bath,

[f the map has map series properties [i.e. more than one page iz generated fram the map), you have the
option of indexring all of the map pages.

Boundany choices:

[v Index selected layers against vizible boundary of map
O ptionz

[v If map i1z a map senes. index all pages in the senes

[ Only index features inside the index polygon

T hiz option limits the items indexed for each page in a map zenies o those that fall within
the index polygon for that page instead of the vizible boundary of the map. 1n ather
wardz, any overlapping areaz on the edge of the page are ignored.

[w If the map has a visible Reference Grid. index each gnd cell.

[f you have a reference gnid zormounding vaur map, this option will not only indes the page
lozation af a feature but alzo the gnd location of that feature [1Le. Man Street, Pg 3 A-4).

For more information about Reference Grids refer to Archd ap's online help.

[ Index zelected layers against polygonz in the following layer

|<N|:une> ﬂ

O ptionz

[ Only ndex polygons that are currently selected

Click Mext to continue

| Lu:uau:l...| Cancel < Back | M ewt > |

In order to create an index, the features that are being indexed need to be compared against
boundaries to see if they fall inside or outside of the boundary. For example, whether or not a
road falls on a page in a map series.

The wizard can index layers against the boundary of the map, a selected polygon layer or both.
For example, you may want to index a street layer against the pages of a map book but also
against a subdivision layer. This can be done by checking both of the indexing boundary
options and selecting the appropriate subdivision layer. So the index would not only note the
page number the street is on but also the subdivision name that it is located in.
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If The Map Is A Map Series, Index All The Pages In The Series

This option insures that the wizard iterates through all the pages in a map series during the
indexing. If this option is not selected, only the current page is indexed.

Only Index Features Inside The Index Polygon

This option limits the items indexed for each page of the map series to those that fall within the
index polygon for that page when indexing the pages of a map series. In other words, any
overlapping areas on the page are ignored. For example, if you are indexing the names of
cities in each state of a map series of US States, you probably do not want the names of the
cities in neighboring states that appear on the page to be indexed.

If The Map Series Frame Has A Visible Reference Grid, Index Each Grid Cell

If you have a reference grid surrounding the map series frame, selecting this option will not only
store the page a feature is located on, but also the grid cell that it appears on (i.e. Main
Street...Page 9 A-4).

For more information about reference grids and their setup, please refer to ArcMap’s online
help.

Only Index Polygons That Are Currently Selected

When indexing against the boundaries of a polygon features in a layer, this option limits the
indexing to only those polygon features that are currently selected.
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Output Columns

. Indexing Wizard g

Intraduction l ap(z] l La_l,ler[s]] Indexing Boundaries  Dutput Colurnns l Sort Order l Cutput l

Once the maps and layers have been selected, the wizard needs to khow what information iz to be extracted
from the zelected layers.

The index databaze iz a table of feature attributes [for example, Main Street] and their locations [for example,
FPage 4 Grid B-5]. The table iz populated with columng that pull information fram the layers that are being
indexed, the boundary lavers or the Map pages.

[ thiz step pou will need to define the names of the columng to be added to the output databaze as well az
an erpression for each caolumn.

The column expreszion determines what information iz going o be extracted and stored in the colurmn. &
default expreszion iz added to each new column. You can modify & column's expression by zelecting the
calumn narme and clicking the expression button below,

Define columns to be added to index database:

&dd...

Remove...

Fename...

Data Source:

(+ Get text from layer that is being indexed
" Get text from map boundary [page number. gnd. etc. ]
~

Expression:

[ROUTE_MUM] E xpreszion...

Click Hext to continue

| Lu:uau:l...| Cancel < Back | M et > |

Once the maps and layers to index have been selected and the boundaries to be indexed
against have been chosen, the next step is to define what information is to be extracted and
stored in the index database.

The index database is a table with different columns containing different information about the
feature being indexed. For example, one column might have the street name, another the
subdivision name and a third the page number.
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The structure of the index database is developed by adding columns to the database and

defining an expression for the content of each column.

To add a new column to the output database click the Add... button. This brings up a dialog
where you can set the name of the column and what kind of information is to be stored in the

column.

Mew Index Database Column X]

Enter a name and select the information source for thiz column.

Column Name: |Listing
[Up to 10 characters, no spaces]
Select the information source for this column:
11 Information from the laver(s] being indexed
f* This column will be populated from the layer being indexed
2] Information from map extent boundary [page number, reference gid, map senes index layer, etc.]
"~ This column will be populated with the book or seriez page number

(" This column will be populated with the reference gnd ID [A1. A2, B1. etc]

the Indexing Boundaries tab]
i

("~ This column will be populated with both the page number and reference grid ID

3] Information from the selected boundary polygon layer [available if vou have selected a polygon laver on

HOTE: & default expreszion will be added to the new column bazed on the information source you have
zelected. You can later modify a column's exprezsion by clicking the exprezsion button on the main dialog.

k. Cancel

The wizard automatically adds a default expression for each column new column that you add.

You can modify the expression of the column by clicking the “Expression...” button.

For more information about expression syntax please refer to the Working With Expressions

section of this manual.
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Sort Order

X

il Indexing Wizard

Intmductiun] Map[s]] La_l,ler[s]] |ndering Euundaries] Output Colurnns St Order l I:Iutput]

The index databasze can be sorted alphabetically over multiple calumng. The sort arder iz determined by the
arder in which the caolumns appear below [The top mast item in the list being the primary sort column, the nest
item the zecondary zort column, ete. ],

[MPORTAMT: Sarting wery large tables with many columns can take a lang time to process. |f the indexing
rezultz in mare than 100,000 records and there are many columng in the table, you can expect sorting to take
hours in some cincumstances.

If you do not choose to zort the databaze, recards will be added in the order that they are indexed.

[v Sort Index

Listini
1

f* Ascending
("~ Descending

Optionz

[v Commectly sort numenc text

Thiz option insures that numeric text iz gorted in the proper order. For example, normally
"Highway 12" would come before "Highway 2" when zorting according to the standard rules
of zorting texst. This option will make sure that "Highway 12" iz listed after "Highway 3" in the
table.

IMPORTAMT: Selecting thiz option can significantly increaze the sort time.

[v Hemove duplicate items from databasze

Thiz option removes all duplicate recards from the index after it has been sorted. Records are
cohzidered duplicates when all the values in all the columng are the same.

Chck Hext to continue

| Load... | Cancel < Back M et >

After the indexing process is completed and information has been extracted and placed in the
output database, there are a number of clean up steps that can be performed on the resulting
table.

Sorting the table puts all the records in order according to the sorting hierarchy. Rearranging
the order of columns in the list changes the sorting hierarchy.

Correctly Sort Numeric Text
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This option makes sure that text containing numbers are sorted correctly. Under the standard
method of sorting text “Highway 12" would come before “Highway 4”. This is because text is
sorted from left to right, one character at a time and “1” would sort before “4”. This option
makes sure that “Highway 12" appears after “Highway 4” in the list.

IMPORTANT: Selecting this option greatly increases sorting time.
Remove Duplicate Items From Database

This makes sure that the database does not include any duplicate rows. Two rows are
considered duplicates if all information in all the columns are the same.

Since the wizard checks for duplicates by comparing a row to the one previous to it, this option
only works if the table is sorted.
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Output

i Indexing Wizard

Intru:uduu:tiu:un] Map[s]l La_l,ler[s]] Indexring Bnundaries] Cutput Eu:ulumns] Sort Order  Output l

The final step in the process iz to zelect a databaze file where the indexing rezultz will be stored.

After the index databaze has been created, you can use the Maplogic Senes Index element ta place the
table on the lavout in preparation for printing.

IMPORTAMT: The index database iz a shapshot of feature locations at the time the databaze iz created.
Ay changes that are made to the map book, GIS datasets or layers that affect the number and location of
features will require the database to be recreated!

Save Resultz In:
|E:"~T emptlndaxD atabaze. dbf EI

[f encountering ermar using folder tool, Click Here

Options
| Create a sample databaze of approximately: (500 listings

Thiz option will create a small zample databaze. |tis good a way to check pour settingz before
creating a full databasze which can take a long time to complete.

The Save and Load buttons allow you to zave
the wizard settings 20 the next ime you are
generating an index you don't have ta re-enter

svenything. Click Finish to begin indesing

3

Save... | Load... | Cancel < Back | | Finizh

The final step in the process of creating an index database is selecting an output database file

to store the information in.

Create A Sample Database

This option will create a small sample database of however many listings you choose. ltis a
good way to check your settings before you create the full database which can take a long time

to complete. An index of roads for a moderately sized city can have tens of thousands of
listings, so it's always a good idea to test the process first.
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You can also save time by using this smaller database while laying out the fonts, column
widths, margins, etc. of the Series Index Element. Once you have the layout looking the way
you want, load the full database into the element.

Saving Wizard Settings

Once you have completed all the settings of the wizard, you can save the settings in an external
file using the Save... and Load... buttons. This removes the need for entering information
every time you use the wizard.

This is particularly useful since map books may be updated once every so many months or
years and it is often difficult to remember the settings from the previous update.

Creating A Single Layer Location Listing Database (Outdated)

This tool is no longer recommended as it has been replaced with the more advanced
Grid Wizard. To begin, go to the layout containing the map series that is going to be indexed.
Once the layout is active, select Tools > Outdated Tools > Create Location Listing
Database... from the MapLogic Layout Manager toolbar.

You must have an Advanced or Pro license to use this tool.

This will bring up the Location Listing Database Wizard dialog. In this dialog you are going to
setup the process for creating the database which includes:

1. The source for the listings. This will include the map series as well as the layer
inside the series containing the map features you would like to index.

2. The expression for the listing text.

3. Any options that you may choose to implement.

4. A file name where the results should be stored.
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The Listing Source

isi. Location Listing Database Wizard x|

& location ligting databaze records the location of map features in a map book, [for example,
kdain Street.. Page 4.B-3].

Lizting Source | Listing Text I Optiohs I Output I
Location listings are made from the pages of a Map Series Frame. This tool will examine
evern pade in a Map Series and create a databaze of where features or annaotation labelz

are located.

Select Map Senies Frame:

Marth America j

{+ Create liztings from geographic features in layer:

Lizting text will came from the layer's table uzing an expreszsion [zee Listing Text tab).

{~ Create liztings from CAD/Coverage/GeoD atabase annotation Layer:

<Mones j

Lizting text will be the annatation label tewt.

" Create listings from annotation [label] group:

<Moner j

Lizting text will be the annotation label text.

MHOTE: Labels that ArcGlS generates on the fly for a layer can not be indexed.

Cancel < Back et = | Eirizh

To set the source of the location listings you must select the map series to be indexed, the type
of features that will be indexed as well as the layer that will be indexed.

The Map Series Frame

The map series frame is the frame which the wizard is going search page by page. The dialog
will present you with a list of available map series frames in the layout to choose from.

The Type Of Features To Be Indexed

You can index features in a map layer or annotation labels on the map. If the location map
features are going to be indexed, you will need to provide information on where in the feature’s
table the listing information will be extracted from.

If you are indexing annotation, the listing text will be the annotation text.

Labels that ArcMap generates “on-the-fly” can not be indexed as their positions are not static.
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The Layer To Be Indexed

The wizard displays the lists of available layers for each type of features you are wanting to
index. The wizard cannot complete its process unless a layer is selected.

The Listing Text

If the location map features in a layer are going to be indexed, you will need to provide
information on where in the feature’s table the listing information will be extracted from. This
option is not available if you have chosen to index annotation labels as the text for the listing is
the annotation text.

i, Location Listing Database Wizard x|

& location ligting database records the location of map features in a map book [for example,
b ain Street.. Page 4.8-3].

Listing Source  Listing Text | Optiors I Dlutput I

The listing databaze iz a table of feature listingz [for example, Main Street] and their
lozations [for example, Page 4 Giid B-5]. The page number. and grid location fields are
automatizally added to the databaze. The lizting text can either come from the laver's table
or ahnotation labels. Uszer's who have a Pro licenze can create multiple izting test fields.

Save listing text in field:

Lizting Adde...
R ermowe®. ..

Rename®...

Expression:

[CITY_MAME]

* Pro license required to add additional fields to databaze.

Cancel < Back M et = Fimizh

The Listing Field

The listing field is the name of the field in the location listing database where the information
about the feature is stored.

If you have a Pro license, you can create multiple fields of information for the feature. For
example, if you would like to create a database that lists the location of a road and the location
of an address range of that road, you can accomplish this by adding another field to the
database for the address range.
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The Listing Expression

The listing expression determines the text for the label. You can modify the expression by
clicking the Expression... button. For more information about expression syntax please refer
to the Working With Expressions section of this manual.

Options For Creating Location Listings

There are a number of options that you can set for the wizard which affect the database
creation process.

i, Location Listing Database Wizard |

& location lizting database records the location of map features in a map book [for example,
K ain Street...Page 4.B-3].

Lizting Su:uuru:el Listing Text © Option :l Dutputl

[~ Only index features inside the index polpgon

Thiz option lirmitz the items indexed for each page in a map series to thoze that fall
within the index polpgon for that page. In other words, any overlapping areas on the
page are ignored.

[~ Only index the center point of line and polygon features

Thiz option lirmitz the indexing of a line or palygaon feature to a zingle point [itz centriod].
Othensize, listings will be created for all the pages the entire extent of that feature
covers. T hiz option haz no effect on the indexing of annaotation layers or labels.

[~ Only index features that are currently zelected
Thiz aption liritz the indexing to anly those features that are currently zelected. This
option haz no effect on the indexing of annotation lavers or labels.

[+ If the Map Series Frame haz a vizible Index Grid, index each gnd cell.

[F pou have an index grd sorounding your Map Senes Frame, this option will not only
index the page location of a feature but alzo the gnd location of that feature [i.e. kain
Street, Pg 3 A-4).

Cancel < Back MHest > Firizh

Only Index Features Inside The Index Polygon

This option limits the items indexed for each page of the map series to those that fall within the
index polygon for that page. In other words, any overlapping areas on the page are ignored.
For example, if you are indexing the names of cities in each state of a map series of US States,
you probably do not want the names of the cities in neighboring states that appear on the page
to be indexed.
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Only Index The Center Point Of Line And Polygon Features

This option limits the indexing of a line or polygon feature to a single point (its center).
Otherwise, listings will be created for all the pages the feature covers. For example, a major
road that crosses many pages in a map series will have a listing for every page it appears on. If
this option is selected, the road will be listed once.

This option has no effect on the indexing of annotation labels.

Only Index Features That Are Currently Selected

If you would like to limit the indexing process to a selection of features, make sure they are
selected before you call up the wizard and then check this option.

This option has no effect on the indexing of annotation labels.

If The Map Series Frame Has A Visible Index Grid, Index Each Grid Cell

If you have an index grid surrounding the map series frame, selecting this option will not only
store the page a feature is located on, but also the grid cell that it appears on (i.e. Main

Street...Page 9 A-4).

Selecting this option significantly increases the time required for generating the index.
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Selecting The Output File To Save The Location Listing Database

. Location Listing Database Wizard x|

& location lizting database records the location of map features in a map book [for example,
bdain Street.. Page 4.8-3].

Lizting Sn:nurn::el Lizting Text I Options  Output
The rezulting liztings are zaved in a dBASE table.

Save Reszults In:

|E:"~temp'\5treetlnde:-:.dbf Iﬂ

IMPORTAMT: The listing databaze iz a snapshat of feature locations at the time the
databaze waz created. Any changes that are made to the map book, GIS datazets
aor layers that effect the number and lozation of features will require the recreation of
the databasel

[T Create a sample databaze of approximately: |2|:||:| listings

Thiz optian will create a gmall zample databaze. |tz good a way to check pour
zettings before creating a full database which can take a lang time to complete.

Y'ou can alza zave alat of time by uzing this smaller database while laying out
the fontz, column widths, marging, etc. of the Senes Index frame. Once things
[k, the way you like, load the full databaze into the frame.

[ Create an "As |z" databaze

A Az |2 databaze puts the page number and index grid row and colurmn
labelz it their final form. T his eliminates the need ko link the Series Index to the
b ap Senes which can significantly slow down the Series Indes on books that
have a large number of pages.

However, with an b |2 databaze, if you change the map book zo the map
padges stark on a different page number, ar if you change the labels an paur Map
Series Frame's index grid, you will need ta recreate the databaze.

Cancel < Back MHext = Firmzh

Click the folder button to select a file to save the location listing database to.
Create A Sample Database

This option will create a small sample database of however many listings you choose. ltis a
good way to check your settings before you create the full database which can take a long time
to complete. An index of roads for a moderately sized city can have tens of thousands of
listings, so it's always a good idea to test the process first.

You can also save time by using this smaller database while laying out the fonts, column
widths, margins, etc. of the Series Index Element. Once you have the layout looking the way
you want, load the full database into the element.

Create An “As Is” Database

Normally, the information in a location listing database is not entirely complete until it is brought
into a Series Index Element and linked to its parent Map Series Frame. The page numbering
and grid row and column labels are corrected when the Series Index Element is placed on the
layout. This allows for some flexibility to move sections around in your map book, or change
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the labels of an index grid without having to recreate the location listing database. However,
this flexibility comes with a performance price.

By creating an “As Is” database the correct page numbers and grid labels are placed in the
location listing database. This allows for better performance in the Series Index Element.
However, any change to the map book or data frame that modifies page numbers and grid
labels will require that you recreate the location listing database.
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Anchoring Elements

What Is Anchoring An Element?

Anchoring allows you to specify the position of an element to an exact location with respect to
the page layout or another element on your page. Anchoring is useful for a number of reasons:

1.

Anchoring allows you to setup your page layouts for two-sided printing. You can
anchor elements so that they have different positions on odd and even pages. For
example, you may want the page number to always be on the outside edge of the
layout. Or you may want the layout to have a different binding margin on odd and even
pages.

As you move from page to page in a map book some elements can change in size. By
anchoring these elements you insure that the relative position of the element does not
change. For example, even though your scale bar might change in size, you can insure
it is always centered with respect to the map by anchoring it to the center of the map.

You can move elements on and off the page. You can setup your anchor properties so
that some elements are only visible on some pages. For example, you may want to
have an inset map appear on certain pages in your map book. By setting up its anchor
properties, the extension will move the element off the page on some pages and move
it back on the page on others.

Adding Anchor Properties To An Existing Element

You can add anchor properties to an element by selecting the element and then selecting Edit
> Add Anchor Properties To Element... from the MapLogic Layout Manager toolbar.

MaplLogic Layout Manager |
Layout = |Edit = View ™ Insert ™ Tools ™ Help = E

3-[%] Convert Data Frame To Map Series Frame
f[ﬁ] Convert Data Frame To Series Locator Frame
ﬁ,‘; Convert Data Frame To Series Key Frame

ﬁ Convert Text Eement To Series Text

ﬁ Hemawve series Properties From Dats Frame

[;_ﬁ Remove Locator Properties From Data Frame

. Remove key Map Properties Erom Data Frame
% Remove Series Text Properties From Text Element
% Remove Fage Index Properties From Element
% Remaove Series Index Properties From Element

@ Add Anchor Properties to Element

xﬁ Remove Anchor Froperties From Element

™ Section Properties, ..

MapLogic Layout Manager User’'s Manual Page 147



You must have an Advanced or Pro license to add anchor properties to an element, otherwise

the tool is grayed out.

Accessing The Anchor Properties Of An Element
To modify the anchor properties of an element, select the element then right-click your mouse

and select Properties...

® Untitled.mxd - ArcMap - Arc¥iew i [m] 4|
J File Edit View Insert Selection Tools ‘Window Help
J @ @ :: o 5"15' O ‘ ‘ RPITO M ﬂ_" I J Layout * Edit * View *  Insert *  Tool
|IDEE& ¢ B@X | | $|mse |4 &8 BED
I_x] | L 1 L 1 L 1 |4 L 1 L 1 |8 L 1 L 1 | ﬂ
l@ Page Lapouts -
E Map Series Lapouts @ | |
=-4j@] Book Lapouts Cut Chrl
=Sl Aflas of US Highwaps 7 o,
: C Chrl+C
-8 Owverview Map e h
‘@ PageLapout1 i} . Delete Delete
E‘ State Maps . Conmverk Ta Graphics
¢ i-[d Page Layout 1 o
[ Template 1 ] (= ell ]
[# Template 2
i 4 1
- & Highway Index =y
i Graphic Operations » _—
i Crder »
‘4| | L | Mudge J |
Displa_l,ll Source La}lgutgl "E| eLI align , _"I
J Drawing ™ k 'f:) | L j A~ |||'|E|‘~"Eti'3~fI Diskribute 3 & =
Display the properties For the selected element |_| Retate or Flip » S
‘ropetties. ..

Once the properties dialog for the element is displayed, click on the Anchor tab to adjust the

anchor properties.
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Modifying The Anchor Properties Of An Element

General I Diata Frame I Coordinate System I [lumination I (Grids | Map Cache
Annotation Groups I Extent Rectangles I Frame I Size and Position ~ Anchor | Map Series

@ Anchor Properties [zome properties overide Element properties. |

Apchored To | Prirnary .-'lnu:hu:url Alkernate .-'f-.n-:hu:-rl I:Ipticunsl

Anchoring postions an elememt on the layout to an exact location with respect to the
page of another element ag the you move from page to page.

[+ Anchor thiz element to the:
i+ Page

i~ Page Element: - Data Frame, Index, ete. [Name must be unigue]

Series Tewt
Scale Test
tap Series Frame

— Multi-Page Settings
[f the lavout has more than one page [map series and bookz];
i~ Use the same anchor settings on all pages

i+ LUze alternate anchor zettings for: IEven Fages j

Page Range: |'IE-1 7.24 WitlEasEs
For example, 1,3.5-12 Page Range

QK I Cancel Apphy

If you would like anchoring to be turned on for this element, check the Anchor this element to
the: option.

Even though you will be able to move the element after it has been anchored, MapLogic Layout
Manager will always reposition the element when previewing, printing or exporting the layout.

Anchoring Element To The Page

Anchoring an element to page layout insures that the position of the element on the page does
not change.

Anchoring Element To Another Element
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Anchoring an element to another element insures that the relative position of the two elements
remains the same. For example, you may want your scale bar to always appear below the
bottom center of your map frame. By anchoring the scale bar to the map frame, as the scale
bar size changes, it will be repositioned so that it is centered below the map frame.

In order for an element to be anchored to another element, the element that is being anchored
to must have a unique name. If there are multiple elements with the same name, one of the
elements is randomly selected to anchor to.

Multi Page Settings

One of the key features of the anchor is that you can setup the anchor to behave differently on
different pages. This is useful in setting up your map book for two-sided printing (different
anchor on odd and even pages) or to create exceptions to the general anchoring rules on
certain pages.

Use The Same Anchor Settings On All Pages — Select this option if you would like to anchor the
element the same way on all pages in the series. A good example of this would be to anchor a
scale bar to the bottom center of a map frame.

Use Alternate Anchor Settings For Odd Or Even Pages — Select this option if you would like the
anchor to alternate between two different settings. A good example of this would be to anchor
the page number to the left and right corners of the page on odd and even pages respectively.
This insures that the page number is always on the outside corner of the page for two-sided
printing.

User Alternate Anchor Settings For Page Ranges — Select this option if you would like the
anchor to behave differently on certain pages. A good example of this would be an inset map
that is off the printed page on most pages in a map series but is brought back onto the page to
show some detail on a certain page in the series.

Modifying The Primary Anchor Properties Of An Element

The Primary Anchor tab displays the settings which determine the primary anchor properties for
an element.
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General I Diata Frame I Coordinate System I llumination I Grids | Map Cache I
Annotation Groups I Bxtent Rectangles I Frame I Size and Position ~ Anchor I Map Series

@ Anchor Properties [zome properties overide Element properties. |

Anchored To Primany Anchor | Alternate .-’-'-.nu:hu:url Dptians I

Anchor the of thiz element
to the ITDP Left j page / selected element.

— Harizontal Pozitianing [ # ]

Horizontal distance between anchor puints:lﬂ.?E

[pozitive numbers move element ta the night, negative numbers to the [eft]

[T | Get dizatance from field: |<Mone: j
[Thiz option iz only available if ancharing to a Map Senies frame]

—%ertical Positioning [ ]

WYertical distance between anchor points: I-D.?E

[pozitive numbers move element up, negative numbers down]

[T Get dizatance Fom feld: |<N|:|ne> j

[Thiz option iz only available if ancharing to a Map Senies frame]

et Current # and ' Dstances |

0K |  Cancel | Appy |

The anchor is setup by linking one of nine locations of the element (Top Left, Top Center, Top
Right, Center Left, Center, Center Right, Bottom Left, Bottom Center and Bottom Right) to one
of nine locations on the page or another element (Top Left, Top Center....).

Once the “from” and “to” positions of the anchor has been set, you can offset the position of the
element a given distance horizontal and vertical distance from the anchor points.

Horizontal Positioning (X)

The horizontal positioning determines how far to the left or right the element will be offset from
its anchor point. For example, you may want the page number to appear 0.25 inches from the
edge of the page. By anchoring the page number text element to the edge of the page and
then setting the horizontal distance to 0.25, the extension will insure that the element is always
0.25 inches from the edge of the page.

Positive numbers will move the element to the right of its anchor point, negative numbers will
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move the element to the left of its anchor point.
Vertical Positioning (Y)

The vertical positioning determines how far above or below the element will be offset from its
anchor point. For example, you may want the page number to appear 0.25 inches from the
bottom of the page. By anchoring the page number text element to the bottom of the page and
then setting the vertical distance to 0.25, the extension will insure that the element is always
0.25 inches above the edge of the page.

Positive numbers will move the element up from its anchor point, negative numbers will move
the element down from its anchor point.

Get Distance From Field

If you anchor the element to a map series frame, you have the option of getting the anchor
horizontal and vertical distances from fields in the map series frame index layer’s table. As you
move from page to page, the extension will read the distance from the appropriate row in the
table and offset the element accordingly.

Get Current X And Y Distances

This option populates the horizontal and vertical distances between the element and its anchor
point based on its current location on the layout.

If you have already positioned the element to the appropriate location with respect to its anchor
point, use this option to populate the anchor distance properties.

Modifying The Alternate Anchor Properties Of An Element

The Alternate Anchor tab displays the settings which determine the alternate anchor properties
for an element.
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General I Diata Frame I Coordinate System I llumination I Grids | Map Cache I
Annotation Groups I Bxtent Rectangles I Frame I Size and Position ~ Anchor I Map Series

@ Anchor Properties [zome properties overide Element properties. |

Anchor the ITDP Right j of thiz element

to the ITDP Right j page / selected element.

— Harizontal Pozitianing [ # ]

Horizontal dizstance between anchor puints:l-ﬂ.?E

[pozitive numbers move element ta the night, negative numbers to the [eft]

[T | Get dizatance from field: |<Mone: j
[Thiz option iz only available if ancharing to a Map Senies frame]

—%ertical Positioning [ ]

WYertical distance between anchor points: I-D.?E

[pozitive numbers move element up, negative numbers down]

[T Get dizatance Fom feld: |<N|:|ne> j

[Thiz option iz only available if ancharing to a Map Senies frame]

Setup az Horizontal Opposite of Primary | Get Current & and ' Distances |

|1z Honizontal Oppozite to zetup alternate anchaor far bwo-gided printing.

QK I Cancel Apphy

The alternate anchor is used to change the position of an element compared to its primary
anchor settings for a given range of pages (odd versus even pages or a user defined page
range).

Similar to the primary anchor properties, the anchor is setup by linking one of nine locations of
the element (Top Left, Top Center, Top Right, Center Left, Center, Center Right, Bottom Left,
Bottom Center and Bottom Right) to one of nine locations on the page or another element (Top
Left, Top Center....).

For more information on the different anchor properties, please refer to the Modifying The
Primary Anchor Properties section.

Setup As Horizontal Opposite of Primary

Use this option to setup the alternate anchor for two-sided printing. This option reads your
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primary anchor settings and then reverses the settings for left to right (or right to left) printing.

For example, if you have anchored your page number label to 0.25 inches from the upper-right
corner of the page on odd pages, clicking the Setup As Horizontal Opposite button will anchor
the page number to 0.25 inches from the upper-left corner of the page on even pages.

Modifying The Anchor Options Of An Element
The Options tab displays anchoring options for an element.

General I Diata Frame I Coordinate System I [lumination I (Grids | Map Cache I
Annotation Groups I Bdent Rectangles I Frame I Size and Position ~ Anchor I Map Series

@ Anchor Properties [zome propertiez overnde Element properties. ]

rerreersrerr ey

Archored To I Prirnary .-’-‘-.nu::h-:nrl Alkernate Anchaor DptIDnSI

The anchar pnority zets the order in which objects are anchored. For example, if a
kext element iz anchored to a data frame and the data frame iz itzelf anchored to the
page, setting the anchor prionty of the text element to LOW will inzure that the data
frame iz anchored to the page before the text element iz anchored to the data frame.

Anchor Priority: |MEDIUM =]

Ok Cancel Apphy

The only option available for anchor is the anchor Priority.
Anchor Priority

The anchor priority determines the order in which the elements are anchored. The priority of an
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anchor can be set to one of three values: Low, Medium and High.

Because you may want to anchor an element to another element (for example, a scale bar to a
map frame) which itself may have its own anchor properties (for example, a map frame to the
edge of the page), the anchor priority settings insures the correct order in which elements are
anchored (repositioned).

After elements on a layout have been updated, the extension begins repositioning elements
based on their anchor settings. Elements with an anchor priority of High will be repositioned
first, then elements with an anchor priority of Medium and finally elements with an anchor
priority of Low.
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Previewing, Printing And Exporting Map Series And Map Books

Previewing Map Series Or Map Book Pages

To preview the pages of a map series or section, select Layout > Preview Pages... from the
MapLogic Layout Manager toolbar.

|
Layout ™ Edit ™ Miew ™ Insert ™ Tools ™ Help =
[ﬂ Preview Pages
£ Print...
Export...

This will display the preview dialog which will allow you to flip through the pages of the series.

¥ Untitled.mud - ArcMap - ArcYiew -0l x|

J File Edit Wiew Insert Selection Tools ‘Window Help
J EHSE F BRX oo & e j|£|@|wj@@
J @ @ @J| B ED A [ m B|254 'I ||§||§| J Layvout * Edit ™ View = Insert * Too

: ﬂa I 1 I 1 I | ;|
_% Page Layauts I

EI EE Map Series La_l,lc'uts A
o EPageLa}luutﬁil 2 ¥ p»§|

liBnnkLaynuts E] @ | g m | Mare... |

-
"
-y

NN E

el & &

Display | Source Layouts | 2o |2 4 | ﬂ_l

JQrawing"T{:}|D'ﬁ':E|l.ﬁ.rial jl1ﬂjﬂfﬂ|é
[ 3.30 8.72Inches

You can click the forward and back buttons to move to the next or previous page. You can also

enter a page number and click the go to page button (small arrow point to a number) to go
directly to a particular page.

Click the More... button to get more options for zooming in on parts of the layout or selecting a
page to preview.
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Zoom To Region On A Layout

3
«1| 22Xy E
DEEM e |

Zoom Window | Fick Page On Map I

|Jze the
[eft mouze
buttan to
drag a
rectangle
to 200m
(}

The expanded preview button displays a small copy of the layout which you can use to zoom to
any area of the layout. Just drag a rectangle on the layout to zoom to it.

Pick Page On The Map

El
“ *'II Hx )y S
E]@“;m | Mare...

Zoom Windaw  Fick Page On Map |

I M arth &merica j
Left mousze
Alabama Georgia button to
zoom in, right
o pan,
Florida double click
to zelect.
Full Exstent

You can also select which page in a map series to preview by selecting the page on a small
map window. This window will display the Index Layer of a Map Series Frame. If you have
more than one map series frame on the layout, you can choose which frame you would like use
from the list.

Use the left mouse button to zoom in on an area. Use the right mouse button to pan the map.
Double click on an area to display its page in the map series.

Click the Full Extent button to zoom back out to the extent of the Index Layer.

Printing A Map Book

To print a map book series or map book, select the Layouts > Prints... from the MapLogic
Layout Manager toolbar.
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MapLogic Layout Manager H

Layout ™  Edit ™ Wiew ™ Insert ™ Tools ™ Help =

n igh Preview Pages...

& I

Export. ..

This will display the print dialog.

pint 21x|
— Prirter
M arme: YWBDA-DC2AHPDJS500_PS
Statuz: Ready
Type: hp dezignjet 5500ps 42 P53

Where: ATl

Comment;  Large farmat color platter. [~ Print bo File
— Dutput Image Quality [Resample Ratio)]——— — Page range

. . I v \ ' e Al
Fast " Cument zection
R atio: " Current page
" Pages: | |

— kap Larger than Printer Paper

. ) Enter page number and/or page
" Tile map to printer paper ranges separated by commas. Far
Al exarmple, 1,3,5-12

" Pages from: I‘I tu:u:l‘l Print; I,.f_-.,|| pages in range j

% Scale map ta fit printer paper

— Copies
r Proceed with printing, some clipping Nurrber of Copies: |17:I
ray ocour -

[~ Pausze 0 seconds between each printed page.

ak | Cancel |

As you can see, this dialog is very similar to that of a word processor. You can choose to print
the entire map series or book, the current page or a range of pages.

You also have the option of printing only the odd or even pages. This is useful if you have a
two-sided book layout.

Click the Setup... button to modify your print settings.
The Print To File option is only available if you have selected a PostScript printer.

Select your print settings and click OK to begin the printing process.
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Exporting A Map Book

To export a map book series or map book, select the Layouts > Export... from the MapLogic
Layout Manager toolbar.

MapLogic Layout Manager |
Layout = Edit = Wiew ™ Insett ™ Tools  Help =

o [&h Preview Pages...

% Frint. ..

This will display the export dialog.

— Location

File: | =

File Maming O ptions... |

—Type — Page range
Al
IPDF (" pe] j " Current section

; " Current page
Options... pag
4' - Pages:] _I

Enter page number and/or page ranges
geparated by commaz. For example, 1,3,5-12

Export: I.-’-\-.II pages in range j

[T Pauze I [ seconds bebween each exported page.
] |

To export a map series or map book, click the folder button and select the file name that you
want to export to.

The tool can export to PDF, BMP, TIFF and JPEG formats. The Options... button allows you
to select the output settings for the format you have selected.

You can select to export the entire book or a page range.

Once you have selected all your export options, click the OK button to begin exporting the map
series or book.

The tool will create a separate file for each page that is being exported. The page number will
be appended to the name of the file that you selected. For example, if the file name you
selected was TEST, the tool will create a series of files called TEST_Pgl, TEST_Pg2, etc. The
File Naming Options... button allows you to set some parameters so that the generated file
names are descriptive and provide more information about their content.
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Export - File Naming Options A

File naming optiohz allow for more descriptive file names when expaorting a map book or map
zenes. |f no ophion iz zelected, only the page number will be appended to the specified file
rane.

[ Add value of the name field in Map Series Frame to file name
If exported pages contain a map zenes, the value of the name field in the Map Seriez
Frame'z index laver iz added to the file name.
If a layout has mare than ohe Map Serez Frame, one will be randomly zelected.
If a name field has not been selected for the Map Senies Frame, thiz option iz ignored.

[ Add theme name to file name
If exported pages contain themes, the theme names iz added to the file name.

[~ Add first and last 3 characters of zenes index listings to file name
If exported pages contain a Senes Index, the value of the firzt 3 characterz of the first
and lazt lizting on each page iz added to the file name.

[~ Add layout name to file name
If exporting a map book, the name of each template layout iz added to the file name.

[ Add section name to file name
If exporting a map book, the name of each section in the book iz added ta the file name.

[~ Drop page number from file name

IMPORTAMT: Only zelect thiz option if vou have selected anaother option which will
rezult in unigue file names [for example, map senes page names).

[ Drop baze file name
The baze file name that you entered when selecting the expaort directary to be removed
fram the file name.

Selecting Print And Export Page Ranges Using List, Map or Query

On both the Print and Export Dialogs you can interactively select the range of pages that you
would like to print by either selecting the desired pages from a list or by pointing to them on a
map. In order to select the pages, click on the “...” button “Pages” input on the Print and Export

dialogs.

This displays the Print/Export Page Range dialog. This dialog offers three methods for

selecting pages. The Pick Pages From List tab allows you to select the pages from a list similar
to the Layouts tab in ArcMap’s Table of Contents. If you have selected to display individual
pages in the Table of Contents, they will be displayed here as well. To select a book, section,

template or page for printing, click the check box next to it.
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. Print/Export Page Range

! Pick Pages From List I Pick Pages On Mapl Selection/( uer_l,ll

X

=%kl Sample Map Book
=[] %) Front Cover
=- DE‘I Cover Layout

- % Introduction
=- DE‘I Iritro Layout

-0 %) Key Map
=B D [# Key Layout

=% Map Pages
El D [ First Page Lapout

=0 %) Index Of Roads
El D [ First Page Lapout

El DE‘I Indes Lawout
------ OB CvP-GRO(7)
------ OB GRO-MAG (3]
------ 08 Mal-PRE (3]
------ OB RAl-VI4 (1]
------ ~O® Yi&-YOR (1)

FPage Lizk: |

Ok

Cancel

The Pick Pages On Map tab allows you to select the pages by clicking on their index layer

polygons.

to select the map series frame.

If you are printing a map book, you will need to select the appropriate section,
template and map series frame to choose from.

If you are printing a map series, you only need

Once you have selected the map series frame, the dialog will display the polygons for the index
layer. Double-clicking on a polygon selects the page.
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. Print/Export Page Range 5[

Pick Pages From List  Fick Pages On Map | Selection/ uer_l,ll

Sec:tiun:l tap Pages j
Template:l tap Seres Lavout j

Map Series Flame:l Mew Data Frame j

LEFT MOUSE BUTTON - Zoom In
RIGHT MOLISE BUTTON - Pan Zoom o Ful Extent |
DOUBLE CLICK - Select Page SHIFT-DOUBLE CLICK - Unselect

Show Additional Layers:

[l hydrantzorlando
[] firesztations_other =
[ Fire Stations ;I
Page List: |3_4
] | Cancel |

The Selection/Query tab allows you to create a page range according to the index polygons that
are currently selected, a new query of the index polygons, or index polygons that overlap
features in another layer on the map.
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. Print/Export Page Range 5[

Pick Pages From Listl Pick Pages Ontap  Selection/Quem |

Sectiun:l tap Pages j
Template:l bap Series Layout j
Map Series Flame:l Mew Data Frame j

— Create & Page Ranage From:

) Currently selected [ndes Laver, palygots

i The following lndes Layer query:

Query Builder...

"Pg_Mumber'" » 7

i+ iIndex Layer polygons that intersect:

I Fire Stations j

[T Orly intersect with selected features in this layer

Create Page Range

Page List: |3_5

k. | Cancel |
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Miscellaneous Tools

There are a number of specialized tools available under the tools menu which helps in working

in the multi-layout environment.

E} Create Grid Index Layer
=" Create Lingar Index Layer

Create Location Listing Database. ..

Create Multi-Laver Index Database. ..

@ Szarch and Replace test in layouts. ..,

Copy layers to mulkiple layouts,

Elf Remove all MapLogic mulki-page objects From MED. ..

Advanced 2

Reqisket License, ..

Search And Replace Text In Layouts

This tool allows you to update text across multiple layouts stored inside the MXD.

Search and Replace Text x|
Search and Replace Text | Lapauts ta Search |
Beplace Text |
Thig tool will zearch and replace all matching test in lavouts stored in M0,
Search For: || Cancel |
Replace With: I
— Search criteria;
[T MWatch case
[~ Match Full text
- no changes are made if only part of the element test
matches the zearch text,
— Search for matching test in:
[+ Text elements
- text on the layout such as map titles, notes, ete.
[T Map [data frame] names
[~ Layer names
[ Legend symbol labels
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In order to use the dialog enter the search and replace text and select the type of elements that
are to be searched. You can look for text in ArcMap text elements (text labels that appear on

the layout) as well as map names, layer names and symbol labels in legends.

Text labels that have been placed on the map itself (as opposed to the layout) can not be

searched.

Search and Replace Text

Search and Replace Text 1 |

Check layouts o be zearched:

x|

Feplace Text |

...... D[@ FPage Layouts

------ DE Map Series Lapouts

EI ‘I Bock Lapouts

=36 Sample Map Book

=- D Front Cover
- D E Cover Lapout
EI D Introduction
P D E Intro Layout
=008 KeyMap
; D E F.eyw Layout

EI O%i Map Pages

- [O1@ First Page Layout

EI D Index Of Roads
...... -0 I3 First Page Layout
------ D E Indesw Layout

Cancel |

D E Map Senes Layout [Active]

Once the search parameters have been entered, select the individual layouts which you want to

search through.

IMPORTANT: The actions of this tool can not be undone so make sure you have saved your
MXD before you make the changes in case you need to revert to the saved version.
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Copy Layers To Multiple Layouts

This tool allows you to copy layers from the currently active map to other layouts within the
MXD. The layers can be copied as new layers or replace existing layers in the destination
maps.

. Copy/Paste Layers il

P;.'l Destination La_l,loutsl Copy Dptiu:unsl Replace I:Iptiu:unsl

Copy |
Check layers to be copied:
[ 4Fagetitlasindex ) Feplace |
atlasindes
O Schaols Cancel |

[ hwdrantzorlanda

[ firestations_ather

Fire Stations

[ Fire Hydrarts

O mymists

[ streets

[ Hospitals

[ hospital_private_7300
[ hospital_8500

[ finter Park, City Limits
[ Railroads

[ Dot B Aerials
~[10_1448 sid
[ 101648 sid
[ 101848 sid
~[O11_1448.5id =

Checking a group layer will copy all of the layers inside the group.

Checking a group layer and a layer inside the group will copy the layer bwice; once as part
of the group and once az an individual layer.

Layers To Copy

When you start up this tool, you are presented with a list of layers found in the currently active
map. Check the layers that are to be copied to other layouts.

If the selected layer is a group layer, the entire group is copied to the destination layout.

If you select a group layer and also one of the layers within the group, the layer will be copied
twice; once as part of the group and once as an individual layer
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Destination Layouts

Once you have selected the layers to copy, the next step is to select which layouts within the

MXD the layers will be copied to.

You will be presented with a copy of the Layouts tab that is in ArcMap’s table of contents from
which to select layouts. Selected grouped layouts (for example a Map Book) will result in the

selected layers being copied to all layouts in the group.

The Show Maps option populates the list with the individual map frames contained in each of
the layouts. This option allows you to select individual maps within the layouts to copy layers to

rather than just copying the layers to all map frames in the layout.

. Copy/Paste Layers

Layers to Copy | Destingtion Layouts | Copy Dptiu:un&l Feplace I:Iptiu:unsl

Check lapouts [other than the active layout] to copy layers to:

X

Copy |

...... DI@ Page Layouts
------ DE Map Series Lapouts

El ‘J%E) Book Lapouts

=- D@] Sample Map Book
EID Front Cover
P D @ Cover Layout
EI 5 Introduction
D @ Intra Layout
: Key Map
. 7 I3 Key Layout
El D b ap Pages

% Firzt Page Layout

. E Map Series Layout [Active]
EI D Index OF Roads

------ % First Page Layout

------ |:| E Index Layout

[T Show Maps [Data Frames] - Reguires achivating everny layout, please be patient...

Feplace |

Cancel

IMPORTANT: The Show Maps option requires every layout to be activated. Depending on the
complexity of your maps, this option can require a fair amount of time to complete.
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Copy Options

. Copy/Paste Layers x|

| Replace Options I

Copy |
[~ Only copy layers to maps [data frames] with the zame name
Replace |
— Layer Position
{* Paste layer at the top of the destination map layers Cancel |

{~ Paste layer at the bottom of the destination map layers

{~ Paste layer in the zame relative position as the original map

— Layer Wizibility
{* Leave layer vizibility unchanged
(= Turn layer off in the destination map

{~ Turn layer on in the destination map

There are a number of options which control how the layers are copied to the destination
layouts.

The “Only copy layers to maps (data frames) with the same name” option will search through
layouts with for maps with matching names before copying.

The Layer Position options control where in the order of the layers the new layer will be placed.

The Layer Visibility options control if the layer will be turned on or off in the destination map.
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Replace Options

x

Layers to Copy I Deztination La_l,lu:uut&l Copy Optionz

Copy |
[+ Search inzide group layers
Replace |
— Replace a layer when these critena are met
Cancel |

[¥ Layer names are the same

[~ Layer data sources are the zame

[~ Layer definition queries are the same
[Feature lavers only: paints, lines, palygons, etc.]

[~ Map [data frame] names are the same

—%hen replacing a layer:

[~ Keep the legend of the layer that is being replaced
[Feature lavers only; paints, lines, palygons, etc.

[~ Keep the definition query of the layer that iz being replaced
[Feature lavers only: points, lines, polygons, etc.]

[~ Keep the layer visibility of the layer that is being replaced

There are a number of options which control how existing layers are replaced in destination
layouts with new layers.

The “Search inside group layers” option will allow the replace tool to search through group
layers when replacing existing layers. Otherwise only layers that are at the root of the list are
examined.

In order for a layer to be considered a match for replacement, it must have the same name as
the layer that is replacing it. However, there are a number of additional criteria that you can use
to further restrict matches. These include matching data sources, definition queries and map
names.

When a match is found, the new layer will replace the existing layer. However, there are a
number of characteristics of the existing layer that you can retain and apply to the new layer.

If the layer is a feature layer (points, lines, polygons, etc.) you may choose to keep the legend
or definition query of the layer that is being replaced and apply it to the new layer. For all other
layers, you can choose to keep the visibility of the layer that is being replaced (i.e. whether or
not the layer is turned on).

IMPORTANT: The actions of this tool can not be undone so make sure you have saved your
MXD before you make the changes in case you need to revert to the saved version.
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Receiving Technical Support

Before you contact MapLogic Support, please make sure you have the product name and serial
number ready.

Online Support Documents

Our online support documents have the answer to many of your questions. Check out our
online help at the following address:

http://www.maplogic.com/support/support.html

If you can't find what the answer to your question online you can always contact MapLogic's
support staff by e-mail or phone.

E-Mail Support (support@maplogic.com)

To contact MapLogic support by e-mail send your support requests to support@maplogic.com
or use our online support form at the above Internet address. Please make sure to include a
daytime phone number in case we need to call you.

E-mail support is available to users 24 hours per day (requests for support received after 4:00
PM Eastern Standard Time are handled the next business day.). You must provide your
customer or product serial number and be eligible to receive support in order for us to process
your request.

Telephone Support
To contact MapLogic support by phone, call (407) 657-1250 7:00 AM to 4:00 PM Eastern

Standard Time Monday through Friday. Please make sure you have the product name and
serial number ready to give to the operator.
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Contacting MapLogic Corporation

Contacting MapLogic Corporation

Mailing Address:

MapLogic Corporation

330 West Canton Ave.
Winter Park, FL 32789 USA
TEL: 407-657-1250

FAX: 407-657-7008

Internet: www.maplogic.com

Marketing & Product Sales

To contact the MapLogic Marketing Department, e-mail us at marketing@maplogic.com or call
us at (407) 657-1250 7:00 AM to 4:00 PM Eastern Standard Time Monday through Friday.
Please make sure to include a daytime phone number in case we need to call you.

Technical Support

To contact MapLogic support by e-mail, send your support request to support@maplogic.com
or use our online support form. Please make sure to include a daytime phone number in case
we need to call you.

To contact MapLogic support by phone call (407) 657-1250 7:00 AM to 4:00 PM Eastern
Standard Time Monday through Friday. Please make sure you have the product name and
serial number ready to give to the operator.
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